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1.1 Legal and copyright information
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About this manual Purpose of the document

1.2 Purpose of the document

22852
This manual describes of the ecomatmobile family for mobile machines of ifm electronic gmbh:

e ecomatController <ecol00-Bez> (Art.-Nr.: CR711S) firmware version V2.5.0.n and higher

The CODESYS programming system is required to program this device:
version 3.5 SP11 or higher

These instructions describe the following topics:

e Configuration of the device in the setup mode

e Firmware update of the device in the recovery mode
e Configuration of the device using CODESYS

e Programming of the device-internal PLC of the CR711S using the CODESYS programming
system.

e Description of the device-specific CODESYS function libraries

1.3 Symbols and formats used

15989

A WARNING

Death or serious irreversible injuries may result.

A CAUTION

Slight reversible injuries may result.

Property damage is to be expected or may result.

] Important note
Non-compliance can result in malfunction or interference

[ ]
l i Information
Supplementary note
| 2
>

Request for action

Reaction, result

— .. see
abc Cross-reference
123 Decimal number

0x123 Hexadecimal number
0b010  Binary number

[...] Designation of pushbuttons, buttons or indications
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Overview: documentation modules for CR711S

1.4

Overview: documentation modules for CR711S

The documentation for this devices consists of the following modules:
(Downloads from ifm's website — ifm weltweit * ifm worldwide ¢ ifm a I’échelle internationale (— p. 205) )

Document Contents / Description
Data sheet Technical data in a table
Installation instructions e Instructions for installation, electrical installation, and commissioning
(are supplied with the Technical data
device)
Programming manual e  Functions of the setup menu of the device
e Creation of a CODESYS project with this device
e  Target settings with CODESYS
e  Programming of the device-internal PLC with CODESYS
e  Description of the device-specific CODESYS function libraries
System manual Know-how about the following topics (examples):
"Know-How

ecomatmobile”

1.5

The following user documentation is provided by 3S GmbH for programming the CR711S with

CODESYS:

Document

Online help

e  Overview Templates and demo programs
e CAN, CANopen

e  Control outputs

e  Visualisations

e Overview of the files and libraries

Overview: documentation for CODESYS 3.n

Content / Description

e  Context-sensitive help
. Description of the CODESYS programming system

22853

22856

After the installation of the programming system store and accessible on the hard disk of the

PCllaptop:
...\Programme (x86)\3S CODESYS\CODESYS\Online Help

CODESYS installation e  Remarks about the installing of the programming system CODESYS

and first steps

. First steps for handling the programming system CODESYS

After the installation of the programming system store and accessible on the hard disk of the

PCllaptop:
...\Programme (x86)\3S CODESYS\CODESYS\Documentation

CODESYS user manual e [H2] CODESYS Safety SIL2 - IEC Programming Guidelines.pdf

Safety SIL2

This document is for programmers who program safety-related controllers.

Download at:
— Www.codesys.com
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About this manual How is this documentation structured?

1.6 How is this documentation structured?

204
1508

This documentation is a combination of different types of manuals. It is for beginners and also a
reference for advanced users. This document is addressed to the programmers of the applications.

How to use this manual:

Refer to the table of contents to select a specific subject.

Using the index you can also quickly find a term you are looking for.

At the beginning of a chapter we will give you a brief overview of its contents.
e Abbreviations and technical terms — Appendix.

In case of malfunctions or uncertainties please contact the manufacturer at:
Contact — ifm weltweit * ifm worldwide ¢ ifm a I'échelle internationale (— p. 205)

We want to become even better! Each separate section has an identification number in the top right
corner. If you want to inform us about any inconsistencies, indicate this number with the title and the
language of this documentation. Thank you very much for your support!

We reserve the right to make alterations which can result in a change of contents of the

documentation. You can find the current version on ifm's website:
— ifm weltweit ¢ ifm worldwide ¢ ifm a I'échelle internationale (— p. 205)

1.7 History of the document CR0711

22862

What has been changed in this manual? An overview:

Date State Change
2017-06-13 01 new document
2017-12-19 02 Article number, operating system version, CODESYS version
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2 Functions and features

23289

This device is used to control processes in applications.

For this, device 2 contains 2 PLCs that can be programmed independently of each other.
In the CODESYS software platform, these PLCs are called:

« standard PLC

« safety PLC

23368

A WARNING

The safety functionality is in preparation.
At present the device has NO safety functionality!

» Do NOT use the device for safety-related functions!

10
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3 Safety instructions
Contents
[ (=T ST o) L= O PP PP P PPPP P 11
What previous KNoOWIedge iS FEQUITEA? ........cooiiiiiiiiiiiee ettt e st e e e sbne e e e s sbneeeeane 12
gl oTelge=Tal B3 v= T Lo o o KT PRSP P PR PPPPP PP 13
Organise the creation of safe machinery with the V. model............cccoooiiiiiiii e, 14
Start-up behaviour Of the CONTIOIET ...........oooiiiiie e 16
K0TV o T £ T SRS 16
NOEES: SEIIAI NUMDET ...ttt se e s n e et e s et e s nn e e snne e s ann e e sareeennnees 17
213
3.1 Please note!
22910
11212

No characteristics are warranted on the basis of the information, notes and examples provided in this

manual. The drawings, representations and examples imply no responsibility for the system and no

application-specific particularities.

» The manufacturer of the machine/equipment is responsible for ensuring the safety of the
machine/equipment.

» Follow the national and international regulations of the country in which the machine/installation is
to be placed on the market!

A WARNING

Non-observance of these instructions can lead to property damage or bodily injury!
does not assume any liability in this regard.

» The acting person must have read and understood the safety instructions and the corresponding
chapters in this manual before working on and with this device.

» The acting person must be authorised to work on the machine/equipment.
» The acting person must have the qualifications and training required to perform this work.
» Adhere to the technical data of the devices!

You can find the current data sheet on homepage.

» Observe the installation and wiring information as well as the functions and features of the
devices!
— supplied installation instructions or on homepage

» Please note the corrections and notes in the release notes for the existing hardware, software
and documentation, available on the website

Website — ifm weltweit ¢ ifm worldwide ¢ ifm a I’échelle internationale (— p. 205)

8340

A WARNING

The user is responsible for the reliable function of the application programs he designed. If
necessary, he must additionally carry out an approval test by corresponding supervisory and test
organisations according to the national regulations.

11
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23368

A WARNING

The safety functionality is in preparation.
At present the device has NO safety functionality!

» Do NOT use the device for safety-related functions!

3.2 What previous knowledge is required?

215
This document is intended for people with knowledge of control technology and PLC programming
with IEC 61131-3.
To program the PLC, the people should also be familiar with the CODESYS software.
The document is intended for specialists. These specialists are people who are qualified by their

training and their experience to see risks and to avoid possible hazards that may be caused during
operation or maintenance of a product. The document contains information about the correct handling

of the product.
Read this document before use to familiarise yourself with operating conditions, installation and
operation. Keep the document during the entire duration of use of the device.

Adhere to the safety instructions.

12
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Important standards

3.3

Important standards

22977
23368

A WARNING

The safety functionality is in preparation.
At present the device has NO safety functionality!

» Do NOT use the device for safety-related functions!

Among other things, the programmer of safety-related controllers should also know and observe the
content of the following standards:

Standard
IEC 61508

ISO 13849

IEC 62061

Title, content

Standard: Functional safety of electrical/electronic/programmable electronic safety-
related systems

Standard: Safety of machinery, safety-related parts of control systems
* Part 1: General design principles
Part 2: Validation

here: The device can be used up to PL d

Standard: Machine safety — functional safety of electric, electronic and
programmable machine controllers

* Specification of the functional requirements

* Specification of the safety requirements

here: The device can be used up to SIL CL 2

Standard: Safety of machinery — Functional safety of electrical, electronic and
programmable electronic control systems

* Functional requirements specification

« Safety integrity requirements specification

here: device is suited up to SIL CL 2

13
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3.4 Organise the creation of safe machinery with the V model
® Summary

» Define, observe, check and document the workflow steps in the V model
» Define responsibilities for tasks
» Define a person responsible for safety technology (Functional Safety Manager)

Every machine manufacturer should define the responsibilities for the respective tasks within his
company through organisational measures. This is independent of the work steps ...

« for machine design

« for the creation of the application program for the SafetyController

A staff member responsible for the safety technology (FSM = Functional Safety Manager) should also
be appointed. In larger companies this role is assigned to staff members who have the primary
responsibility.
» Tasks:

* prepare specifications

* prepare safety concept and machine specifications

« prepare functional specifications

+ determine or calculate the reliability of the safety function

» document all work steps

« archive the documentation and keep it during the life cycle of the machine

» The execution and verification of a task must not be performed by the same staff member!

» create and verify specifications

» create and verify machine specifications

« create and verify the different safety-related function units

« verify the interaction of the function units

The 4-eye principle is typically applied here.
To illustrate this structure in graphic form the V model can be applied. The machine manufacturer
adds the corresponding details and responsibilities to each work step of a particular application. The
machine manufacturer could also — depending on the work packages — create several organisational
units based on the V model.

It is important that this organisational structure is documented and archived.

14
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Business plan

Functional requirements Validation
{machine and Validation
safety functions)

Validated machine
and safety functions

Integration tests

!

Module design |-« — —| Module fests

!

=3 Result

Coding
il = = = Verification

Figure: V model showing the individual work steps

» In accordance with the applicable directives and standards:
= adhere to the mechanical and electrical layout of the safety functions when designing the
mobile machine
= document the respective steps of the specification and implementation process in a clearly
structured way
= make a statement regarding their reliability and the likelihood of a dangerous error

» Archive these documents during the entire life cycle of the mobile machine or machine series!

15
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3.5 Start-up behaviour of the controller

15233
11575

A WARNING

Danger due to unintentional and dangerous start of machine or plant sections!

» When creating the program, the programmer must ensure that no unintentional and dangerous

start of machines or plant sections after a fault (e.g. e-stop) and the following fault elimination
can occur!

= Realise restart inhibit.
» In case of an error, set the outputs concerned to FALSE in the program!

A restart can, for example, be caused by:
* Voltage restoration after power failure

» Reset after the watchdog responded because the cycle time was too long
* Error elimination after an E-stop

To ensure safe controller behaviour:
» monitor the voltage supply in the application program.
» In case of an error switch off all relevant outputs in the application program.

» Additionally monitor actuators which can cause hazardous movements in the application program
(feedback).

3.6 Warnings used

13685

A WARNING

Death or serious irreversible injuries may result.

A CAUTION

Slight reversible injuries may result.

Property damage is to be expected or may result.

Important note
Non-compliance may result in malfunction or interference.

1
[
l i Information
Supplementary note.

16
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3.7 Notes: serial number

20780
» In the user's production facility, draw a diagram of the controller network in the machine. Enter the
serial number of each controller installed into the network diagram.

» Before downloading a software component, read out this serial number and check the network
diagram to make sure that you are accessing the right controller.

17
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4 Installation
Contents
SYSEEM FEOUITEIMIENTS. ......tetee ittt ee ettt e ettt ettt e e e et e e e aa b et e e e aa b et e e e aa ket e e e aabe e e e e asbe e e e e anbe e e e e anbeeeeeanbneeeennnns 18
Carry OUL INSTAIIATION .......eeeee ittt e et e e e st e e e s st et e e e anbr e e e e snbn e e e e anbneeeeannns 19
23075

This chapter describes the installation of the software components that are necessary to program the
CR711S.

4.1 System requirements
Contents
[ E= 0 1T T PSP RRO 18
Y0 1111 1= OO PP PSP PP PPPPP 18
o =T S T 18
22911
Under which conditions can and may this device be programmed and operated?
411 Hardware
22912
e Device from the ifm product family ecomatController CR711S
e PCllaptop for CODESYS programming system
(— Chapter Software > System requirements CODESYS Development System V3.5)
e Ethernet connection between CODESYS PC/laptop and Ethernet interface of the CR711S
(— installation instructions)
41.2 Software
22913

To program the device-internal PLC of the CR711S, the following software components are required:

Component of Description version
CODESYS Development 3S Programming software CODESYS for PLC 3.5 SP11
System programming complying with the standard IEC 61131-3
[CR711S]_V2.5.0.n.zip ifm Complete package for ecomatController CR711S, V2.5.0.n
consisting of: — Components of the complete package
(— p- 20)
] The features and functions warranted in this manual can only be obtained by using the
d software components in the versions that are mentioned here.

On their website, ifm electronic provide the software components for download:
— ifm weltweit ¢ ifm worldwide ¢ ifm a I'échelle internationale (— p. 205)

413 Licensing

22914

By buying a controller CR711S, the buyer also purchases a licence that is valid for the use of the
CODESYS 3.5 programming system.

18
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4.2 Carry out installation

Contents

CODESYS programming SOTIWAIE ..........uuiieiiiieie it ettt et e e et e e et e e e e sabe e e e e snbreeeasnbneeeeannns 19

Complete package for ecomatController CRT7LLS ........ccuiiiiiiiiiiieiiiee et 20

Check the operating system version of the deVICe............oooiiiiiiiiiie e 22

Update the operating SYyStem Of the deVICE .........ccuuiiiiiiiiie e 24
23077

421 CODESYS programming software

7282

The CODESYS Development System (short: CODESYS) serves as platform for the creation of PLC
applications according to the standard IEC 61131-3.

Install CODESYS Development System

23508
To install the software "CODESYS Development System":

| ﬁ For installation on the PC/laptop, administrator rights are required.

» Install the programming system CODESYS 3.5 SP11.
— CODESYS installation and first steps

> CODESYS 3.5 SP11 is installed on the PC/laptop.

19
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422 Complete package for ecomatController CR711S

23372

Components of the complete package

23393
To program the device-internal PLC, ifm provides a complete package "CODESYSS for ifm R360lll
Products”. The overall package is structured as follows and includes the following components:

Data name / path Description
"CODESYS for ifm R360IIl Products”.zip Complete package
, CODESYS_Package Folder
+ Plugin Folder
+ CODESYS Safety SIL2 xyz.package Package "CODESYS Safety SIL2 Plugin”
+ ifm Safety SIL2 Extensions Vn.n.n.n.package Package "ifm Safety SIL2 Plugin"
+ ifm_ecomatController_Vn.n.n.n.package Package "ecomatController (device description,
libraries, etc.)"
+ Device Folder
+ boot Folder
+ boot.ifm Bootloader
+ o0s Folder
+ ifmOS.ifm Runtime system

The following components must be installed:

e CODESYS Safety SIL2 Plugin

e ifm Safety SIL2 Plugin

e ecomatController package (device description, libraries, etc.)

20
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Install package (PC/laptop)

23369

To install a package
Requirements

> CODESYS 3.5 SP11 is installed on the PC/laptop.

> ifm package "CODESYS for ifm R360Ill Products" is stored on the PC/laptop.
Start CODESYS

» Start CODESYS as administrator.

> CODESYS user interface appears.

Start Package Manager

» Select [Tools] > [Package Manager] to start the Package Manager.
> Package manager appears.

> Window shows installed packages.

Install package

» Click on [Install...].

The file explorer appears.

select the required file* . package and carry out a full installation.
The [Package Manager] window shows the installed package.
Click on [Close] to quit the Package Manager.

Save the project.

Close CoDeSys

Start CODESYS

> The installed package is now available.

vvyvyVyYyVvVyyY

To install another package, proceed again as described.

Update package (PC/laptop)

23370

To update a package:

1

Uninstall the old version of the package

» Uninstall package (PCl/laptop) (— p. 22)

Install the new version of the package

» Install package (PC/laptop) (— p. 21)

Update device

In the device tree: Mark node [Device (CR711S)].
Select [Project] > [Update Device...].

Dialogue window appears.

Click on [Update Device] to start the update process.
CODESYS loads new device libraries.

Device tree view is updated.

Click on [Close] to quit the Package Manager.
Save the project.

vyvyVvyVvyy

21
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Uninstall package (PC/laptop)

To uninstall a package:
1  Start package manager
» Select [Tools] > [Package Manager] to start the Package Manager.
> Window [Package Manager] shows installed packages.
2 Uninstall package
» Activate checkbox [Display versions].
> The window shows the version numbers of the installed packages.
» Select the package version to be uninstalled and uninstall it with [Uninstall...].
> Selected package version is uninstalled.
» Click on [Close] to quit the Package Manager.
423 Check the operating system version of the device

Check the operating system version of the device

To check the operating system version of the device:

» Connectto PLC (— Set communication path of PLC (— p. 61))

» Copy the file \info\swinfo.txt by clicking on [<<] to a local PC drive (— Manage files
(— p. 66)).

» Open swinfo.txt in an editor, e.g. Notepad

> Content of the opened file (example):
[ifmOS]
Version=V1.4.0.3
BuildDate=21.10.2016 15:11:14

[Bootloader]
Version=1.2.3.4
BuildDate=01.01.2017 23:10:15

» Check the information in the [ifmOS] area behind [Version=]

> If the version deviates from the required version, the operating system must be updated.

22
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Check the hardware version of the device

To check the hardware version of the device:
» Connect to PLC (— Set communication path of PLC (— p. 61))

» Copy the fifle \info\devinfo.txt by clicking on [<<] to a local PC drive (— Manage files
(— p. 66)).

» Open and check devinfo.txt in an editor, e.g. notepad

> devinfo.txt contains the following information:

23587

. Key Description
Section
Hardware Number Hardware article number
HARDWARE Name Hardware article designation
MANUFACTURE LPKnum Production order number
MANUFACTURE LPKerp ERP material number
MANUFACTURE Fabrnum Production order number of the final unit

23
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424 Update the operating system of the device
Contents

Update the operating system of the device with the batch file............cccccooiiiiii s 24

ATTENTION

Important; During the update process, the electric voltage supply of the device must be assured.
The device may only be disconnected from the voltage supply after the data transfer/update process
is finished.

An incomplete operating system update may destroy the device!

23374

(1) Important: Field test units cannot be updated!

» Before the update process, please ensure:
= Device is connected to the voltage supply and switched on
= The Ethernet interface is connected to the same network as the PC

Update the operating system of the device with the batch file

23825

» Strictly follow the instructions on the screen during the entire update process!
> Otherwise the controller may be destroyed!

To update the operating system of the device with the batch file update.bat:
» Unpack the ZIP file with the batch file update.bat and the corresponding files in a local
memory location.

Important: The data path in which the batch file is unpacked may not contain any blanks!

» Execute the batch file update.bat
» Follow the instructions on the screen.
> The [ecomatController Update Start Menu] appears.

If the device is not set to the standard IP address 192.168.82.247:
» Use the [i] key to select the menu item [Set device ip-address].
» Enter the IP address set in the device and confirm with [RETURN].
The IP address setting in the batch program has been changed.

\Y

» Use the [P] key to call up the menu item [Ping device]
The ping command is executed. The device must answer to the ping request to enable an
update process.

V

If ping is successful:

24
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» Use the [0] key to call up the menu item [Continue update process].
> Order number, software and hardware version are read from the device.

If an update is possible using the read data:
> The [ecomatController Update Menu] appears.
> Otherwise: Error message and return to the [ecomatController Update Start Menu].

» Follow the instructions on the screen.
> The updated process is executed.

> After loading the first file cmd.ifm and after the instruction on the screen, execute a power-on
reset of the controller.

> Otherwise the controller may be destroyed!

» After the power-on reset, continue the update process following the instructions on the screen.
> The user is informed about the success of the update process.

If the update process is finished successfully:
» Disconnect the voltage supply.
» Re-connect the voltage supply after the waiting time.
The PLC boots with a new operating system.

\%
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5 System description

Contents

Hardware deSCriPLION........cooiiiiiiiiiieee e
INMEEITACES ...t
SOftWAre deSCrIPHON ....c.iuviiieiiie et e e

5.1 Hardware description

Contents

HArdWAre STTUCTUIE .......eveiiieiieeesiee e
Device supply (teChNOIOGY) .. .eeeeiiiiieiiiiiiee e
MONItOIING CONCEPL ..ttt e
INPULS (ECNNOIOGY) -t
OUtPULS (IECHNOIOGY) «eeeierieieiiiiiiee e
Feedback in case of externally supplied outputs ..........ccccoviieeniiieennninee.

511 Hardware structure

Contents

OVEIVIEW: HAMWAIE ...t
[N o1 L3N0 o IR oo [PPSR PP
Standard PLC and safety PLC ..........oooiiiiiiiiiiiiee e
AVaAIlaDIE MEMOIY ... e
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Overview: Hardware

System context of the controller

22921

22922
23368

A WARNING

The safety functionality is in preparation.
At present the device has NO safety functionality!

» Do NOT use the device for safety-related functions!

All devices of this controller family can execute both security levels simultaneously:
» PLC for safety-related application (in the figure: yellow areas)

» PLC for standard applications (in the figure: blue areas)
Elements that can belong to both security levels are grey.

on-board sys analogue | | digital
Ah}--1hi- sensors sensors
VBB... IN...
displays
eg.
CR1OBL | ethernet . actuators
- ecomok .
further | switch it /
ethemnet OUT.
devices
CRO7nn \
controller valve
e.g. PC | RS232
CAN1...4
safety I I
— CANopen I
— J1939
fail-safe L engine sensors
CAN node 10 module joystick control unit (CAN)
—T legend:
. . urther
fail-safe fail-safe fail-safe (yellow) safety-related
actuators sensors nit mmmm  (blue) standard

Figure: System context of the controller
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System overview
module
supply

module
inputs

module

interfaces

Details:
Module
Power supply
Inputs
Interfaces
Memory, ports
Processing
HMI
Outputs

ecomok controller module
mohile
CRO7nn HMI
module module
memory, ports outputs
modul (standard) module (safety)
processing processing
Overview of the system modules
see

Device supply (technology) (— p. 33)
Inputs (technology) (— p. 38)
Interfaces

Available memory (— p. 31)
Standard PLC and safety PLC

Status LEDs

Outputs (technology) (— p. 43)

23405
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Block diagram of the supply and of the output deactivation

22934
o BAT+
— ’ I
(hri Ignition switch
Controller VBB30  ©VBB15
(blue) = system flags i ~[VEB15.VBExX
——————— .~ - — - - > VBB30.VBBx
oD k ————— ————— SUPPLY_SWITCH
o—— Supply = - » SUPPLY_VOLTAGE
Logic
VBBO_SW_|.OutVoltage VBB0_SW_Q.ValueDigital VBBO_SW_|.OutVoltage_SW
VBBO A g A VBBO_SW_|.OutState
o= — s ——o OUT0000...0008
VBB1_SW_|.OutVoltage VBB1_SW_Q.ValueDigital VBB1_SW_|.OutVoltage_SW
VBB1 A v A VBB1_SW_|.OutState
o * o— R —0 0UT0100...0108
VBB2_SW_|.OutVoltage ~ VBB2_SW_Q.ValueDigital VBB2_SW_|.OutVoltage_SW
VBB2 A g A VBB2_SW_|.OutState
o - e —-0 OUT0200...0208
Figure: Block diagram of the supply
Note on wiring
23102
Group designations
23103

Inputs and outputs are assigned in groups.
Input groups are required for 2-channel safety-related inputs.

The identifier of an input or output results from the following principle:
1. Type (IN, OUT)

2. Group number (00...18)

3. Channel number (00...08)

Examples:

e INOOO2 = input | group 00 | channel 02 in this group

e OUTO0507 = output | group 05 | channel 07 in this group

In case of ready-to-use multipoint connectors, both the corresponding identifier and the corresponding
pin number is indicated on each individual wire.
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Standard PLC and safety PLC

22916
23368

The safety functionality is in preparation.
At present the device has NO safety functionality!

» Do NOT use the device for safety-related functions!

The device features separate controllers:
« for standard functions
« for safety-related functions (safety)

® Before the programming of the application may even begin:

» distribute the resources to both PLCs ( Chapter Configure PLC (— p. 64)).
(system, inputs, outputs, user LEDSs)
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Available memory

Memory allocation

IEC61131-1 divides the memory for the storage of the user data into:

e memory of the applications (parts are configurable)
* IEC code non-safe
* IEC code safe

e Application data memory (IEC data):

= for volatile data (IEC RAM)

= for non-volatile data (memory-remanent in case of voltage failure)
The device has the following additions:
e USER files (storage of application-specific data in one data format)

e |EC memory bytes (permanent storage of application-specific data at application-specific
addresses)

13736

22928

23368

A WARNING

The safety functionality is in preparation.
At present the device has NO safety functionality!

» Do NOT use the device for safety-related functions!

FLASH memory

physical: 9.0 Mbytes
available: 6.0 Mbytes

RAM

physical: 2.7 Mbytes
available: 1.5 Mbytes

remanent memory

physical: 10 Kbytes
available: 10 Kbytes

IEC code (safe)
(configurable)

IEC RAM (safe)
(configurable)

IEC retain (safe)
(2.5 Kbytes)

IEC code (non-safe)
(configurable)

IEC RAM (non-safe)
(configurable)

IEC memory bytes (safe)
(2.5 Kbytes)

user files
(1.0 Mbytes)

Table: memory areas

IEC retain (non-safe)
(2.5 Kbytes)

IEC memory bytes (non-safe)
(2.5 Kbytes)
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Memory allocation variants

22932
23368

A WARNING

The safety functionality is in preparation.
At present the device has NO safety functionality!

» Do NOT use the device for safety-related functions!

The user can select from the pre-defined configurations of the memory partitioning. The configuration
enables optimum separation between safety-relevant application and standard application.

Memory

Configuration
Configuration 1

Configuration 2
(preset)

Configuration 3

Configuration 4

(—p.64)

IEC code safe

1.0 Mbytes
2.0 Mbytes

3.0 Mbytes
4.0 Mbytes

IEC RAM safe

306 Kbytes
614 Kbytes

920 Kbytes
1228 Kbytes

Table: configurable memory partitioning
Description of the allocation of the memory partitions in CODESYS: — Allocate memory partition

IEC code non-safe

4.0 Mbytes
3.0 Mbytes

2.0 Mbytes
1.0 Mbytes

1228 Kbytes
920 Kbytes

614 Kbytes
306 Kbytes
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51.2 Device supply (technology)

Contents
Voltage ranges of the 0N-board SYSTEM .......c..icuiiiiiiiiiie et e e e e beeeeeeae 33
STt T A ote] 1o [11T0] o O PO PP PP P PPPP P 33
Switch on/off Via MaIN SWILCH ......coiiiiiii e e s 34
Switch on/off via ignition 1ock (Terminal 15) ........coiiiiiiiiiiieeiie e 35
23404
Voltage ranges of the on-board system
22926

The system monitors the voltage ranges of the on-board system.
The voltages mentioned here apply to the specified range + 1 % (at 36 V).

Voltage [V]

from to
<+55
+5.5 <8.0
+8.0 +32.0
> +32.0 +36.0

> +36.0
Start conditions

Description

Undervoltage

VBB15, VBB30:

If the controller was in the OPERATING mode, the controller shuts down.

Limited operating range

If the controller was in the OPERATING mode, then it continues to operate in this range without any
restrictions in case of voltage dips.

Regular operating voltage

Nominal operating voltage
all functions available

VBB15 > 5V AND VBB30 > 8 V:
The controller is booting
Overvoltage (protected)

The device is not damaged by the voltage deviation.

If this condition on VBB15 / VBB30 in the OPERATING mode lasts longer than 10 s, the controller
changes to the FATAL ERROR state.

If this condition on VBBO...n in the OPERATING mode lasts longer than 10 s, the corresponding
output group changes to the COMPONENT ERROR state.

Overvoltage (unprotected)

In this area, the device is no longer protected and the behaviour is not predictable.
The device can be destroyed by this voltage.

» If such voltages are likely to occur in an application, provide for external protection!

22925

The device only boots when sufficient voltage is applied to the power supply connection VBB30 and to
VBB15 (= terminal 15).
In vehicles clamp 15 is the plus cable switched by the ignition lock.

This voltage must be provided by the on-board system of the mobile machine.
— chapter Monitoring concept (— p. 36)
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Switch on/off via main switch

22917
To do so: VBB15 is connected with VBB30
Procedure when switching on the main switch

> The system recognises the applied voltage (VBB15 > 5 V AND VBB30 > 8 V) and activates the
connection of the controller to the VBB30 potential via solid-state switch.

> The controller boots and starts.

Procedure when switching off the main switch:

> Running tasks will continue till the end.
IMPORTANT: The maximum length of tasks is 50 ms!
Tasks that run for longer will be aborted before the end of the task.

> the system automatically stores the retain data
the input signals are no longer read
the outputs are switched off.

> the system switches off completely

If this behaviour is not wanted, use the circuit via ignition lock:
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Switch on/off via ignition lock (Terminal 15)

22918
To do so:
» Connect the VBB15 via the ignition lock (= vehicle terminal 15 *) with the vehicle plus pole.
» Connect VBB30 directly with the vehicle plus pole (= vehicle terminal 30).
*) In vehicles clamp 15 is the plus cable switched by the ignition lock.

controller
PSU System-A logic
ignition switch VBB15 I~
| VBB15 """" switches VBB30 on

system activates latching

O~ 3
) VBB30 —F —>
[ : VBB15 L

on-board system backups data
4M'M‘ system application program switches VBB30 off

e

Figure: Delayed switch-off via ignition lock (terminal 15)

Procedure as with switch-on via ignition lock:

> The ignition lock applies voltage to VBB15 (= vehicle terminal 15 *).

> The system recognises the applied voltage (VBB15 >5 V AND VBB30 > 8 V) and activates the
connection of the controller to the VBB30 potential via solid-state switch.

> The ignition lock is bypassed. Latching of the control voltage is established.

> The controller boots and starts.

Procedure for switching off via ignition lock:
» Evaluate VBB15 in the application via FB SystemSupply (— p. 135)
If VBB15<5V:

= execute necessary actions (e.g.:)
« stop machine gently
* transmit required data
* save required data and close

= set the the input xSwitchOff of the FB SupplySwitch (— p. 133) to TRUE
* running tasks continue till the end.
= stop the application

= the system automatically stores the retain data
the input signals are no longer read
the outputs are switched off.

= the system lifts the latching via VBB30:
» the system switches off completely
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51.3 Monitoring concept

22919

The controller monitors the supply voltage for overvoltage and undervoltage.
In case of undervoltage, the controller switches off.

Monitoring and securing mechanisms
22941

Switch off outputs via solid-state switch
23273

A WARNING

Danger due to unintentional deactivation of all outputs!
If monitoring routines detect a system error:

> The device switches off the energy for all outputs of the affected output groups.
— chapter Output groups
— chapter List of outputs (— p. 49)

During the program process, the output switches are under the user's full software control. For further
safety, the corresponding applicable national regulations must be complied with.

If an error occurs during the program sequence, it is possible to disconnect the output switches from
voltage via the FB OutputGroup in order to separate critical plant sections.
11575

A WARNING

Danger due to unintentional and dangerous start of machine or plant sections!

» When creating the program, the programmer must ensure that no unintentional and dangerous
start of machines or plant sections after a fault (e.g. e-stop) and the following fault elimination
can occur!
= Realise restart inhibit.

» In case of an error, set the outputs concerned to FALSE in the program!
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Watchdog

The watchdog has multiple levels:

IEC task-related watchdog
This watchdog works in the ifm operating system and is executed in each CPU core. Each task is
monitored individually.
If an error occurs, the system only deactivates the affected PLC and the corresponding outputs.
Error class =B

External watchdog
If an error occurs, this watchdog puts the entire system into the "safe state" (emergency stop). The
output groups change to logic "0".
Error class = A

— chapter Error classes
To eliminate the fault:
» Rebooting the PLC is necessary via voltage on/off.

Configure IEC watchdog

» Familiarise yourself with the following CODESYS functions!

= Watchdog:
— Online help > CODESYS Development System > Programming Applications >
Task Configuration > Creating a Task Configuration > Tab 'Configuration’

= Task configuration:
— Online help > CODESYS Development System > Programming Applications >
Task Configuration

To configure the IEC watchdog of a task:

| 2

| 2
>
>
>

Open task configuration (— Configure task processing (— p. 80))
Activate watchdog with option field [Enable]

Enter watchdog [Time]

Set [Sensitivity]

Watchdog is configured

The watchdog time must be shorter than the interval time.
The watchdog time must be longer than the runtime of the task.
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5.1.4 Inputs (technology)

Contents
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Types of inputs
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23078
We differentiate between the following input types:
Binary input block diagram plus/minus-switching
23080

I("')
S o
In CSI = Current Sinking
In = connection of binary input n
(S) = sensor

(3))-
¢ ¢

Binary input block diagram, plus-switching (B.)
for positive sensor signal
Input = open = Signal = Low (GND)

*+)

CSO = current sourcing
In = connection of binary input n
(S) = sensor

Binary input block diagram, minus-switching (By)
for negative sensor signal:
Input = open = Signal = High (Supply)
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Input type IN MULTIFUNCTION-A

23081
Binary and analogue inputs

Block diagram

{CR}) VBB30 IN MULTIFUNCTION-A
IN#iit =

Connection of multi-function input no. ##H##
(CR) = device
(1) = input filter
—=— (5} | (2) = analogue current measurement
Re =300
(3) = binary input, plus-switching
Re =10 kQ

{2) (3) {4) (4) = analogue voltage measurement
0..10Vv/0..32V

(5) = measured value
(6) = reference voltage for ratio

(6}

INt ~_

|
—_t T LJ

V][V

Configure input — Chapter System configuration

Possible operating modes:

e Binary input CSI (Br) (Re = 10 k) or Namur

e Analogue current measurement 0...20 mA

e Analogue voltage measurement 0...10 V

e Analogue voltage measurement 0...32 V

¢ Analogue voltage measurement, ratiometric to the reference voltage

Input type IN FREQUENCY-A/B

23083
Binary and fast inputs

Block diagram
IN FREQUENCY-A/B

IN#H#HE =
(5} | Connection of frequency / counting input
no. #HH

i

~ (CR) = device
:3)% . L} [> =4} | (1)=input filter
(2) = CSl binary input

plus-switching
@ ® O s siching
L vBB3o (4) = measured value (analogue)
(5) = measured value (binary)

INHEEE
G

Configure input — Chapter System configuration

Possible operating modes:

e Binary input CSI (BL) (Re = 10 kQ2) or Namur

e Binary input CSO (Bn)

e Analogue voltage measurement 0...10 V (only for input type IN FREQUENCY-B)

e Pulse measurement CSI (BL) (frequency measurement, ratio measurement, pulse counter)
e Pulse measurement CSO (Br) (frequency measurement, ratio measurement, pulse counter)
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Input type IN RESISTOR-A

(1) = input filter
(2) = measured value (analogue)

23083
Binary inputs and resistance measurement
{CR)
Vee Block diagram
i IN RESISTOR-A
; ') +1 mA Nt =
Connection of frequency / counting input
IN#HHRE X —_— g quency g inp
e X 1 | —=(3}
i X (CR) = device
3k2 (1) = input filter
(2) = CSl binary input
! @) plus-switching
(3) = measured value (analogue)
Configure input — Chapter System configuration
Possible operating modes:
e Binary input CSI (BL) (Re = 10 kQ) or Namur
¢ Resistance measurement 0...30 kQ
Input type IN DIGITAL-A
23087
Binary inputs
fery T B (N 4
: (0 Block diagram
IN#HRE ; X — IN DIGITAgL A
1 2 -
O—1 ) [t
! :3)% # — [> @ IN##4 = Connection of binary input no.
i s
H (CR) = device
i
1
:
1
1
!

Input not configurable

Possible operating modes:
e Binary input CSI (Br) (Re = 10 kQ2) or Namur
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Input type IN DIGITAL-B

23089
Binary inputs
'(6?()'"; """""""""""""""" T
(1 Block diagram
INFHEEE X IN DIGITAL-B
o - {1 Ed
:3)% P — [> @) IN#### = Connection of binary input no.

HHH
(CR) = device

(1) = input filter
(2) = measured value (analogue)

Input not configurable

Possible operating modes:
e Binary input CSI (BL) (Re = 3.3 kQ) or Namur
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List of inputs

23117

IEC identifier Input type
INOOOO IN Frequency-A
INO0O1 IN Frequency-A
IN0002 IN Frequency-A
INO003 IN Frequency-A
IN0100 IN Multifunction-A
INO101 IN Multifunction-A
IN0102 IN Multifunction-A
IN0103 IN Multifunction-A
INO200 IN Multifunction-A
IN0201 IN Multifunction-A
IN0202 IN Multifunction-A
IN0203 IN Multifunction-A
INO300 IN Digital-B
INO301 IN Digital-B
INO400 IN Resistor-A
IN0401 IN Resistor-A
INO500 IN Frequency-A
INO501 IN Frequency-A
IN0502 IN Frequency-A
INO503 IN Frequency-A
INO600 IN Multifunction-A
INO601 IN Multifunction-A
IN0602 IN Multifunction-A
IN0603 IN Multifunction-A
INO700 IN Multifunction-A
INO701 IN Multifunction-A
INO702 IN Multifunction-A
INO703 IN Multifunction-A
INO800 IN Digital-B
INO801 IN Digital-B
IN0900 IN Resistor-A
IN0901 IN Resistor-A
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51.5 Outputs (technology)

Contents
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Output types

Contents

Binary output block diagram plus/minus-SWItChiNg ..........ccuviiiiieiiiiiiice e
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We differentiate between the following output types:

Binary output block diagram plus/minus-switching

(L) | (L)=load

|(+) )]
CSO = current sourcing j(m CSl = current sinking
D—Oon% Qn = connection of output n | > | an Qn = connection of output n

¢

Output block diagram plus-switching (By)
for positive output signal

|—-|- (L) = load
¢

Output block diagram, minus-switching (B.)
for negative output signal
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Output type OUT PWM-n-A

23091
n = current rating
Example:n =25 = Imax=2.5A

Binary output or
analogue output with pulse width modulation (PWM), optionally current-controlled (PWM;)

(1) = measured value (analogue)
(2) = measured value (binary)

— veex (CR)
OUT#HHHE
CSO »— D L O Block diagram
¥ OUT PWM-n-A
OUTH#H## = connection of PWM output no. ####
m={<]

1
1
1
1
1
1
1
1
1
1
1
1
1
1
1 =
! (CR) = device
1
1
1
1
1
1
1
1
1
1
1
1
1

Configure input — Chapter System configuration

Possible operating modes:

e Binary output CSO (Br)

e analogue output CSO with pulse width modulation (PWM4)

e analogue output CSO with pulse width modulation, current-controlled (PWM)

Setting and measurement via:

e FB Output (— p. 128)for binary output

e FBPWM1000 (— p. 156) for PWM

e FB CurrentControl (— p. 153) for current control (PWM),)
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Output type OUT PWM-n-B

23093
n = current rating
Example:n =25 = Imax=2.5A

Binary output or
analogue output with pulse width modulation (PWM)

— veex (CR)
CSO » D OUT#HHH
" O Block diagram
Uoe OUT PWM-n-B
OUTH#H## = connection of PWM output no. ####
(CR) = device

(1) = measured value (binary)
Uanc = current mirror

™ A

Configure input — Chapter System configuration

Possible operating modes:
e Binary output CSO (Bw) with restricted current measurement
e analogue output CSO witch pulse width modulation (PWMg), without current measurement

Setting and measurement via:

e Function block Output (— p. 128) for binary output
e Function block PWM1000 (— p. 156) for PWM
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Output type OUT PWM-n-BRIDGE-A
23094
n = current rating
Example:n =25 = Imax=2.5A
Binary output or
analogue output with pulse width modulation (PWM), optionally current-controlled (PWM;)
or bridge output (via PWM)

(CR)
OUT#HHHE
CSO »—j ’ {1 o}
% Block diagram
OUT PWM-n-A
OUT##H#H = connection of PWM output no. ####

(1) = measured value (analogue)
(2) = measured value (binary)

(1) ==

I_ VBBx
>
CSI i D
L
<
uin

(2) —=

1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
i (CR) = device
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1

Configure input — Chapter System configuration

Possible operating modes:

e Binary output CSO (BH)

e Binary output CSI (BL)

e analogue output CSO with pulse width modulation (PWMs), current controlled (PWM,)
e analogue output CSI with pulse width modulation (PWML)

e analogue output CSO with pulse width modulation, current-controlled (PWM;)

e Pair of outputs as bridge with pulse width modulation (PWM)

Setting and measurement via:

FB Output (— p. 128) for binary output

FB PWM1000 (— p. 156) for PWM

FB CurrentControl (— p. 153) for current control (PWM))
FB HBridge (— p. 148) for bridge output
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Output type OUT Supply-A

23125

The output OUT3000 is used to supply sensors with a stable voltage (5 V or 10 V) that is not affected

by fluctuations of the supply voltage.

13402

Reference voltage output can get damaged!
» Do NOT apply any external voltage!

Setting and measurement via FB Output (— p. 128) or via system configuration:

Setting / measurement via system configuration

Setting the reference voltage:
» In the device tree, select [Local_|O] > [Outputs] > tab [Parameter] > [OUT3000]

» Activate the required list element in the column [Value]:
for 5 V: [OUT_SENSOR_@5] or
for 10 V: [OUT_SENSOR_10]

Monitoring of the values at the reference voltage output:
» In the device tree, select [Local_IO] > [Outputs] > tab [IO-Mapping] > [OUT3000_I]

> [OutVoltageDiag] indicates the measured voltage in [mV]
[OutCurrentDiag] indicates the measured voltage in [mA]

Setting /measurement via FB Output

Setting the reference voltage:

» Use the inputs in the FB output as follows:
[uiChannel] = 3000
[eMode] = [OUT_SENSOR_05] (for 5 V) or
[eMode] = [OUT_SENSOR_180] (for 10 V)

Monitoring of the values at the reference voltage output:

» Read the outputs in the FB output as follows:

> [uiOutVoltage] indicates the measured voltage in [mV]
[uiOutCurrent] indicates the measured current in [mA]

Details — FB Output (— p. 128).
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Output type OUT Voltage-A

23126

The output provides 0...10 V e.g. for further controllers or actuators.
M3071n/ CRO71n: only OUT3001
M3072n / CR0O72n: 0UT3001 and 0UT3002

The output is protected against overload and automatically switches off if overloaded.

13402

Reference voltage output can get damaged!
» Do NOT apply any external voltage!

Setting and measurement via FB Output or via system configuration:

Setting / measurement via system configuration
23424

Setting the reference voltage:
» Select [Local_IO] > [Outputs] > tab [Parameter] > [OUT3001 / OUT3002] in the device tree

» Enter the required value [V] in the column [Value]
permissible = 0...10

Monitoring of the values at the reference voltage output:
» Select [Local_|O] > [Outputs] > tab [IO-Mapping] > [OUT3001_| / OUT3002_1] in the device tree
> [OutVoltageDiag] indicates the measured voltage in [mV]

Setting /measurement via FB Output
23425

Setting the reference voltage:

» Use the inputs in the FB output as follows:
[uiChannel] = 3001 / 3002
[uiValue] = required voltage in [mV]
permissible = 0...10000

Monitoring of the values at the reference voltage output:
» Read the outputs in the FB output as follows:

> [uiOutVoltage] indicates the measured voltage in [mV]
[uiOutCurrent] indicates the measured current in [mA]

Details — FB Output (— p. 128).
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List of outputs

IEC identifier
OUT0000
OUTO0001
OuUTO0002
OuUT0003
OUTO0004
OUTO0005
OUTO0006
OuUTO0007
OuUT0008

OuT0100
OouT0101
OouT0102
OouT0103
OouT0104
OuUT0105
OuUT0106
OouT0107
OuT0108

OuUT0200

OuT0201
OuT0202
OuUT0203
OuT0204
OUT0205
OUT0206
OouT0207
OuUT0208

OuUT3000
OuUT3001

Output type

OUT PWM-25-A
OUT PWM-25-B
OUT PWM-25-A
OUT PWM-25-B
OUT PWM-25-A
OUT PWM-25-B

OUT PWM-40-Bridge-A
OUT PWM-40-Bridge-A

OUT PWM-40-A

OUT PWM-25-A
OUT PWM-25-B
OUT PWM-25-A
OUT PWM-25-B
OUT PWM-25-A
OUT PWM-25-B

OUT PWM-40-Bridge-A
OUT PWM-40-Bridge-A

OUT PWM-40-A

OUT PWM-25-A

OUT PWM-25-B
OUT PWM-25-A
OUT PWM-25-B
OUT PWM-25-A
OUT PWM-25-B

OUT PWM-40-Bridge-A
OUT PWM-40-Bridge-A

OUT PWM-40-A

OUT Supply-A
OUT Voltage-A
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5.1.6 Feedback in case of externally supplied outputs

23874

Do not apply any external voltage to the outputs!

> As soon as output group switch VBBn_SW_Q = FALSE:

The internal device monitoring checks the voltage on the contact bar after the output group switch.
If then a voltage of > 0.4 VBBn is measured:

« the controller reports error class C,

« the controller switches the group to the safe state.

Safe state of the group = all outputs are switched off
« all outputs will be switched off
« the controller reports the error to the IEC application

To reboot the device:

» remove the error cause

» do a power-on reset.

OR error handling in the IEC application:

» remove the error cause

» Remove error of the group via xResetError

GND  VBBn
'—iVBBn

MY p— 7 “1  Figure: Example of wiring with blocking diodes due to the

“’)s | : —|—I " risk of feedback

S1 . | VBBn_SW_Q | )
" = FALSE . Remedy: o

Vi | | Insert the blocking diodes V1 and V2
. +  (— green arrows)!

'_E " 1 E!I— Q1 =FALSE | Successful:
K1 v ' '

If VBBn_SW_Q = FALSE, the controller does not
| | go to error class C when the S1 contact is

_EKz il\_ E!l— Q2=TRUE | closed.

@ NOTE

Help for externally connected outputs

» Decouple the externally connected outputs by means of diodes so that no external voltage can
be connected to the output terminal of the controller!
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5.2 Interfaces

23132

The device includes the interfaces described in the following.

[ i Position of the connections on the device and technical data: — Installation instructions, data
sheet

5.21 Serial interface

23133
This device features a serial interface.

The serial interface can generally be used in combination with the following functions:
* program download

» debugging

Connections and data — data sheet

5.2.2 Ethernet interface

23134
23450

Only use the Ethernet interface in a secure network environment (e.g. separate network or VPN)!

Otherwise, unauthorised persons can read or manipulate data or tamper with the functions of the
device.

This device features an Ethernet interface with 2 ports via an internal switch.
This enables line wiring between several devices.

-

The Ethernet interface supports the following standards:
« transmission rate 10/100 Mbits/s

The Ethernet interface supports the following protocols:
* TCP/IP

+ UDP/IP

* Modbus TCP slave

* Modbus/TCP master

* network variables UDP

Connections and data — data sheet

51



ifm Programming Manual ecomatController/60-1 (CR711S) Operating System V2.5.0.n

System description

2017-12-19

Interfaces

5.2.3 CAN: Interfaces and protocols

» Familiarise yourself with the following CODESY'S functions!

= CAN-based fieldbuses
— Online help > Fieldbus support > CAN-based fieldbuses

The device has 4 CAN interfaces. Each CAN interface supports the following protocols:

e RawCAN (CAN Layer 2)

e CANopen Manager

e CANopen Device

e CANopen Safety Manager
e CANopen Safety Device

e J1939 Manager

23147

23368

A WARNING

The safety functionality is in preparation.
At present the device has NO safety functionality!

» Do NOT use the device for safety-related functions!
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5.31 Overview: Software

23511
We differentiate between the following software components:

PC / Laptop .:mn:.ﬁ_E Controller
CODESYS Development System : CRO7nn
Service and
. - Maintenance IEC Application IEC Application
Device Description (Standard) (Safety)
IEC Application bina bina
T (binary) (binary)
Config Pluglins (binary) ifm Operating System
Debugging
IEC Libraries BT CODESYS CODESYS
(Standard) (Safety) CTRL CTRL-SIL2
(binary)
IEC Libraries . ;
(Safety) Real Time Operating System
Tools for Service Files
and Maintenance }- Bootloader Directories

Software on the PC/notebook.

23518

The programming environment CODESYS Development System is installed in the PC/notebook to
create and debug both applications. The controller supports service and maintenance via CODESYS
or via other tools.

The CODESYS functions are extended with Config plugins. Thereby, additional setting options for
memory and inputs/outputs become available. ifm electronic provides adequate device descriptions
for the CODESYS Development System for each derivative. IEC libraries for the safe and non-safe
applications provide CODESYS and the programmer with access options to the functions of the
controller.
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Software in the controller

23519
The controller processes the applications by means of several software components.
The ifm operating system with the CODESYS CTRL-SIL2 and the CODESYS CTRL constitutes,
among other things, the runtime environment that executes both applications. The real-time operating
system enables separate execution of the safe and the non-safe software components in the

controller.
23368

A WARNING

The safety functionality is in preparation.
At present the device has NO safety functionality!

» Do NOT use the device for safety-related functions!

Using the configuration file comconf. cfg, the programmer can control the interface.

The programmer can store files and directories on the controller and use them in the application. Or
the applications themselves create files and store them in the controller.

The bootloader is a fallback level for cases in which the ifm operating system is no (longer) available
or corrupt.

54



Programming Manual ecomatController/60-1 (CR711S) Operating System V2.5.0.n 2017-12-19

System description Software description

5.3.2 Software module for the device

23500
The software in this device communicates with the hardware as follows:

ecomak
muobife

Hardware

Software module Can the user change the module? Using what?
Application

with libraries s CODESYS,

a) for standard PLC y Tools for service and maintenance
b) for safety PLC

. . Upgrade yes CODESYS,

ifm operating system Downgrade no Tools for service and maintenance
Bootloader no

(Hardware) no

We describe this software module in the following:

Bootloader
23503
The bootloader is a start program with which the operating system and the application can be reloaded

on the device.
23561

Only execute the bootloader update when explicitly requested by ifm!

Operating system

23504
Basic program in the device, establishes the connection between the hardware of the device and the
application.
— Chapter Software module for the device

The device is supplied with the installed operating system.

Verifying and changing the operating system version — Chapter Check the operating system version of the
device (— p. 22)

The operating system only needs to be downloaded once - if at all. The application can then be loaded
(also several times) in a PLC without affecting the operating system.

The operating system can be downloaded from 's website:
— ifm weltweit ¢ ifm worldwide ¢ ifm a I'échelle internationale (— p. 205)

55



ifm Programming Manual ecomatController/60-1 (CR711S) Operating System V2.5.0.n

System description

2017-12-19

Software description

Application

23505

Software specific to the application, implemented by the machine manufacturer, generally containing
logic sequences, limits and expressions that control the appropriate inputs, outputs, calculations and

decisions.

8340

A WARNING

The user is responsible for the reliable function of the application programs he designed. If
necessary, he must additionally carry out an approval test by corresponding supervisory and test
organisations according to the national regulations.

Libraries

ifm electronic provides the following function libraries for the programming of the device under

23505
23458

CODESYS 3.5:
Name Description
ifmCANopenManager Functions for use of the CAN interfaces as CANopen Manager
ifmDeviceCR711S Data structures, enumeration types and global variables

ifmFastinput

Functions to access the fast inputs of the device

ifmlOcommon

Functions for access to the inputs and outputs of the device

ifmlOconfigDiagProt

Functions to configure the 1/O-related diagnostic and protective functions

ifmOutGroup Functions to control output group switches
ifmOutHBridge Functions to access H-bridge outputs

ifmOutPWM Functions to access PWM outputs

ifmRawCAN Functions for use of the CAN interfaces as CAN Layer 2
ifmSysinfo Functions to set / read system information

ifmTypes Global types and interfaces for other ifm libraries

| i Detailed information about the ifm function libraries: — ifm function libraries (— p. 102)
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6 Getting started

Contents
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15858
This chapter contains information about the first steps to program the device with CODESYS.
6.1 Start CODESYS
23383
Requirements
> Software components are correctly installed (— Installation).
Start CODESYS
» Double-click on [3.5 SP11] symbol
> CODESYS starts.
> CODESYS user interface appears.
6.2 Create CODESYS project
23384

» Familiarise yourself with the following CODESYS functions!

= Create a project
— Online help > CODESYS Development System > Creating and Configuring a
Project

= Manage a project
— Online help > CODESYS Development System > Protecting and Saving the
Project

ifm electronic provides a special template for each model of the device family. The user can select the
corresponding template when the project is created.
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6.2.1 Create new project with CR711S

23452
Requirements
> ifm package "CODESYS for ifm R360I11l Products" has been correctly installed (— Installation).
1  Create new CR711S project
» Select [File] > [New Project...].
> The window [New Project] appears.

| =] New Project X

Categories: Templates:
-1 Libraries

-3 Projects ® — —
Empty project CRO711 Project CR0721 Project

= =
Standard project  Standard project
with Applicatio...

A template project with ifm CR7021 3Mbyte standard 2Mbyte safety |

Name: | MyProject |

Location: |C: \MyPath W |

coes

» Set the following values:
1. [Templates]: Select the device project template, e.g. [CR0721 Project]
2. [Name]: Enter the project name
3. [Location]: Select storage location for the project file

» Click on [OK] to adopt the selected values.
CODESYS creates a new CR711S project.

> The window [Devices] shows the device tree of the project (— Overview: Project structure with
CR711S).

2  Save the project
» Select [File] > [Save Project].
> CODESYS saves the project.
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6.2.2 Overview: Project structure with CR711S

23387

A CODESYS project contains all components for configuration, management and programming of the
CR711S. All components of a project are shown in the window [Devices] in a hierarchic tree view.
CODESYS projects with a CR711S have the following structure:

=[] fm_CR0721_Root (CRO721)

= safetyPLC (CR0O721 SIL2)

+ 8] PLC Logic

[ system_Info (System_Info)
[ Local IO (Local 10)

+ (] HMI (HMI)

+-(f] Communication (Communication)
=-(f standardPLC (CRO721 Standard)

+ Bl PLC Logic
[ system_Info (System_Info)
[ Local_IO (Local_IO)
(] HMI (HMI)
+-(f] Communication (Communication)

+

+

Legend:

ifm_CR711S_Root provides access to the settings of the CR711S
(ifm CR711S Root) — Configure PLC

SafetyPLC " o

(ifm CR711S SIL2) Content of the PLC called "SafetyPLC
StandardPLC

(ifm CR711S Standard) Content of the PLC called "StandardPLC"

contains the applications of the CR711S

PLC logic — Objects of a PLC application (— p. 77)
Svstem info provides access to the device information
Y — Display system information (— p. 101)
provides access to the configuration options of the inputs and outputs
Local_IO . :
- — Configure inputs and outputs (— p. 67)
HMI provides access to the configuration options of the operating and display elements

provides access to the configuration options of the communication interfaces

Communication ~, Configure CAN interfaces (— p. 70)

The programmer can adjust the terms in the structure before the expression in brackets:
» Right mouse click on the term > [Properties...]

> The window [Properties] appears > tab [Common]

» enter aterm

» confirm with [OK]

(&)
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6.3 Use CODESYS user manual

This manual only describes the integration, configuration and the programming of the CR711S using
the CODESYS development system.

For the description of user actions and user interface elements the CODESYS terminology will be
used.

Standard functions and methods of CODESYS will not be described. At the beginning of each section
there will be a reference to the corresponding chapters of the CODESYS online help.

To access the online help of the CODESYS development system:
» Start CODESYS.

> The CODESYS user interface appears.

» Press[F1].

> Online help of the CODESYS development system appears.

» Familiarise yourself with the CODESYS development system! In particular with the
following topics:
= Names and functions of the user interface elements
= Basic menu functions
= Programming techniques and methods for data retention
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6.4 Configure programming interface

23495

Programming of the device-internal PLC is made via the Ethernet interface of the device (position of
the connections: — Installation instructions).

l i Device and PC/laptop can be coupled directly or indirectly via an Ethernet network.

» Only use the recommended accessories for connection of the Ethernet interfaces!
(— Installation instructions).

» For connection in the network, an experienced user or system administrator should set
up the network addresses and do the configuration.

23450

Only use the Ethernet interface in a secure network environment (e.g. separate network or VPN)!

Otherwise, unauthorised persons can read or manipulate data or tamper with the functions of the
device.

6.4.1 Set communication path of PLC

13901

To configure the communication path between the programming system CODESYS and the device-
internal PLC:

Preparations
> CODESYS PCllaptop and Ethernet interface of the device are connected.
> Optional: Adjust IP settings of the Ethernet interface.
1  Select communication settings
» In the device tree: Double-click on symbol [Device (CR711S)]
> In the editor window: Select tab [Communication].
> Editor window shows communication settings.
2  Select gateway
» Select the requested gateway in the list [Gateway].
> List shows selected gateway.
3 Set communication path
Activate [Scan Network ...].
Window [Select Device] appears.
Select gateway node and start scan process with [Scan network].
CODESYS scans network for devices.
Window shows network path and detected devices.

Select node of the device and activate [OK] to set the communication path to the device-
internal PLC.

> CODESYS can transfer data to the device-internal PLC.

vVvVvvyVvVy

61



ifm Programming Manual ecomatController/60-1 (CR711S) Operating System V2.5.0.n 2017-12-19
Getting started Add ifm function libraries to the application

6.5 Add ifm function libraries to the application

23390

l i » Familiarise yourself with the following CODESY'S functions!

= Library manager
— Online help > CODESYS Development System > Managing Libraries > Adding a
library to the application

The ifm package includes function libraries for the programming of the device under CODESYS. The
libraries are installed in CODESYS together with the ifm package.

The user can add the libraries individually to an application he/she needs for the programming.

By means of the container library ifmR360-3. library, the user can add all functions
available for the device to the project.

To integrate a library into a project:
Requirements:
> ifm package is correctly installed (— Install package (PC/laptop) (— p. 21)).
Load container library
» In the device tree: Double-click on [PLC Logic] > [Application] > [Library Manager]
> Editor window shows table of added libraries.
» Click on [Add library].
> Dialogue window [Add library] appears.
» Select requested library and click on [OK] to add the selected library to the application.
> CODESYS adds the selected library to the project.
> Editor window shows the library.
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6.6 Activate the access protection for a project

l i » Familiarise yourself with the following CODESY'S functions!

» Protect and save project
— Online help > CODESYS Development System > Protect and save project

The user can use a password to protect the device from unauthorised access.
Select [Project] > [Project Settings...].

Window [Project Settings] appears.

Select [Security].

Activate checkbox [Enable project file encryption].

Enter the requested password in the field [New password].

Enter the entered password again in the field [Confirm new password].
Select [OK] to activate the access protection for the project.

Access protection is activated. Project is encrypted.

VYyVYyYVYVYVY VY
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7 System configuration
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23096
741 Configure PLC
23097
23368
A WARNING
The safety functionality is in preparation.
At present the device has NO safety functionality!
» Do NOT use the device for safety-related functions!
711 Allocate memory partition
23483
23368
A WARNING

The safety functionality is in preparation.

At present the device has NO safety functionality!
» Do NOT use the device for safety-related functions!

Further information: — Memory allocation variants (— p. 32)

To allocate the memory partitions to the PLCs:
1 Select memory partition

» In the device tree: Double-click on symbol [Device (CR711S)]
» In the editor window: Select [Memory Layout] tab.
> The editor window shows the partitioning of the memory:

Memory layout

Partitioning Safety PLC / PLC

MemoryLayout_1s 4

MemoryLayout_4s_1 4MB/1MB
MemoryLayout_3s_2 3MB/2MB
MemoryLayout 2s 3 2MB/3 MB

1MB/4MB

2 Set memory partitioning
» Highlight the required memory partition
» Click on the [Update Devices] button

> Memory partitioning is adopted in CODESYS

3 Load memory partition into the device

» Click on the [Download Configuration] button
> Memory partition is downloaded to the device
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71.2 Allocate inputs/outputs
23482
23368
A WARNING
The safety functionality is in preparation.
At present the device has NO safety functionality!
» Do NOT use the device for safety-related functions!
To allocate the 1/Os to the PLCs:
® Before the programming of the application may even begin:
1  Select I/O allocation
» Inthe CODESYS device tree: Double-click on symbol [Device (CR711S)]
» In the editor window: Select [I/O Assignment] tab.
> Editor window shows the PLC allocation of the inputs/outputs (excerpt):

. Standard Safety
Section Element Parameter PLC PLC
System info IP Settings - O] O
Local_IO Inputs INO00O © @)

IN00O1 o} ¢)

IN0002 o} o)

Outputs OuUT0000 © @)
OUT0001 o} o)

OUT0002 o} ¢)

System_Outputs VBBO_SW O] O
VBB1_SW o} ¢)

Supply_Switch © O

HMI User_LEDs User LED 0 © @)
User LED 1 © O

User LED 2 © @)

User LED 3 © @)

2 Setl/O allocation

» Highlight all I/Os in the column [StandardPLC] to allocate it to the standard PLC

» Highlight all I/Os in the column [SafetyPLC] to allocate it to the safety PLC

> The I/Os are allocated
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71.3 Manage files

23520

To transfer files between PC and device:
1  Select file view

» In the device tree: Double-click on symbol [Device (CR711S)]

» In the editor window: Select the [Files] tab.

> The editor window shows the file structure on the PC on the left and on the device on the right
2 Transfer file from PC to device

» Highlight the file on the left

» Select device target directory on the right

» Star transfer using the [>>] button

> The file is transferred to the device
3 Transfer the file from the device to the PC

» Highlight the file on the right

» Select PC target directory on the left

» Start the transfer using the [<<] button

> The fle is transferred to the PC

714 Manage users and groups

23521

This function has not yet been implemented.
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7.2 Configure inputs and outputs

23099
The inputs and outputs can be configured applying two methods:

7.21 via system configuration

23149

This method is useful if the configuration is not supposed to be changed again during the runtime of
the application.

Note: Only the 1/Os allocated to the PLC can be configured!

Procedure using the example of the operating mode of an input / output:

In the CODESYS device tree: Extend required PLC > Element [Local_|O]
Double-click on [Inputs] / [Outputs]

Click on [Parameters] tab

The parameter setting view of the inputs / outputs appears

Select input / output from the list

Double-click in the column [Value] of the parameter [Mode]

Click on arrow symbol

List of possible modes appears

Click on the required mode

The mode for the input / output is set

If needed, set further parameters as described, e.qg. filters, periods, frequency, etc.

vVVVYyYVYyVYyYVYyYvVYYyyy

722 via function block

23150

This method is useful if the configuration is supposed to be changed during the runtime of the
application.

The operating type of the inputs and outputs is set via the block input eMode of the following FBs.
Examples:

e FBInput (— p. 125) > Input eMode

e FB Output (— p. 128) > Input eMode

e FB OutputGroup > Input eMode
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7.3 Configure interfaces
23100
7.31 Configure serial interface

23151
The CODESYS service communication via RS232 only works with the preset baud rate.

For other purposes, the device supports the following baud rates:
9 600 baud

19 200 baud

28 800 baud

38 400 baud

57 600 baud

115 200 baud (preset)

Setting the interface: — Interface configuration file comconf.cfg (— p. 76)

7.3.2 Configure Ethernet interface

23152
Setting the interface: — Interface configuration file comconf.cfg (— p. 76)

Factory setting:

IP address = 192.168.82.247
Subnet mask = 255.255.255.0
Gateway address = 192.168.82.21
UDP port = 12345

23450

Only use the Ethernet interface in a secure network environment (e.g. separate network or VPN)!

Otherwise, unauthorised persons can read or manipulate data or tamper with the functions of the
device.

The the IP parameter of the Ethernet interface

23455

In order to update the runtime system of the CR711S via a network, the device must be connected to
the corresponding network. For the configuration of the Ethernet interface, the following options are
available:

e Manual The user defines the parameters of the Ethernet interface manually:
IP address,
Subnet mask,
gateway address
» Observe the Address assignment in Ethernet networks (— p. 69) in
Ethernet networks!

e Automatic The interface parameters are set via the Dynamic Host Configuration
Protocol (DHCP).
(the development of this function is still in progress)

Setting the interface: — Interface configuration file comconf.cfg (— p. 76)
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Address assignment in Ethernet networks

In the Ethernet network every IP address MUST be unique.
The following IP addresses are reserved for network-internal purposes and are therefore not

14436

allowed as an address for participants: nnn.nnn.nnn.0 | nnn.nnn.nnN.255.

Only network participants whose subnet mask is identical and whose IP addresses are
identical with respect to the subnet mask can communicate with each other.

Rule:

If part of the subnet mask = 255, the corresponding IP address parts must be identical.
If part of the subnet mask = 0, the corresponding IP address parts must be different.

If the subnet mask = 255.255.255.0, 254 participants communicating with each other are

possible in the network.

If the subnet mask = 255.255.0.0, 256x254 = 65 024 participants communicating with each
other are possible in the network.

In the same physical network different subnet masks of the participants are allowed. They
form different groups of participants which cannot communicate with groups of participants

having other subnet masks.

Examples:

l i In case of doubt or problems please contact your system administrator.

Participant A
IP address

Participant A
Subnet mask

Participant B
IP address

Participant B
Subnet mask

Communication of
participants possible?

192.168.82.247

255.255.255.0

192.168.82.10

255.255.255.0

Yes, 254 participants possible

192.168.82.247

255.255.255.0

192.168.82.247

255.255.255.0

No (same IP address)

192.168.82.247

255.255.255.0

192.168.82.10

255.255.0.0

No (different subnet mask)

192.168.82.247

255.255.255.0

192.168.116.10

255.255.255.0

No (different IP address

range:
82 vs. 116)
192.168.222.213 255.255.0.0 192.168.222.123 255.255.0.0 Yes, 65 024 participants
possible
255.255.0.0 192.168.222.123 255.255.0.0 Yes, 65 024 participants

192.168.111.213

possible

192.168.82.247

255.255.255.0

192.168.82.0

255.255.255.0

No; the whole network is
disturbed because the IP
address xxx.xxx.xxx.0 is not
allowed
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7.3.3 Configure CAN interfaces

23156
The CAN interfaces are configurable as follows:

e via system configuration:
» CANopen
« SAE J1939

e via function block:
* RAW-CAN

Under Vendor = 3S, you will find, among others, the following entries:

CIA CANopen

+- CIA CANopenManager

+- CANopen_Manager

+- CANopen_Manager_SIL2
+- CIA Local Device

+- CANopen Device
+- CANopen Device SIL2
SAE J1939

+- SAE J1939 Manager
+- J1939_Manager
23368
A WARNING

The safety functionality is in preparation.
At present the device has NO safety functionality!

» Do NOT use the device for safety-related functions!

The functions of the following protocols are available, but NOT yet suitable for safety applications:
* CANopen_Manager_SIL2
* CANopen_Device SIL2
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via system configuration: CANopen Manager

23159
In the CODESYS device tree, you will find the following entry under each PLC:
[Communication] > [CAN]

! Configure each interface only at ONE position!

Attach CAN bus

In the CODESYS device tree: Right mouse click on [Communication] > [CAN].
Select [Add Device...].

Window [Add Device] appears.

Select [Vendor:] [ifm electronic].

In the list below: Select [ifmCANbus].

Confirm the selection with [Add Device].

Close the window [Add Device] with the [Close] button.

vVyvyvyVvvyy

Assign CAN interface
» Inthe CODESYS device tree: Double-click on [Communication] > [CAN] > [ifmCANBus].

» Tab [General] > [General] > [Network]:
assign this setting with A/V¥ to a CAN interface.
permissible = 0...3

» Select the required value for baud rate [Baudrate (bit/s)] from the list field.

Attach CANopen manager

In the CODESYS device tree: Right mouse click on [Communication] > [CAN] > [ifmCANBus].
Select [Add Device...].

Window [Add Device] appears.

Select [Vendor:] [<All vendors>].

In the list below: Select [Fieldbusses] > [CiA CANopen] > [CiA CANopenManager] >
[CANopenManager].

Confirm the selection with [Add Device].
Close the window [Add Device] with the [Close] button.

vvyvyy

vy

71



ifm Programming Manual ecomatController/60-1 (CR711S) Operating System V2.5.0.n 2017-12-19

System configuration Configure interfaces

o Set CANopen manager parameters

» Inthe CODESYS device tree: Double-click on [Communication] > [CAN] > [CiA
CANopenManager] > [CANopenManager].

» Tab [General] > [General] > [Node ID]:
assign a node ID to this interface using A/V.
permissible = 1...127

» Select the further parameters according to the requirements, e.g.:
= Configure the heartbeat protocol in the section [Nodeguarding]:

Click on the field of options in order to activate [Heartbeat Producing]

Set the parameters [Node ID] and [Producer Time (ms)]

Configure the sync protocol in the section [Sync]:

Click on the field of options to activate [Enable Sync Producing], if necessary.

Set the parameters [COB-ID (Hex)], [Cycle Period (us)] and [Window Length (us)]
» In the section [Time]: The time protocol is not supported.

> With the menu [File] > [Save Project], the values become valid.

R A 4

vy

l i The sync protocol triggers the receiving/sending of data of the CANopen devices (input:
SDO 16#1800/ output: SDO 16#1400).
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via system configuration: CANopen device

23523
In the CODESYS device tree, you will find the following entry under each PLC:
[Communication] > [CAN]
These entries are equivalent.
Attach CAN bus
In the CODESYS device tree: Right mouse click on [Communication] > [CAN].
Select [Add Device...].
Window [Add Device] appears.
Select [Vendor:] [ifm electronic].
In the list below: Select [ifmCANbus].
Confirm the selection with [Add device].
Close the window [Add device] with the [Close] button.

vvyvyVvVyVvVvYyyvy?®

Assign CAN interface
In the CODESYS device tree: Double-click on [Communication] > [CAN] > [ifmCANBus].

» Tab [General] > [General] > [Network]:
assign this setting with A/V¥ to a CAN interface.
permissible = 0...3

v

» Select the required value for baud rate [Baudrate (bit/s)] from the list field.

e Attach CANopen device

» Inthe CODESYS device tree: Right mouse click on [Communication] > [CAN] > [ifmCANBus].
» [Add Device...] Select .

> Window [Add Device] appears.

» Select [Vendor:] <All vendors>.

» In the list below: Select [Fieldbusses] > [CiA CANopen] > [Local Device] > [CANopenDevice].
» Confirm the selection with [Add Device].

» Close the window [Add Device] with the [Close] button.

o Set CANopen device parameters

» Inthe CODESYS device tree: Double-click on [Communication] > [CAN] > [CANopenDevice].

» Tab [General] > [General] > [Node ID]:
assign a node ID to this interface using A/V.
permissible = 1...127

Select the further parameters according to the requirements.
> With the menu [File] > [Save Project], the values become valid.

v

@ When activating the option field [Werkseinstellungen]: Each time the controller is switched

on or the program is downloaded, the settings are reset to factory settings. Thereby, user
settings can be overwritten. The type and the scope of reset settings depend on the
CANopen device.

l i In the CANopen Device, the correct baud rate and the node ID must be set, so that the
CANopen master will recognise the device.
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via system configuration: J1939 manager

In the CODESYS device tree, you will find the following entry under each PLC:
[Communication] > [CAN]
These entries are equivalent.

° vVyvyvyVvvyy

v

vyvyvyVvyyvy®

v

>

Attach CAN bus

In the CODESYS device tree: Right mouse click on [Communication] > [CAN].
Select [Add Device...].

Window [Add Device] appears.

Select [Vendor:] [ifm electronic].

In the list below: Select [ifmCANbus].

Confirm the selection with [Add Device].

Close the window [Add Device] with the [Close] button.

Assign CAN interface
In the CODESYS device tree: Double-click on [Communication] > [CAN] > [ifmCANBus].

Tab [General] > [General] > [Network]:
assign this setting with A/V¥ to a CAN interface.
permissible = 0...3

Select the required value for baud rate [Baudrate (bit/s)] from the list field.

Attach J1939 manager

In the CODESYS device tree: Right mouse click on [Communication] > [CAN] > [ifmCANBus].

Select [Add Device...].

Window [Add Device] appears.

Select [Vendor:] <All Vendors>.

In the list below: Select [Fieldbusses] > [SAE J1939] > [J1939 Manager] > [J1939_Manager].
Confirm the selection with [Add Device].

Close the window [Add Device] with the [Close] button.

Set J1939 manager parameters
In the CODESYS device tree: Double-click [Communication] > [CAN] > [J1939_Manager].

Tab [General] > [Database] > [Database]:
select the list from the required database.
default = J1939Default

l i Users can use their own databases.

They must be at the following storage location:
C:\ProgramData\CODESYS\J1939 Databases

The directory ProgramData is hidden by default.

With the menu [File] > [Save Project], the values become valid.
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Attach J1939-ECU

» Inthe CODESYS device tree: Right mouse click on [Communication] > [CAN] > [ifmCANBus] >
[J1939 Manager].
» Select [Add Device...].
> Window [Add Device] appears.
» In the area [Device]: [Vendor:] select <All vendors>.
» In the list below: Select [Fieldbusses] >[J1939] > [J1939 ECU] > [J1939_ ECU].
» Confirm the selection with [Add Device].
» Close the window [Add Device] with the [Close] button.
e Set J1939-ECU parameters
» Inthe CODESYS device tree: Double-click on [Communication] > [CAN] > [J1939 Manager] >
[J1939_ECU].
» Make the following settings in the tab [General] in the section [General] according to the specific
application:
User case [Local Device] Significance [Preffered Address]
*»  Receiving broadcast data of the ECU D deactivated Addr_ess of the ECU from which the data is to be
= No transmission received
»  Sending data (broadcast and P2P) activated Address of the ifm controller
= Receiving P2P data
» Add parameter groups in the tab [TX-Signals] by clicking on [Add PG].
> The settings become valid with menu [File] > [Save Project].

via function block: RAW-CAN

23160

The Library ifmRawCAN.library (— p. 161) features several function blocks for this application.
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734 Interface configuration file comconf.cfg

22929

The file directory /com of the device contains the file comconf. cfg.

To change the configuration data of the following interfaces, this file must be written into the device
with the corresponding changes:

* Serial interface

* Ethernet interface

» CAN interfaces

Factory setting of the content:

[ETHERNET]
Number=1

[ETHERNET®]
IpV4Address=192.168.82.247
Ipv4SubnetMask=255.255.255.0
IpV4Gateway=192.168.82.21
UDPPort=12345

[CAN]
Number=4

[CANO]
Baud rate=250000
NodeId=127

[CAN1]
Baud rate=250000
NodeId=126

[CAN2]
Baud rate=250000
NodeId=125

[CAN3]
Baud rate=250000
NodeId=124

[com]
Number=1

[coMo]

Baud rate=115200
Bits=8

Parity=e

Stop=1

» To start the (deactivated) device with these default settings:
(the file comconf. cfg is not taken into consideration)
TRUE on connection RESET-COM (Pin 72) simultaneous wtih POWER-ON
After the start-up: FALSE on RESET-COM

» To start the (deactivated) device with the content of the (new) file comconf. cfg:
FALSE on connection RESET-COM (Pin 72) simultaneously with POWER-ON
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8 Programming

Contents
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8.1 Objects of a PLC application

22915
All objects of a PLC application are listed as sub-elements of the node [Application] in the device tree.
In the basic configuration, a PLC application contains the following objects:

P SLGIUAIU L (LR L1 SLaIGIU)
=&l PLC Logic
=1} Application
iy Library Manager
PLC_PRG (PRG)
=-[# Task Configuration

+-38 Task
[Application] Container for objects of a PLC applications
[Library manager] Provides access to the standard and device-specific function libraries:
— Use ifm function libraries
[PLC_PRG(PRG)] Provides access to the editor of the PLC application

— Create PLC application (— p. 78)

[Task configuration] Provides access to the settings of the task processing:
— Configure task processing (— p. 80)

If necessary, the user can add further objects to the PLC application.
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8.2 Create PLC application

23457

» Familiarise yourself with the following CODESYS functions!
= — Online help > CODESYS Development System > Programming Applications

CODESYS automatically generates the function block PLC_PRG (PRG) during project creation. The
function block is processed cyclically. Other programs are called in this function block.

To create a PLC application:

» In the device tree: Double-click on [Application] > [PLC_PRG (PRG)]

> Editor window shows input mask of the selected programming language.
» Enter program code.

8.2.1 Supported programming languages

23454
The following table shows which ifm function libraries support which programming languages
according to IEC 61131

o o
~ O L
2 %) o
= < =
© =
N N .
g S 3 £ g 5
© - = (8] = ~
% g Z 5 £ 5
3 2 = = s o)
= h = 7} o
o o] o =} o] o
c = = o S o
o < o = S
= ) S = = =
b3 S s = % o
c g ® g o g
Library 2 ) £ o = @
ifmDeviceCR711S.library X X X X X X
ifmCANopenManager.library X X X X X X
ifmRawCAN .library X X X X X X
ifmFastinput.library X X X X X X
ifmlOcommon.library X X X X X X
ifmOutHBridge.library X X X X X X
ifmOutGroup.library X X X X X X
ifmOutPWM.library X X X X X X

Legend:
X = is supported
— = is not supported
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8.2.2 Supported variable types

Contents

Retain variables

The device supports the following variable types:

Local variables

l i » Familiarise yourself with the following CODESYS functions!

— Online help > CODESYS Development System > Reference Programming >
Variable Types and special Variables > Local Variables - VAR

Global variable list

— Online help > CODESYS Development System > Reference Programming >
Variable Types and special Variables > Global Variables - VAR_GLOBAL

Network variables (currently not supported)
— Online help > CODESYS Development System > Exchanging Data on the

Network > Network Variables

Variable type Declaration Scope of validity Memory behaviour
; ; i volatile

local In the declaration part of the POU Qpplles only to the POU in which it has '
local retain een declared non volatile
global volatile

in the global variable list (GVL) applies to all POUs of the project i
global retain non volatile
network Values are available to all projects in Volatile

. . the whole network if the variable is

In network variable lists . 3 . ; .

Network retain Icontamed in their network variables non volatile
ists.

Retain variables

For performance reasons, do not overuse 64 bit variables!
CAN network variables are not supported!

23613

Variables declared as RETAIN generate remanent data. Retain variables keep the values saved in
them when the device is switched on/off or when an online reset is made.

Typical applications for retain variables are for example:
* operating hours which are counted up and retained while the machine is in operation,
* position values of incremental encoders,

* preset values entered in the screen device,
* machine parameters,
i.e. all variables whose values must not get lost when the device is switched off.
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8.2.3 Options to access input and output data

17621

In a CODESYS project, each input and output has a physical address according to the IEC standard
(e.g. %IW5). CODESYS offers the following options to access this address from a PLC application and
thereby to access the input and outputs data of the device:

e Access to IEC address via AT declaration
e Definition of an ALIAS for an IEC address
e Link a program variable to an IEC address (mapping)

8.2.4 Configure task processing

23487

» Familiarise yourself with the following CODESYS functions!

= Task configuration:
— Online help > CODESYS Development System > Programming Applications >
Task Configuration

The processing of the tasks is controlled by parameters. The user can set the parameters for each
task.

CODESYS automatically creates the following task when the project is created:

Name Description

Task Task for the processing of the main program [PLC_PRG (PRG)]
] For subprograms with POUs that are to be executed several times per PLC cycle:
- » Create new task.

» Configure task properties:
1. [Priority]: permissible = 0 (high) ... 3 (low)
(select a priority for each task)
2. [Type]: Cyclic
3. [Interval]: Interval of the task call-ups in [ms]
The interval time must be longer than the runtime of the task.

» Recommended: Activate watchdog: — Configure IEC watchdog (— p. 37)
The watchdog time must be shorter than the interval time.
The watchdog time must be longer than the runtime of the task.

» Assign subprogram with POUs to the newly created task.
If the CAN buses are heavily utilised:

» Configure task properties:
1. [Priority]: high
2. [Type]: Cyclic
3. [Interval]: requested cycle time (=transmission interval)
» Assign subprograms with the POUs for CAN communication to the CAN tasks.

80



ifm Programming Manual ecomatController/60-1 (CR711S) Operating System V2.5.0.n 2017-12-19

Programming

Use ifm function libraries

8.3 Use ifm function libraries
23458
ifm electronic provides the following function libraries for the programming of the device under
CODESYS 3.5:
Name Description
ifmCANopenManager Functions for use of the CAN interfaces as CANopen Manager
ifmDeviceCR711S Data structures, enumeration types and global variables
ifmFastinput Functions to access the fast inputs of the device
ifmlOcommon Functions for access to the inputs and outputs of the device
ifmlOconfigDiagProt Functions to configure the 1/O-related diagnostic and protective functions
ifmOutGroup Functions to control output group switches
ifmOutHBridge Functions to access H-bridge outputs
ifmOutPWM Functions to access PWM outputs
ifmRawCAN Functions for use of the CAN interfaces as CAN Layer 2
ifmSyslInfo Functions to set / read system information
ifmTypes Global types and interfaces for other ifm libraries
@ Detailed information about the ifm function libraries: — ifm function libraries (— p. 102)
8.3.1 Access to inputs
23600

To access the inputs of the device, the following functional elements are available:

Function element

Input (— p. 125)

FastCount (— p. 116)
IncEncoder (— p. 118)
Period (— p. 120)

Short description

Assigns an operating mode to an input channel
Provides the current state of the selected channel

Counter block for fast input pulses
Up/down counter function to evaluate encoders

* measures at the indicated channel:

the frequency and the period length (cycle time) in [us],
* measures at the indicated channel pair:

the phase shift in [°] between channel A and channel B
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8.3.2 Access to outputs

23608

To access the outputs of the device, the following functional elements are available:

Function element Short description

Output (— p. 128) Assigns an operating mode to an output channel

Provides the current state of the selected channel
OutputGroup controls the activation status of an output group and provides diagnostic information about the

group and the connected outputs. Using the FB, an output group including the corresponding

outputs can be switched on or off.

HBridge (— p. 148) H bridge on a PWM channel pair
PWM1000 (— p. 156) Initialises and configures a PWM-capable output channel
the mark-to-space ratio can be indicated in steps of 1 %o
CurrentControl (— p. 153) Current controller for a PWMi output channel
8.3.3 Control device

The following function elements are available to control the device:

Function element Short description

SupplySwitch (— p. 133) Switch off the unit

SetLED (— p. 131) Change the frequency and the colour of the status LED in the application program
8.34 Read device information

To read information from the device the following functional elements are available:

Function element Short description
SystemSupply (— p. 135) indicates the value of the system voltage
Temperature (— p. 137) indicates the value of the system temperature
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8.4 Use 10 mapping

Contents
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AACCESS OUIPULS ... eeeeieeiiiite ettt ettt s ettt e e e 4 ettt e e e e 4 e e e et e e e e e 4 e an e e et e e e e e s e ann e e eeeaesesaannn 85

Read diagnostic data Of the TEVICE .........uiiiiiiiiieii et 86
23498

During the 10 mapping (I/0O image), global variables are coupled to the IEC addresses (%Ixx, %Qxx).
Via symbol names, the user has access to the following elements from the application:

e inputs and outputs

e Functions of the operating elements

e Functions of the display elements

e States of system components and characteristic values

The addresses of the system flags can change if the PLC configuration is extended.
» While programming only use the symbol names of the system flags!
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8.4.1

Access inputs

23499

The user can use the following global variables to access the operating modes and the values of the

inputs of the device.

) Data Access | Description Possible values
Variable t
ype
INnnnn_I.
ValueAnalogue UINT r Value of the analogue input 0
65535
ValueDigital BIT r Value of the digital input FALSE Input deactivated
TRUE Input activated
ValueCount UDINT r Value of the counting input 0
4294967295
ValueCountincEnc DINT r Value of the encoder input -2147483648
2147483647
ValueLastCountWasUp BIT r Counting direction upwards FALSE not active
TRUE active
ValuelLastCountwasDown | BIT r Counting direction downwards | FALSE not active
TRUE active
ValueCycle UDINT r cCcle time 0
4294967295
ValueFreq REAL r Frequency 1.401e-45
3.403e+38
ValueTime UDINT r Elapsed time since the last 0
edge evaluation
4294967295
valueRatio UINT r Pulse/pause ratio 0
65535
Error BIT r Error FALSE no error
TRUE Error
INNnnnn_Q.
CountDirection ENUM of | riw Read/set counting direction COUNT_OFF Counting off
INT COUNT_UP Counting upward
COUNT_DOWN | Zahlen abwarts
Counting downward BIT w Set preset value FALSE no action
TRUE Set preset value

Legend:
r = read only
riw = read and write

(&)

» Observe configuration of the inputs! — Configure inputs and outputs (— p. 67)

84

The valid value ranges and the type and number of the variables of the input depend on the
active operating mode of the input.
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8.4.2

Access outputs

23515

The user can use the following global variables to access the operating modes and the values of the
outputs of the device.

. Data type | Access | Description Possible values
Variable
OUTnnnn_I
outCurrent UINT riw Current value of the analogue 0
output
65535
Ratio UINT riw PWM Ratio 0
65535
OutVoltageDiag UINT r Measured voltag(_e value of the 0
analogue output in mV
65535
OutCurrentDiag UINT r Measured current value of the 0
analogue output in mA
65535
OutState BIT riw Output status 0
4294967295
Error BIT riw Error FALSE no error
TRUE Error
OUTnnnn_Q
ValueAnalogue UINT riw Analogue output value 0
65535
ValueDigital UINT riw Digital output value 0
65535
OutVoltage UINT riw Output voltage 0
65535
Error BIT riw Error FALSE no error
TRUE Error
Legend:
r =read only

r/iw = read and write

(&)

» Observe configuration of the outputs! — Configure inputs and outputs (— p. 67)

85

The valid value ranges and the type and number of the variables of the output depend on the
active operating mode of the output.
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8.4.3 Read diagnostic data of the device

23528
The user can use the following global variables to access the current diagnostic data of the device:

Data type | Access | Description Possible values
Name
iTemperature0 INT r Temperature on the system board | -32768
(value in °C)
32767
iTemperaturel INT r Temperature on the system board | -32768
(value in °C)
32767
uiVoltageVBB15 UINT r Voltage at power input VBB15 0 0mvV
(value in mv)
65535 [ 65535 mV
uiVoltageVBB30 UINT r Voltage at power input VBB30 0 omv
(value in mv)
65535 [ 65535 mV
Legend:
r = read only
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8.5 Use RawCAN (CAN Layer 2)

Contents
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RawCAN: Request and send remote CAN MESSAGES .....ueeiruurreeiiurreeiaireeesaireeesanreeesasnreeesannreeessannnes 88

» Observe the notes on task configuration! (— Configure task processing (— p. 80))

In order to access one of the CAN interfaces configured for CANopen operation, the following POUs
are available.

Requirements:

e The CAN interface is configured for operation as RawCAN (CAN Layer 2)
(— Configure CAN interfaces (— p. 70)).

8.5.1 RawCAN: Control CAN network nodes

23546
The following POUs are available to control a node in a CAN network:
Function element Short description
CAN_Enable (— p. 162) initialises the specified CAN interface
configures the CAN baud rate
CAN_Recover (— p. 164) controls the processing of a failure of the specified CAN channel
If the CAN channel fails, reset the CAN interface and reboot
8.5.2 RawCAN: Send and receive CAN messages
23547

The following POUs are available to send or receive messages in a CAN network:

Function element Short description
CAN_Rx (— p. 170) configures a data receive object and reads the receive buffer of the data object
CAN_RxMask (— p. 172) receives CAN messages of a non-coherent area

The area is defined via a bit pattern and a bit mask

CAN_RxRange (— p. 174) receives CAN messages of a coherent area
The area is defined via an upper and lower limit

CAN_Tx (— p. 176) asynchronous transmission of CAN messages
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8.5.3 RawCAN: Request and send remote CAN messages

23548

The following POUs are available to request remote messages in a CAN network or to send replies to
a remote request:

Function element Short description
CAN_RemoteRequest (— p. 166) Send a request for a remote message
CAN_RemoteResponse (— p. 168) reply to the request of a remote message
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8.6 Use CANopen

Contents
CANOpeN: Send and reCeIVE SDO .........uiiiiiiiiiie et e et e et e e e e e e e 89
CANopen: Network Management (NIMT) ..ottt e e e 89
23544
1 » Observe the notes on task configuration! (— Configure task processing (— p. 80))
o

» Observe the notes about CANopen! (— System manual)

In order to access one of the CAN interfaces configured for CANopen operation, the following POUs
are available in ifm libraries.

Further POUs are available in CODESYS libraries from 3S.
Requirements

e The device is configured as CANopen manager (master)
(— via system configuration: CANopen Manager (— p. 71)).

8.6.1 CANopen: Send and receive SDO

23537
The following POUs are available to send or receive Service Data Objects (SDO):

Function element Short description
COP_SDOread (— p. 105) Read Service Data Object (SDO)
COP_SDOwrite (— p. 107) Write Service Data Object (SDO

8.6.2 CANopen: Network Management (NMT)

23539
The following POUs are available for the management of the CANopen network:

Function element Short description
COP_GetNodeState (— p. 103) Request state of one or several CANopen devices
COP_SendNMT (— p. 109) Send an NMT control command to a CANopen device
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8.7 Use SAE J1939

To use the SAE J1939 network protocol, 3S provides the library IoDrvJ1939.

23802
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9 Operation

Contents
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» Familiarise yourself with the following CODESYS functions!

e Translate project/application and transfer to the device
— Online help > CODESYS Development System > Transferring Applications to the PLC

9.1 Transfer CODESYS project to device

Contents
Load the application t0 the HEVICE ...........uiiiiiiiii e e 91
Delete application from CRT7LLS ......cooiiiiiieiiiiie ettt ettt e b e s anb e e e e sbe e e e esbeeeeeanenes 92
23493
To save the CODESYS project on the device, transfer the following component:
e Application (— Load the application to the device (— p. 91))
] » Observe notes on the operating modes of the PLC of the device!
d — Operating states of CR711S
9.1.1 Load the application to the device
23494

To transfer the created application as boot project to the device:
Requirements:
> Communication path is set (— Set communication path of PLC (— p. 61)).
> Project tested.
1 Translate application
» In the device tree: highlight application as active application.
» Use [Build] > [Rebuild] to translate the active application.
> CODESYS generates program code.
2  Load application to the device
» Only for safety PLC: Change to debug mode with [SIL2] > [Enter debug mode...].
» Use [Online] > [Login] connect with the device.
> Active application is loaded to the device (download).
> Application on the device is in the STOP state.
3 Start application
» Use [Debug] > [Start] to start the application.
> Application goes to the RUN state.
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9.1.2 Delete application from CR711S

18030
To delete an application stored on the device:
1 Connect with the device
» In the device tree: highlight application as active application.
» Use [Online] > [Login] to establish connection to the device.
> CODESYS is in the online mode.
2 Delete application
» In the editor window: Select [Device] > [Applications] tab.
» Press [Refresh List] to refresh the view.
> List shows the applications that are stored on the device.
>

Delete all applications in the device with [Remove All].
OR:
Highlight requested application and press [Remove] to delete it from the device.

> Selected application will be deleted.
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Operating states

9.2

Operating states

The following figure shows the possible operating modes of the device:

SYSTEM_STOP

23421

POWER_OFF (initial)
Application Application
‘ ’ STOP STOP
Process Communication | Service Communication [~——=J=— DProcess Communication | Service Communication
‘_> OFF ON OFF OFF
I 5 I
INIT
Application
STOPP
Process C ication | Service Communication
OFF OFF
i | LD
Safety PLC: OPERATING
Standard PLC: OPERATING
RUNTIME_STOP RUNTIME_OPERATING
Application Application
STOPP OPERATING
Process Communication | Servicea Communication Process Communication | Service Communication
OFF ON IEC-Controlled ON
IAARARRARRAARARARY T T
RUNTIME_DEBUG_STOP RUNTIME_DEBUG_RUN
Application Application
STOPP . OPERATING
Process Communication | Service Communication Process Communication | Service Communication
OFF ON | g |IEC-Controlled ON
| LED e I s I
UPDATE SHUTDOWN
Application Application
STOPP SHUTDOWN
Process Communication | Service Communication Process Communication | Service Communication
e |
— OFF ON OFF OFF =
| [ ] ] ! LtED [ no change ] LFD
il
It contains:

« status of the application

« status of the process communication (inputs/outputs, CAN bus)

« status of the service communication (connection with the programming device)
« display of the LEDs SYS0/ SYS1
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9.3 Status LEDs

The device has the following LEDs:

LED Description

Status of the standard PLC
SYSO Status of the ifm operating system
Status of the bootloader

Status of the safety PLC

SYs1 Status of the ifm operating system

ETHO Status of the Ethernet interface 0

ETH1 Status of the Ethernet interface 1

APPLO
APPL1
APPL2
APPL3

LEDs for free use in the application

9.3.1 Status LED: system ifm operating system (SYS0+SYS1)

For the status of the ifm operating system, both LEDs SYS0 and SYS1 are lit simultaneously:

LED colour Display Description
permanently off ifm operating system on the unit: POWER_OFF
off
I O O
t
permanently on ifm operating system on the unit: INIT
Green

t

rmanently on
permanently o Error class = A

Red

L

no change ifm operating system on the unit: SHUTDOWN
no change

no change

Flashing with 2 Hz ifm operating system on the unit: UPDATE
green-yellow

t  (time frame = 200 ms)

ifm operating system on the unit: SYSTEM_STOP
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9.3.2

Status LED: system PLC (SYS0, SYS$1)

23436

The SYSO LED is for the "standard PLC".
The SYS1 LED is for the "safety PLC".

The status of one of the PLCs has no influence on the display of the other PLC.

LED colour Display Description

Green

Green

Yellow

Yellow

Red

9.33

RUNTIME_OPERATING

permanently on no application loaded

RUNTIME_OPERATING
Application = RUN

T T T | | T T | |

Flashing with 2 Hz

t  (time frame = 200 ms)

RUNTIME_DEBUG_RUN
Application = RUN

I Y o

Flashing with 2 Hz

t  (time frame = 200 ms)

RUNTIME_DEBUG_STOP
Application = STOP

permanently on

t

RUNTIME_STOP
Error class =B

LA,

flashes with 10 Hz

(time frame = 200 ms)

Status LED: System bootloader (SYS0)

23426

The SYSO0 LED is for the bootloader status only.
The SYS1 LED is switched off in these cases.

23561

! Only execute the bootloader update when explicitly requested by ifm!

LED colour Display Description

Flashing with 5 Hz no runtime system loaded
oreen TNalsTaNaYsTatal= I

t  (time frame = 200 ms)

flashes with 5 Hz Bootloader update process active
green-yellow

e,

(time frame = 200 ms)
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934 Status LED: Ethernet interfaces (ETHO, ETH1)

The two Ethernet interfaces indicate their status as follows:

LED colour Display Description

Ethernet connection is established

permanently on non data traffic

Green
| L
blinks Ethernet connection is established
with data traffic
Green
o o e

9.3.5 Controlling LEDs in the applications

The LEDs APPLO to APPL3 are for free use in the applications.
This is the function of the FB SetLED (— p. 131).

Possible colours: — LED_COLOUR (ENUM) (— p. 114)
Possible frequencies: — LED_FLASH_FREQ (ENUM) (— p. 114)
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9.4 Reset
Contents
SUPPOITEU FESET VAITANTS ...eeeiiutiieeiiitiiee ettt ettt e ettt e e e sttt e e e e et e e e aab et e e e aabe e e e e anbe e e e e anbneeeeanbreeeeannees 97
ReSEt aPPIICALION (WEIMN) ...eiiiiiiteiiieie ettt sttt s et s bt e s eas et e e e s be e e e aas bt e e e nbn e e e enbneeeennnnes 97
RN =T o] o] [Tor=1 1o o W (ole] (o ) I PO P PP PPPP P 98
RN R o] o] [Tor= 1o o W (o] o 1 ) F PP PP PP PP 98
18025
9.4.1 Supported reset variants
18613

The following table shows the reset variants supported by the device-internal CODESYS PLC and the

resulting system behaviour:

System behaviour
Type of reset

Triggering actions

Reset (warm) = application goes to STOP state.

initialised.

= Remanent variables (VAR RETAIN) of the
application keep their current values.

= Standard variables (VAR) of the application are

— Reset application (warm) (— p. 97)

Reset (cold) = application changes to the STOP state.
= All variables (VAR, VAR RETAIN) of the
application are initialised.

— Reset application (cold) (— p. 98)

Reset (default) = application goes to STOP state.

= The application on the PLC is deleted.

= All variables (VAR, VAR RETAIN) of the
application are initialised.

= PLCis reset to the default state.

— Reset application (origin) (— p. 98)

o]

&

specific standard value (e.g. INT = 9).

94.2 Reset application (warm)

To reset the application:

In the device tree: Select [Application] and select
[Online] > [Login] as active application.

CODESYS changes to the online mode.

Select [Online] > [Reset warm] to reset the application.
Application changes to the STOP state.

Standard variables are newly initialised.

Retain variables keep their values.

vV V V ‘y Vv ‘y V'

97

A variable that has been declared without an initialisation value is initialised with the variable-

7233
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Reset

943 Reset application (cold)

To reset the application:

>
| 2
>
| 2
>
>

In the device tree: Select [Application].

Select [Online] > [Login].

CODESYS changes to the online mode.

Select [Online] > [Reset cold] to reset the application.
Application changes to the STOP state.

All variables are newly initialised

94.4 Reset application (origin)

To reset the application:

vV V V ‘y Vv ‘y V'

In the device tree: Select [Application].
Select [Online] > [Login].
CODESYS changes to the online mode.

Select [Online] > [Reset origin] to reset the application.
Application changes to the STOP state and is deleted.

All variables are newly initialised
PLC is reset to the original state.

98
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9.5 Data transmission for series production

23577

For the series production, application data and stored data can be transferred to the PC and then
transferred from the PC to further devices.

The data transmission takes place in two steps:
1 Data backup from the device to the PC
2 Distribution of the backed up data to the target devices

9.5.1 Transmission of the files with CODESYS

23579
23520

To transfer files between PC and device:
1  Select file view
» In the device tree: Double-click on symbol [Device (CR711S)]
» In the editor window: Select the [Files] tab.
> The editor window shows the file structure on the PC on the left and on the device on the right
2 Transfer file from PC to device
» Highlight the file on the left
» Select device target directory on the right
» Star transfer using the [>>] button
> The file is transferred to the device
3 Transfer the file from the device to the PC
» Highlight the file on the right
» Select PC target directory on the left
» Start the transfer using the [<<] button
> The fle is transferred to the PC
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Data transmission for series production

9.5.2

Data transmission with TFTP

With the aid of the program TFTP, files can be transferred.

Transfer file from device to PC:

IP address = address of the source device, e.g. 192.168.82.247

Source = source file on the device
Target = target file on the PC

Transfer file from PC to device:

tftp -i IP-Adresse PUT source target

IP address = address of the source device, e.g. 192.168.82.247

Source = source file on the PC
Target = target file on the device
Example:

tftp -i 192.168.82.247 PUT [Windows-Pfad]\ifm0S.ifm \os\ifmOS.ifm

9.5.3

The following files must be transferred:

Data name / path
apps

= standard.app
= safe.app

0s

= ifmOS.ifm

cfg
= comconf.cfg

=  memconf.ifm

Files for series production

Description
Folder

Application non-safe

Application safe
Folder

ifmOS
Folder

Communication configuration

Memory configuration

The following file must be transferred according to the kind of application (retain data and free user

data):

Data name / path
retain

= standard.ret

= standard.mb

= safe.ret
= safe.mb
data

™ * %

Description

Folder

Application retain non-safe
Application memory bytes non-safe
Application retain safe

Application memory bytes safe
Folder

Memory space for user-defined data

100
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9.6 Display system information

14161

In the online mode the device tree displays the current values of the following system parameters:

PRATEET Description Possible values
[IP Settings] IP settings —

= [IP Address] IP address of the device E.g. 192.168.0.100
»  [IP Mask] Subnet mask of the network E.g. 255.255.255.0

= [Gateway Address]

IP address of the network gateway

E.g. 192.168.0.2

[Version Firmware]

Version of the installed firmware

E.g.V14.0

[Serial Number Device]

Serial number of the device

E.g. 1511AB019

To display the system information of the device:

VVYVYVYYY

Establish connection between CODESYS and CR711S.
Select [Online] > [Login].

CODESYS changes to the online mode.

In the device tree: Double-click on [System_Info]

In the editor window: Select tab [Parameter].

In the editor window: Table shows current values of the system parameters.
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10 ifm function libraries

Contents

LCT=] 0= = | PRSP 102
Library ifmCANOPEenMaNAgEr.liIDIary .........coocuieii i 102
Library ifmDeVICECROT2LIIDIAIY......ccoiiiiieiiiiiee ettt e e e e e e e 112
MFASTINPULIDIANY ..ot e bt e e et e et e e e anbn e e e e nnnees 115
Library ifmlOCOMMON.IIDIANY .......oviiiiiiiee e e 124
(] o] = U Y14 1@ LU (T o PR 142
(] o] = U YA 14T LU =T o o PR 147
[T o] = U Y14 1@ LU Y PR 152
Library ifMRAWCAN.IDIAIY ......oooeie i s e e e e e s et e e e e e e e sannnnanaeeeeaeas 161

7034

This chapter contains the detailed description of the function libraries provided by ifm electronic for
programming the device under CODESYS 3.5.

10.1 General

23828
General information about:
= — Messages / diagnostic codes of the function blocks (— p. 180)
= — ifm behaviour models for function blocks (— p. 182)
10.2 Library ifmCANopenManager.library
Contents
COP _GEtNOUESEALE ... 103
(010 ] S L@ == o RSP PPPR 105
(10 ] S L@ 1/ (= PR PPPR 107
(010 ] S T= 10 o N RSP PPPR 109
NMT_SERVICE (ENUMY) ...ttt ettt st et e e st e e e e et e e e e anta e e e e snbaeeeasnbaeeeeantaeeeennnees 111
NMT _STATES (ENUM) ..eiiii ittt ettt e stee e e e st e e e e snba e e e e anbaeaeaastaeeeeanbaeeeesnbaeeeeanbaeeeennnees 111
18443

The library contains program blocks (POU) and data structures for the programming of the
functionality of a CANopen Manager.
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10.2.1 COP_GetNodeState

Function block type:
Behaviour model:

Library:
Symbol in CODESYS:

Description

The FB indicates the current state of a CANopen node.

Input parameter

Function block (FB)
EXECUTE

ifmCANopenManager.library

15956

COP_GetNodeState

xExecute
eChannel
usiNode

¥Donef—
xErrorp—
eDiaginfof—
eNMT_State —

18445

18446

Data type | Description Possible values
Parameter
xExecute BOOL Control execution of the FB FALSE FB is executed once
= TRUE
Other No impact on FB processing
eChannel CAN_ Identifier of the CAN Interface — CAN_CHANNEL (ENUM) (— p. 113)
CHANNEL
usiNode USINT ID of the CANopen node 0 Local device
1..127 ID of the CANopen node
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Output parameter

18447

Data type [Description Possible values
Parameter
xDone BOOL Indication of whether execution of the FB FALSE | FB is executed
has been successfully completed
TRUE = FB successfully executed
= FB can be called again
XEFror BOOL Indication if an error occurred during the FB | FALSE | No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO [ Diagnostic information — List below (diagnostic codes:)
eNMT State NMT_ State of the CANopen node — NMT_STATES (ENUM) (— p. 111)
B STATES

Diagnostic codes:
= STAT_INACTIVE
= STAT_BUSY
= STAT_DONE

= ERR_INTERNAL

= ERR_INVALID_VALUE

= ERR_BUS_OFF

= ERR_COMMUNICATION

State: FB/Function is inactive.

State: FB/Function is currently executed.

State: FB/Function has been successfully executed and completed. There are valid

results on the outputs.

Error: Internal system error
» Contact the ifm Service Center!

Error: at least 1 invalid input parameter or invalid combination of input parameters;

Function call has been stopped.

Error: CAN interface is in the "BUS OFF" state

Error: no Connection to the network node or network node not available
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Library fmCANopenManager.library

10.2.2 COP_SDOread

Function block type:
Behaviour model:

Library:
Symbol in CODESYS:

Description

Function block (FB)
EXECUTE

ifmCANopenManager.library

18448

COP_SDOread

—xExecute
—eChannel
—usiNode
—uilndex
—usiSubIndex

—pData

—udiBuffLen
—tTimeout

¥Donef—
xErrorp—
eDiaginfof—
udiLenf—

7144

The FB reads the contents of a Service Data Object (SDO) and writes them into a buffer storage. The
SDO is selected via the CAN interface, the ID of the CANopen node, as well as index and subindex of

the object directory.

The CANopen node has to reply to the request of the FB within a period of time defined by the user.

Input parameters

19832

Data type |Description Possible values
Parameters
xExecute BOOL Control execution of the FB FALSE | FB is executed once
= TRUE
Other No impact on FB processing
eChannel CAN_ Identifier of the CAN Interface — CAN_CHANNEL (ENUM) (— p. 113)
CHANNEL
usiNode USINT ID of the CANopen node 0 Local device
1..127 ID of the CANopen node
uilndex UINT Index in the object directory
usiSublindex USINT Subindex of the index in the object directory
pData Pointer to | Pointer on buffer storage
USINT
udiBuffLen UDINT Size of the buffer storage (in byte)
tTimeout TIME Max. response time E.g. T#25ms
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Library fmCANopenManager.library

Output parameters

11271

Data type [Description Possible values
Parameter
xDone BOOL Indication of whether execution of the FB FALSE | FB is executed
has been successfully completed
TRUE = FB successfully executed
= FB can be called again
XEFror BOOL Indication if an error occurred during the FB | FALSE | No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO [ Diagnostic information — List below (diagnostic codes:)
udiLen UDINT Number of received bytes

Diagnostic codes:

STAT_INACTIVE
STAT_DONE

ERR_CHAN_UNKNOWN
ERR_INVALID_VALUE
ERR_BUFFER_OVERFLOW

ERR_INVALID_OBJ_ENTRY
ERR_TIMEOUT

ERR_INTERNAL

State: FB/Function is inactive.

State: FB/Function has been successfully executed and completed. There are valid
results on the outputs.

Error: Selected communication channel unknown / not configured
Error: At least one input parameter is invalid or outside the value range.

Error: Transmission buffer full; CAN message cannot write to buffer storage and is not
transmitted

Error: Object directory entry is invalid.

Error: The maximum permissible execution time was exceeded. The action was not
finished.

Error: Internal system error
» Contact the ifm Service Center!
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10.2.3 COP_SDOwrite

Function block (FB)
EXECUTE

Function block type:
Behaviour model:

Library:
Symbol in CODESYS:

Description

ifmCANopenManager.library

17128

COP_SDOwrite

—xExecute
—eChannel
—usiNode
—uilndex
—usiSubIndex
—pData
—udiLen
—tTimeout

¥Donef—
xErrorp—
eDiaginfof—

19833

The FB writes the contents of a Service Data Object (SDO). The SDO is selected via the CAN
interface, the ID of the CANopen node, as well as index and subindex of the object directory.

Input parameters

7011

Data type | Description Possible values
Parameters
xExecute BOOL Control execution of the FB FALSE [FB is executed once
= TRUE
Other No impact on FB processing
eChannel CAN_ Identifier of the CAN Interface — CAN_CHANNEL (ENUM) (— p. 113)
CHANNEL
usiNode USINT ID of the CANopen node 0 Local device
1..127 ID of the CANopen node
uilndex UINT Index in the object directory
usiSublindex USINT Subindex of the index in the object directory
pData Pointer to | Pointer on buffer storage
USINT
udiLen UDINT Number of received bytes
tTimeout TIME Max. response time E.g. T#25ms

107



ifm Programming Manual ecomatController/60-1 (CR711S) Operating System V2.5.0.n 2017-12-19

ifm function libraries

Library fmCANopenManager.library

Output parameters

7005

Data type [Description Possible values
Parameters
xDone BOOL Indication of whether execution of the FB FALSE FB is executed
has been successfully completed
TRUE = FB successfully executed
= FB can be called again
XError BOOL Indication if an error occurred during the FB | FALSE No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO | Diagnostic information — List below (diagnostic codes:)

Diagnostic codes:

STAT_INACTIVE
STAT_DONE

ERR_CHAN_UNKNOWN
ERR_INVALID_VALUE
ERR_BUFFER_OVERFLOW

ERR_INVALID_OBJ_ENTRY
ERR_TIMEOUT

ERR_INTERNAL

State: FB/Function is inactive.

State: FB/Function has been successfully executed and completed. There are valid
results on the outputs.

Error: Selected communication channel unknown / not configured
Error: At least one input parameter is invalid or outside the value range.

Error: Transmission buffer full; CAN message cannot write to buffer storage and is not
transmitted

Error: Object directory entry is invalid.

Error: The maximum permissible execution time was exceeded. The action was not
finished.

Error: Internal system error
» Contact the ifm Service Center!
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Library fmCANopenManager.library

10.2.4 COP_SendNMT

Function block type:
Behaviour model:

Library:
Symbol in CODESYS:

Description

Function block (FB)
EXECUTE

ifmCANopenManager.library

COP_SendNMT

—xExecute
—eChannel
—usiNode
—usiNMTservice

¥Donef—
xErrorp—
eDiaginfof—

The FB sends a command for the control of a CANopen node.

Input parameter

7006

7001

6981

Data type |Description Possible values
Parameter
xExecute BOOL Control execution of the FB FALSE FB is executed once
= TRUE
Other No impact on FB processing
eChannel CAN_ Identifier of the CAN Interface — CAN_CHANNEL (ENUM) (— p. 113)
CHANNEL
usiNode USINT ID of the CANopen node 0 Local device
1..127 ID of the CANopen node
usiNMTservice NMT_ Command for the control of a CANopen — NMT_SERVICE (ENUM) (— p. 111)
SERVICE | node
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Library fmCANopenManager.library

Output parameters

7147

Data type [Description Possible values
Parameters
xDone BOOL Indication of whether execution of the FB FALSE | FB is executed
has been successfully completed
TRUE = FB successfully executed
= FB can be called again
XEFror BOOL Indication if an error occurred during the FB | FALSE | No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO [ Diagnostic information — List below (diagnostic codes:)

Diagnostic codes:
= STAT_INACTIVE
= STAT_DONE

= ERR_CHAN_UNKNOWN
= ERR_INVALID_VALUE

= ERR_INTERNAL

State: FB/Function is inactive.

State: FB/Function has been successfully executed and completed. There are valid

results on the outputs.

Error: Selected communication channel unknown / not configured

Error: at least 1 invalid input parameter or invalid combination of input parameters;

Function call has been stopped.

Error: Internal system error
»  Contact the ifm Service Center!
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10.2.5 NMT_SERVICE (ENUM)

7132

Name Description Possible values Data type | Value
NMT_SERVICE Command for the INIT_NODE Initiate CAN node INT 0
‘;ggtero' of a CANOpen FSET BRE_OPERATIONAL | Set preoperational state INT 1
SET_OPERATIONAL Set operational state INT 2
RESET_NODE Reset CAN node INT 3
RESET_COMM Reset communication INT 4
STOP_NODE Stop CAN node INT 5

10.2.6 NMT_STATES (ENUM
( ) 18496

Name Description Possible values Data type | Value
NMT_STATES State of the CAN network INIT Initialisation INT 0
PREOP Preopertional INT 1
OPERATIONAL Operational INT 2
STOP STOP INT 3
NOT_AVAILABLE Not available INT 4
UNKNOWN Unknown INT 5
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10.3 Library ifmDeviceCR0721.library

Contents

CAN_BAUDRATE (ENUM)
CAN_CHANNEL (ENUM)
CANconstants (GVL)
Syslinfo (GVL)
SysiInfoStruct (STRUCT)
LED_COLOUR (ENUM)

LED_FLASH_FREQ (ENUM)

The library contains all device-specific data structures, enumeration types, global variables and

constants.

112



ifm Programming Manual ecomatController/60-1 (CR711S) Operating System V2.5.0.n

ifm function libraries

2017-12-19

Library ifmDeviceCR0721.library

23253
Description Possible values Data type | Value
Name P yP
CAN baud rate Data transmission rate of the CAN KBAUD_20 20 kilobaud INT 20
interface -
KBAUD_33 33.3 kilobaud INT 33
KBAUD_50 50 kilobaud INT 50
KBAUD_83 83.3 kilobaud INT 83
KBAUD_100 100 kilobaud INT 100
KBAUD_125 125 kilobaud INT 125
KBAUD_250 250 kilobaud INT 250
KBAUD_500 500 kilobaud INT 500
KBAUD_800 800 kilobaud INT 800
KBAUD_1000 1000 kilobaud INT 1000
17131
Description Possible values Data type | Value
Name
CAN CHANNEL Identifier of the CAN Interface CHAN_O CAN interface 0 INT 0
CHAN_1 CAN interface 1 INT 1
CHAN_2 CAN interface 2 INT 2
CHAN_3 CAN interface 3 INT 3
10.3.3 CANCconstants (GVL)
20936
Description Data type | Value
Name . o
usiNumberCANitf Number of the CAN interfaces of the devices UINT 4
10.34 Sysinfo (GVL)
20937
Description Data type Value
Name P yp
usiNumberOfSysinfo Number of system components of the device USINT 8
aSyslnfoList Variable with list of the system components ARRAY]J0..8] OF
(— aSyslnfoList (GVL)) SysInfoStruct
(STRUCT) (— p. 114)
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Library ifmDeviceCR0721
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library

10.3.5 SysInfoStruct (STRUCT)

21317

. . Data type Description Possible values
Designation
elnfoType INFO_TYPE System component E.g. FIRMWARE_DEVICE
sValue STRING (255) | Value of the system component E.g.3.1
sName STRING (32) Name of the system component E.g. FW Device

1036  LED_COLOUR (ENUM)

23232

Name Description Possible values Data type | Value
LED_COLOUR Colour of the LED (RGB code) BLACK (OFF) | Off UINT 0x00 0000
WHITE White UINT OxFF FFFF
RED Red UINT O0xFF 0000
GREEN Green UINT 0x00 FFOO0
BLUE Blue UINT 0x00 OOFF
YELLOW Yellow UINT OxFF FFOO0
MAGENTA Magenta UINT OxFF OOFF
CYAN Cyan UINT 0x00 FFFF
10.3.7 LED_FLASH_FREQ (ENUM
( ) 23233
Name Description Possible values Data type | Value
LED_FLASH_FREQ Flashing frequency of the status LED FRQ_OHz off INT 0
FRQ_05Hz 0.5 Hz INT 1
FRQ_1Hz 1Hz INT 2
FRQ_2Hz 2Hz INT 4
FRQ 5Hz 5Hz INT 7
FRQ_10Hz 10Hz INT 8
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10.4 ifmFastinput.library

Contents

(=151 L0 11 1| AP RPON 116
[ Tod = Yoo o =Y SO PPPS 118
[T [0 Yo PR 120
COUNT_DIRECTION (ENUMY) ...cttttiieiiiiitiieeete ettt e et ettt e e e e e e s s siibeaeeeae e e s s annbaaeeeeaeesesnnnsneeees 122
ENCODER_RESOLUTION (ENUM) ....utiiiiiieiiiiiiiiiie e e e e s e e s e e e s et ee e e e e e sanantaeeeaaeeesannsnnnnseaeesens 122
FREQ SENSE _PERIODS (ENUM) ....uuiiiiiiiei i e e s et e e e e e et et e e e e s e saantaeeeaaeeesnnnsnnnneeaeenens 122
MODE_FAST _COUNT (ENUM)....cciiiiiiiiieie e ieiiiee e e e e e e s e ee e e e e e s ssantaeeeeaeessansntaeeeaaeeesansnsnneeeeeeans 122
MODE_INC_ENCODER (ENUM) ... .uiiiiiiiiiie it e e s s e e e e e e s esantae e e e e e e e sanantaeeeaaeeesannsnsnneeaeeeens 123
MODE_PERIOD (ENUM) ....uuiiiiiiieeiiiiiieeie e e e e se st e e e e e e sasitetaeseeaeaasaasantaseeaaeeesanssnsaneeaaeeesansnssnnseeeeas 123

The library contains function blocks (POU) and enumeration types to control the quick inputs of the
device.
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10.4.1

Function block type:

Library:

Symbol in CODESYS:

Description

FastCount

Function block (FB)

ifmlFastInput.library

23262

FastCount

—xR.esetErrar

—uiChannel

—eMode

—eDirection
—udiPresetValue

—xPreset

XErrorf—
eDiagInfof—
¥Prepared—

udivaluef—
udiValueCyclef—
rValueFregf—
udiValueTimef—

23259

The FB functions as a counter block for pulses on fast input channels.

Input parameters

23260

Data type Description Possible values
Parameters
xResetError BOOL Reset request for an occurring error FALSE | When switching from FALSE
TRUE = TRUE: Reset request to the
lower level system
uiChannel UINT Input channel Group + channel
— Data sheet
— Note on wiring (— p. 29)
Examples:
403 Group 4 + channel 3
502 Group 5 + channel 2
eMode MODE_FAST_ | Operating mode of the input channel — MODE_FAST_COUNT (ENUM) (— p. 122)
COUNT
eDirection COUNT_ Counting direction — COUNT_DIRECTION (ENUM) (— p. 122)
DIRECTION
udiPresetValue UDINT Preset counter value permissible = 0...4 294 967 295
xPreset BOOL Changeover switch: counter function FALSE counter active; the number of
active / adopt preset counter value counted pulses is issued to
udiValue.
TRUE The preset counter value is

adopted;
udiValue = udiPresetValue
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Output parameters

23261

Parameters Data type | Description Possible values
XEFror BOOL Indication if an error occurred during the FB | FALSE | No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO | Diagnostic information — List below (diagnostic codes:)
xPrepared BOOL State of the FB outputs FALSE | FB outputs still invalid; FB is
still processed
TRUE FB outputs valid; FB has been
processed
udivalue UDINT Counter value; number of detected pulses permissible = 0...4 294 967 295
udiValueCycle UDINT Cycle time of the input signal in [us]
rValueFreq REAL frequency of the input signal in [Hz]
udiValueTime UDINT Time elapsed since the last edge evaluation |0...4 294 967 295
in [ps]

Diagnostic codes (— Messages / diagnostic codes of the function blocks (— p. 180)):
= ERR_INVALID_VALUE

= ERR_INTERNAL

= ERR_UNDEFINED

= ERR_TIMING
= DIAG_INVALID_VA
= DIAG_INTERNAL

= DIAG_ACCESS

= DIAG_CHANGEOV

LUE

ER_TIME

= DIAG_SLOW_SIGNAL

Error: At least one input parameter is invalid or outside the value range.

Error: Internal system error
» Contact the ifm Service Center!

Error: Unknown error
» Contact the ifm Service Center!

reserved

At least one input parameter is invalid or exceeds the permissible area.

Internal system error.

FB/Function cannot access the required resource; Resource is blocked by another task.

Minimum changeover time for the highside-lowside selection of the drivers has not yet
expired.

Input signal is too slow for the measurement.
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10.4.2 IncEncoder

23298

Function block type: Function block (FB)
Library: ifmlFastInput.library
Symbol in CODESYS: IncEncoder
—xResetError XError f—
—uiChannel eDiagInfof—
—eMode wPreparedf—
—eResolution divaluef—
—diPresetyalus xUpp—
—xPreset ¥Down f—
udiValueCycdep—
rvalueFreqf—
udivalueTimef—
Description

23299

The FB is used to configure and to operate a digital input pair to record and count incremental encoder
pulses.

Two frequency inputs constitute the input pair (channel A and channel B) that is configured and
evaluated via the FB.

Behaviour at the counter limits

If the applicable value range is exceeded, the output switches to the minimum value of the applicable
area. (= overflow)

If the applicable value range is not reached, output switches to the maximum value of the applicable
area. (= outside range)

Input parameter
23300

Data type Description Possible values
Parameters
xResetError BOOL Reset request for an occurring error FALSE | When switching from FALSE
TRUE = TRUE: Reset request to the
lower level system
uiChannel UINT 1. Input channel (channel A) of the pair [ Group + channel
of input channels — Data sheet
— Note on wiring (— p. 29)
Examples:
703 Group 7 + channel 3
1203 Group 12 + channel 3
eMode MODE_INC_ Operating mode of the input channel — MODE_INC_ENCODER (ENUM) (— p. 123)
ENCODER
eResolution ENCODER _ Resolution / encoder mode — ENCODER_RESOLUTION (ENUM)
RESOLUTION (— p. 122)
diPresetValue DINT Preset counter value -2 147 483 648...2 147 483 647
xPreset BOOL Changeover switch: counter function FALSE counter active; the number of
active / adopt preset counter value counted pulses is issued to
udiValue.
TRUE The preset counter value is
adopted;
udiValue = udiPresetValue
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Output parameters

23301
Data type [Description Possible values
Parameters
XEFror BOOL Indication if an error occurred during the FB | FALSE | No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO | Diagnostic information — List below (diagnostic codes:)
xPrepared BOOL State of the FB outputs FALSE | FB outputs still invalid; FB is
still processed
TRUE FB outputs valid; FB has been
processed
divalue DINT Counter value; number of detected pulses permissible = -
2 147 483 648...2 147 483 647
xUp BOOL Code sequence upwards FALSE [ No count-up since the last call
up
TRUE Count-up or overflow since
that last call-up
xDown BOOL Code sequence downwards FALSE [ No count-down since the last
call-up
TRUE Count-up or underflow since
the last call-up
udiValueCycle UDINT Cycle time of the input signal in [us]
rValueFreq REAL frequency of the input signal in [Hz]
udiValueTime UDINT Time elapsed since the last edge evaluation |0...4 294 967 295
in [us]

Diagnostic codes (— Messages / diagnostic codes of the function blocks (— p. 180)):

= ERR_INVALID_VALUE Error: At least one input parameter is invalid or outside the value range.
= ERR_INTERNAL Error: Internal system error
» Contact the ifm Service Center!
= ERR_UNDEFINED Error: Unknown error
» Contact the ifm Service Center!
= ERR_TIMING reserved
= DIAG_INVALID_VALUE At least one input parameter is invalid or exceeds the permissible area.
= DIAG_INTERNAL Internal system error.
= DIAG_ACCESS FB/Function cannot access the required resource; Resource is blocked by another task.
= DIAG_CHANGEOVER_TIME Minimum changeover time for the highside-lowside selection of the drivers has not yet
expired.
= DIAG_SLOW_SIGNAL Input signal is too slow for the measurement.
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104.3 Period

23313

Function block type: Function block (FB)
Library: ifmlFastInput.library
Symbol in CODESYS: Period
—xResetError XErrorf—
—uiChannel eDiagInfof—
—eMode ¥Prepared—
—ePeriods udivalueCyclef—
—udiTimebase rvalueFregf—
udiValueTimef—
uivalueRatiof—
Description

23314
TheFB is used to configure and to operate an input channel or a pair of input channels to detect and
count pulses.
In the operating modes IN_PHASE_CSI and IN_PHASE_CSO (to be set at the eMode function block
input), a phase measurement is carried out on one input channel pair. The input channel pair is
defined by indicating the channel with the even number of the input channel pair (channel A) at the
input uiChannel.

In the other operating modes, a signal evaluation is carried out at the input channel defined at the
uiChannel input.

Input parameters

23315

Data type Description Possible values
Parameters
xResetError BOOL Reset request for an occurring error FALSE [ When switching from
TRUE |FALSE = TRUE: Reset
request to the lower level
system
uiChannel UINT Input channel Group + channel
— Data sheet
— Note on wiring (— p. 29)
Examples:
403 Group 4 + channel 3
502 Group 5 + channel 2
eMode MODE_PERIOD Operating mode of the input channel | — MODE_PERIOD (ENUM) (— p. 123)
ePeriod FREQ_SENSE_PERIODS | Number of pulse periods for — FREQ_SENSE_PERIODS (ENUM)
averaging (= p. 122)
udiTimebase UDINT El;lrg]e base for frequency calculation in — MODE_PERIOD (ENUM) (— p. 123)
Only used in eMode:
= IN_FREQUENCY_CSI
* IN_FREQUENCY_CSO
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Output parameters

23316

Data type [Description Possible values
Parameters
XEFror BOOL Indication if an error occurred during the FB | FALSE | No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO | Diagnostic information — List below (diagnostic codes:)
xPrepared BOOL State of the FB outputs FALSE | FB outputs still invalid; FB is
still processed
TRUE FB outputs valid; FB has been
processed
udiValueCycle UDINT Cycle time of the input signal in [us]
rValueFreq REAL frequency of the input signal in [Hz]
udiValueTime UDINT Time elapsed since the last edge evaluation |0...4 294 967 295
in [us]
uiValueRatio UINT Depends on the mode that is set in the
eMode input.
Pulse/pause ratio of the input signal in [%o]
at:
= IN_PERIOD_RATIO_CSI
* IN_PERIOD_RATIO_CSO
Phase shift of the input signal at the B
channel to the signal at the A channel in [°]
* IN_PHASE_CSI
= IN_PHASE_CSO

Diagnostic codes (— Messages / diagnostic codes of the function blocks (— p. 180)):

STAT_PREPARING

STAT_DONE

ERR_INVALID_VALUE
ERR_INTERNAL

ERR_EXCEEDED_RANGE
ERR_UNDEFINED

ERR_TIMING
DIAG_INVALID_VALUE
DIAG_INTERNAL
DIAG_ACCESS
DIAG_CHANGEOVER_TIME

DIAG_SLOW_SIGNAL

State: FB/FUN is processed; final results are not yet available. Some output values are
updated in each PLC cycle.

State: FB/Function has been successfully executed and completed. There are valid
results on the outputs.

Error: At least one input parameter is invalid or outside the value range.

Error: Internal system error
» Contact the ifm Service Center!

Error: The value exceeds the value range of its data type.

Error: Unknown error
» Contact the ifm Service Center!

reserved

At least one input parameter is invalid or exceeds the permissible area.

Internal system error.

FB/Function cannot access the required resource; Resource is blocked by another task.

Minimum changeover time for the highside-lowside selection of the drivers has not yet
expired.

Input signal is too slow for the measurement.
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10.4.4 COUNT_DIRECTION (ENUM)
23267
Description Possible values
Name
COUNT DIRECTION | Counting direction COUNT_OFF Counting function off
COUNT_UP Counting function up
COUNT_DOWN Counting function down

10.4.5 ENCODER_RESOLUTION (ENUM)
23269
Description Possible values
Name
ENCODER RESOLUTION | Resolution FULL_PERIOD Counts each rising edge on one
- channel (A)
HALF_PERIOD Counts each rising and falling edge
on one channel (A)
EVERY_EDGE Counts each rising and falling edge
on al channels (A and B)

10.4.6 FREQ_SENSE_PERIODS (ENUM)

23270

Description Possible values

Name

Number of clock periods for PERIODS nmitn=1

FREQ_SENSE_PERIODS

No averaging

the averaging

PERIODS nmitn=2...16

Averaging via n periods

10.4.7 MODE_FAST_COUNT (ENUM)
23264
Description Possible values
Name
MODE FAST COUNT | ©perating mode of the inputs | UNCHANGED Setting remains unchanged
IN_COUNT_CsSI Input to count fast signal edges;

Csl

IN_COUNT_CSO

Input to count fast signal edges;
CSsO

MONITOR

= Only output data will be
updated.

= Values, configurations ans
process data are not written.

= For applications that are not
owners of the resource.
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10.4.8

MODE_INC_ENCODER (ENUM)

23271

Name

Description

Possible values

MOTE_INC_ENCODER

Operating mode of the input

UNCHANGED

Setting remains unchanged

IN_INC_ENCODER_CSI

Input for the evaluation of an
incremental encoder, channel A;
(o8]

IN_INC_ENCODER_CSO

Input for the evaluation of an
incremental encoder, channel A;
CSO

MONITOR

=  Only output data will be
updated.

= Values, configurations ans
process data are not written.

= For applications that are not
owners of the resource.

104.9

MODE_PERIOD (ENUM)

23272

Name

Description

Possible values

MODE_PERIOD

Operating mode of the period
input

UNCHANGED

Setting remains unchanged

IN_FREQUENCY_CSI

Input for frequency measurement;
Csl

IN_FREQUENCY_CSO

Input for frequency measurement;
CSO

IN_PERIOD_RATIO_CSI

Input for absolute and ratiometric
period measurement; CSI

IN_PERIOD_RATIO_CSO

Input for absolute and ratiometric
period measurement; CSO

IN_PHASE_CSI

Input pair for phase measurement,
Csl

IN_PHASE_CSO

Input pair for phase measurement,
CsO

MONITOR

= Only output data will be
updated.

= Values, configurations ans
process data are not written.

= For applications that are not
owners of the resource.
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10.5 Library ifmlOcommon.library

Contents
0] LU PP TP PPP PP 125
L@ 11 1 11 PP PP PP PPPPP 128
SEELED ..ttt ettt e e e e bt et e e e e e e e e b et e e e e e e e e e e an b ettt e e e e e e e e nnbeae e et e e e e e e annbreeees 131
10 0] 0]V 1 1 (o PP P PP PPPPRPN 133
YY) (T 1S o) 2 135
LI 00 1=T = LU = PP PP TP PPt 137
FILTER_INPUT (ENUM) ..ttt e e st e e e snbe e e e e anbae e e e snbaeeeesnbaeeeennnes 139
FILTER_OUTPUT (ENUM) ..ottt ittt ettt ettt e e e st e e e assbe e e e e anbaeeeasnbaeeeesnbaeeeennnees 139
MODE_INPUT (ENUMY) ..ottt ettt ettt e e e sttt e e sabe e e e e ambe e e e e asbee e e e anbaeeeasnbaeeeesnbaeeeennnees 140
MODE_OUTPUT (ENUM) ....utiiieiiiiie ettt ettt ettt ettt e et e e e saba e e e e snba e e e e snbaeeeasnbaeeeesnbaeeeennnees 141
SYS VOLTAGE_CHANNEL (ENUM) ...ttt s ettt ee e e s s siieaeeeae e e s e snstaaeeeeeeeseanssneeees 141
21286

The library contains program blocks (POU) and enumeration types for the control of the inputs and
outputs of the device.
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10.5.1 Input

Function block type:

Library:

Symbol in CODESYS:

Description

Function block (FB)

ifmlOcommon.library

Input
—xResetError xErrar
—uiChannel eDiagInfo
—eMode wPrepared
—eFilter wWalueDigital

uivaluetnalogue

The FB is used to configure and read a digital or analogue input channel.

Filter:

The input signal can be changed with a digital low-pass filter.
Configure the filter via the input eFilter.

Input parameters

23155

23164

23157

Data type Description Possible values
Parameters
xResetError BOOL Reset request for an occurring error FALSE | When switching from FALSE
TRUE = TRUE: Reset request to the
lower level system
uiChannel UINT Input channel Group + channel
— Data sheet
— Note on wiring (— p. 29)
Examples:
403 Group 4 + channel 3
502 Group 5 + channel 2
eMode MODE_INPUT | Operating mode of the input channel — MODE_INPUT (ENUM) (— p. 140)
eFilter FILTER_INPUT | Filter definition of the input channel — FILTER_INPUT (ENUM) (— p. 139)
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Output parameters

23158

Data type [Description Possible values
Parameters
XEFror BOOL Indication if an error occurred during the FB | FALSE | No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO | Diagnostic information — List below (diagnostic codes:)
xPrepared BOOL State of the FB outputs FALSE | FB outputs still invalid; FB is
still processed
TRUE FB outputs valid; FB has been
processed
xValueDigital BOOL Logical state of the input in digital operating | FALSE | Low Level
mode . _ [TRUE _[High Level
In case of analogue operation, the output is
FALSE
uiValueAnalogue UINT Measured input value in analogue operating | permissible = 0...65 535
mode.
The interpretation of the input value
depends on the setting at the eMode input.
MODE_INPUT (ENUM) (— p. 140)
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Diagnostic codes (— Messages / diagnostic codes of the function blocks (— p. 180)):

ERR_INVALID_VALUE

ERR_INTERNAL

ERR_UNDEFINED

ERR_SHORT_CIRCUIT
ERR_OPEN_CIRCUIT
ERR_OVERLOAD_CURRENT
ERR_STUCK_AT
ERR_STUCK_AT_HIGH
ERR_STUCK_AT_LOW
ERR_OVERVOLTAGE
ERR_UNDERVOLTAGE
ERR_UNDERVOLTAGE_VBBX

ERR_OVERVOLTAGE_VBBX

DIAG_INVALID_VALUE
DIAG_INTERNAL
DIAG_OPEN_CIRCUIT
DIAG_SHORT_CIRCUIT

DIAG_UNDERVOLTAGE_VBBX "

DIAG_OVERVOLTAGE_VBBX

DIAG_OVERLOAD_CURRENT
DIAG_STUCK_AT
DIAG_STUCK_AT_HIGH
DIAG_STUCK_AT_LOW
DIAG_OVERVOLTAGE
DIAG_UNDERVOLTAGE
DIAG_NO_CALIB

DIAG_ACCESS
DIAG_CHANGEOVER_TIME

Error: at least 1 invalid input parameter or invalid combination of input parameters;
Function call has been stopped.

Error: Internal system error
»  Contact the ifm Service Center!

Error: Unknown error
» Contact the ifm Service Center!

Error: Short circuit with GND or VBBXx.

Error: Open circuit detected. Possible cause: Wire break.
Error: Maximum current exceeded.

Error: Signal is frozen.

Error: Signal frozen, signal state high.

Error: Signal frozen, signal state low.

Error: Maximum signal voltage exceeded.

Error: Minimum signal voltage not reached.

For inputs: Error: Reference voltage not reached.
For outputs. Error: The voltage of the corresponding output group supply or at
VBB30 / VBB15 is not reached.

= Forinputs: Error: Reference voltage exceeded.
For outputs. Error: Voltage of the corresponding output groups supply or at  VBB30
/ VBB15 not reached.

At least one input parameter is invalid or exceeds the permissible area.
Internal system error.
Open circuit detected. Possible cause: Wire break.

Error: Short circuit with GND or VBBX.

For inputs: Error: Reference voltage not reached.
For outputs. Error: The voltage of the corresponding output group supply or at
VBB30 / VBB15 is not reached.

For inputs: Error: Reference voltage exceeded.
For outputs. Error: Voltage of the corresponding output groups supply or at VBB30
/ VBB15 not reached.

Maximum current exceeded.

Error: Signal is frozen.

Error: Signal frozen, signal state high.
Error: Signal frozen, signal state low.
Maximum signal voltage exceeded.

Error: Minimum signal voltage not reached.

The selected resource has no valid calibration.
The displayed values are maybe faulty.

FB/Function cannot access the required resource; Resource is blocked by another task.

Minimum changeover time for the highside-lowside selection of the drivers has not yet
expired.
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10.5.2 Output

23161

Function block type: Function block (FB)
Library: ifmlOcommon.library
Symbol in CODESYS: Output
—xResetError ¥Errorf—
—uiChannel eDiagInfof—
—eMode wPrepared—
—{eFilter wOutstatef—
—uivalue uidutVoltagep—
uiQutCurrent f—
Description
23206
The FB is used to configure and control a digital or analogue output channel.
Input parameters
23162
Data type Description Possible values
Parameter
xResetError BOOL Reset request for an occurring error FALSE | When switching from FALSE
TRUE = TRUE: Reset request to the
lower level system
uiChannel UINT Output channel Group + channel
— Data sheet
— Note on wiring (— p. 29)
Examples:
703 Group 7 + channel 3
1203 Group 12 + channel 3
eMode MODE_OUTPUT | Operating type of the output channel — MODE_OUTPUT (ENUM) (— p. 141)
eFilter FILTER_ Filter definition of the output channel — FILTER_OUTPUT (ENUM) (— p. 139)
OUTPUT
uivValue UINT Value that is to be written to the output
In the digital mode or sensor supply FALSE |Output deactivated
mode; if setting at the eMode input = TRUE | Output activated
= OUT_DIGITAL_CSI
= OUT_DIGITAL_CSO
= OUT_SENSOR_05
= OUT_SENSOR_10
In analogue mode; if setting at the 0...10 000
eMode input =
=  OUT_ANALOGUE_10
Values indicated in [mV]

128



ifm Programming Manual ecomatController/60-1 (CR711S) Operating System V2.5.0.n

ifm function libraries

2017-12-19

Library ifmlOcommon.library

Output parameters

23163

OUT_DIGITAL_CSI and
OUT_ANALOGUE_10

Data type [Description Possible values
Parameters
XEFror BOOL Indication if an error occurred during the FB | FALSE | No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO | Diagnostic information — List below (diagnostic codes:)
xPrepared BOOL State of the FB outputs FALSE | FB outputs still invalid; FB is
still processed
TRUE FB outputs valid; FB has been
processed
xOutState BOOL Return value activation state of the selected | FALSE [ Output is deactivated
output
The state may deviate from the required
output state if e.g. a safety function has - -
deactivated an output group due to an error. TRUE Output is activated
uiOutVoltage UINT Current output voltage in [mV] 0 Operating mode neither
Only available for the operating modes "analogue" nor "sensor"
analogue” and "sensor #0 Operating mode "analogue" or
"sensor"”
uioutCurrent UINT Present output current in [mA] available = 0...final value of the
Not available for the operating types measuring range
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Diagnostic codes (— Messages / diagnostic codes of the function blocks (— p. 180)):

ERR_INVALID_VALUE

ERR_INTERNAL

ERR_UNDEFINED

ERR_SHORT_CIRCUIT
ERR_STUCK_AT
ERR_STUCK_AT_HIGH
ERR_STUCK_AT_LOW
ERR_UNDERVOLTAGE_VBBX

ERR_OVERVOLTAGE_VBBX

DIAG_INVALID_VALUE
DIAG_INTERNAL
DIAG_ACCESS
DIAG_CHANGEOVER_TIME

DIAG_UNDERVOLTAGE_VBBX "

DIAG_OVERVOLTAGE_VBBX

DIAG_STUCK_AT
DIAG_STUCK_AT_HIGH
DIAG_STUCK_AT_LOW
DIAG_SHORT_CIRCUIT
DIAG_NO_CALIB

Error: at least 1 invalid input parameter or invalid combination of input parameters;
Function call has been stopped.

Error: Internal system error
» Contact the ifm Service Center!

Error: Unknown error
» Contact the ifm Service Center!

Error: Short circuit with GND or VBBXx.
Error: Signal is frozen.
Error: Signal frozen, signal state high.

Error: Signal frozen, signal state low.

For inputs: Error: Reference voltage not reached.
For outputs. Error: The voltage of the corresponding output group supply or at
VBB30 / VBB15 is not reached.

= Forinputs: Error: Reference voltage exceeded.
= For outputs. Error: Voltage of the corresponding output groups supply or at VBB30
/ VBB15 not reached.

At least one input parameter is invalid or exceeds the permissible area.
Internal system error.
FB/Function cannot access the required resource; Resource is blocked by another task.

Minimum changeover time for the highside-lowside selection of the drivers has not yet
expired.

For inputs: Error: Reference voltage not reached.
For outputs. Error: The voltage of the corresponding output group supply or at
VBB30 / VBB15 is not reached.

For inputs: Error: Reference voltage exceeded.
For outputs. Error: Voltage of the corresponding output groups supply or at  VBB30
/ VBB15 not reached.

Error: Signal is frozen.

Error: Signal frozen, signal state high.
Error: Signal frozen, signal state low.
Error: Short circuit with GND or VBBXx.

The selected resource has no valid calibration.
The displayed values are maybe faulty.
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10.5.3

Function block

type:

Library:

Symbol in
CODESYS:

Description

SetLED

Function block (FB)

ifmlOcommon.library

23220

—uiChannel
—leColourl
—eColour?
—eFrequency
—x0n

SetLED

XErrorf—
eDiagInfof—
wPreparedf—

The FB is used to configure and control an LED.

Input parameters

23221

23222

Data type Description Possible values
Parameters
uiChannel UINT Output channel of the ED 0..3 | Device LED APP 0...3
eColourl ENUM LED colour status 1 — LED_COLOUR (ENUM) (— p. 114)
eColour2 ENUM LED colour status 0 — LED_COLOUR (ENUM) (— p. 114)
eFrequency ENUM Flashing frequency of the status LED — LED_FLASH_FREQ (ENUM) (— p. 114)
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Output parameters

23223

Data type Description Possible values
Parameter
XEFror BOOL Indication if an error occurred during the FB | FALSE | No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO | Diagnostic information — List below (diagnostic codes:)
xPrepared BOOL State of the FB outputs FALSE | FB outputs still invalid; FB is
still processed
TRUE FB outputs valid; FB has been
processed

Diagnostic codes (— Messages / diagnostic codes of the function blocks (— p. 180)):

STAT_INACTIVE
STAT_BUSY
STAT_DONE

STAT_PREPARING

ERR_INVALID_FREQUENCY
ERR_INVALID_COLOUR
ERR_INVALID_VALUE
ERR_INSTANCE
ERR_ACCESS

ERR_UNDEFINED

ERR_NOT_SUPPORTED

State: FB/Function is inactive.
State: FB/Function is currently executed.

State: FB/Function has been successfully executed and completed. There are valid
results on the outputs.

State: FB/FUN is processed; final results are not yet available. Some output values are
updated in each PLC cycle.

Error: Unsupported frequency.

Error: Unsupported colour.

Error: At least one input parameter is invalid or outside the value range.
Error: Instance is ZERO or invalid.

Error: FB/Funktion cannot access the required resource; Resource is blocked by another
task.

Error: Unknown error
» Contact the ifm Service Center!

Error: Invalid function calls; Function is not supported.

132



ifm Programming Manual ecomatController/60-1 (CR711S) Operating System V2.5.0.n

ifm function libraries

2017-12-19

Library ifmlOcommon.library

10.5.4 SupplySwitch

Function block type:

Library:

Symbol in CODESYS:

Description

Function block (FB)

ifmlOcommon.library

8034

supplySwitch

—uSwitchOff

xErrorf—
eDiagInfof—
wPrepared—

23252

The FB stops all running applications and switches off the voltage supply latching (terminal 30) in

order to shut down the device safely.
The voltage supply latching is only deactivated if the following conditions are met:

e Voltage VBB15 < 5.5 V (undervoltage)

Input parameters

The separation from the VBB30 takes place when all IEC tasks are finished.

23153

Data type |Description Possible values
Parameters
XSWitchOff BOOL Deactivate latching switch of the device FALSE | No action
TRUE Request deactivation of the

latching switch
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Output parameters

23154
Data type [Description Possible values
Parameters
XEFror BOOL Indication if an error occurred during the FB | FALSE | No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO | Diagnostic information — List below (diagnostic codes:)
xPrepared BOOL State of the FB outputs FALSE | FB outputs still invalid; FB is
still processed
TRUE FB outputs valid; FB has been
processed

Diagnostic codes (— Messages / diagnostic codes of the function blocks (— p. 180)):

STAT_DONE

ERR_INTERNAL

ERR_UNDEFINED

DIAG_INVALID_VALUE
DIAG_INTERNAL
DIAG_ACCESS

State: FB/Function has been successfully executed and completed. There are valid

results on the outputs.

Error: Internal system error
» Contact the ifm Service Center!

Error: Unknown error
» Contact the ifm Service Center!

At least one input parameter is invalid or exceeds the permissible area.

Internal system error.

FB/Function cannot access the required resource; Resource is blocked by another task.
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10.5.5 SystemSupply

Function block type:

Library:

Function block (FB)

ifmlOcommon.library

23242

Symbol in CODESYS:

SystemSupply

—eChannel

XErrorf—
eDiagInfof—
wPreparedf—

uidutVoltagef—

Description

The FB indicates the value of the system voltage.

Input parameters

23237

23238

Parameter Data type |Description Possible values
eChannel ENUM System voltage channel — SYS_VOLTAGE_CHANNEL (ENUM)
(— p. 141)

Output parameters

23239

Data type [Description Possible values
Parameters
XError BOOL Indication if an error occurred during the FB | FALSE | No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO | Diagnostic information — List below (diagnostic codes:)
xPrepared BOOL State of the FB outputs FALSE FB outputs still invalid; FB is
still processed
TRUE FB outputs valid; FB has been
processed
uiOutVoltage UINT Current output voltage of the selected permissible = 0...maximum operating
system voltage channel in [mV] voltage
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Diagnostic codes (— Messages / diagnostic codes of the function blocks (— p. 180)):

= STAT_DONE State: FB/Function has been successfully executed and completed. There are valid
results on the outputs.

= STAT_PREPARING State: FB/FUN is processed,; final results are not yet available. Some output values are
updated in each PLC cycle.

= ERR_INVALID_VALUE Error: At least one input parameter is invalid or outside the value range.

= ERR_INTERNAL Error: Internal system error
» Contact the ifm Service Center!

= ERR_UNDEFINED Error: Unknown error
» Contact the ifm Service Center!

= ERR_SHORT_CIRCUIT Error: Short circuit with GND or VBBX.

= ERR_OPEN_CIRCUIT Error: Open circuit detected. Possible cause: Wire break.

= ERR_OVERLOAD_CURRENT  Error: Maximum current exceeded.

= ERR_STUCK_AT Error: Signal is frozen.

= ERR_STUCK_AT_HIGH Error: Signal frozen, signal state high.

= ERR_STUCK_AT_LOW Error: Signal frozen, signal state low.

= ERR_OVERVOLTAGE Error: Maximum signal voltage exceeded.
= ERR_UNDERVOLTAGE Error: Minimum signal voltage not reached.

= ERR UNDERVOLTAGE VvBBX " Forinputs: Error: Reference voltage not reached.
- - = For outputs. Error: The voltage of the corresponding output group supply or at
VBB30 / VBB15 is not reached.

= ERR_OVERVOLTAGE_VBBX = For inputs: Error: Reference voltage exceede_d.
= For outputs. Error: Voltage of the corresponding output groups supply or at VBB30
/ VBB15 not reached.

= ERR_SHORT_CIRCUIT Error: Short circuit with GND or VBBX.

= ERR_OPEN_CIRCUIT Error: Open circuit detected. Possible cause: Wire break.

= DIAG_INVALID_VALUE At least one input parameter is invalid or exceeds the permissible area.
= DIAG_INTERNAL Internal system error.

= DIAG_OPEN_CIRCUIT Open circuit detected. Possible cause: Wire break.

= DIAG_SHORT_CIRCUIT Error: Short circuit with GND or VBBX.

« DIAG UNDERVOLTAGE VvBBX " Forinputs: Error: Reference voltage not reached.
- - = For outputs. Error: The voltage of the corresponding output group supply or at
VBB30 / VBB15 is not reached.

u DIAG OVERVOLTAGE VBBX - For inputs: Error: Reference V0|tage exceede.d.
- - = For outputs. Error: Voltage of the corresponding output groups supply or at  VBB30
/ VBB15 not reached.

= DIAG_OVERLOAD_CURRENT Maximum current exceeded.

= DIAG_STUCK_AT Error: Signal is frozen.

= DIAG_STUCK_AT_HIGH Error: Signal frozen, signal state high.

= DIAG_STUCK_AT_LOW Error: Signal frozen, signal state low.

= DIAG_OVERVOLTAGE Maximum signal voltage exceeded.

= DIAG_UNDERVOLTAGE Error: Minimum signal voltage not reached.

= DIAG_NO_CALIB The selected resource has no valid calibration.

The displayed values are maybe faulty.
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10.5.6 Temperature

Function block type:

Library:
Symbol in CODESYS:

Description

Function block (FB)

ifmlOcommon

library

—uiChannel

Temperature

XErrorf—
eDiagInfof—
¥Prepared—

iTemperatureCF—
iTemperatureF f—

The FB indicates the value of the system temperature.

Input parameters

23245

23247

23246

Parameters

Data type

Description

Possible values

uiChannel

UINT

Input channel

Group + channel
— Data sheet
— Note on wiring (— p. 29)

Examples:
403 Group 4 + channel 3
502 Group 5 + channel 2
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Output parameters

23248

Data type [Description Possible values
Parameter
XEFror BOOL Indication if an error occurred during the FB | FALSE | No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO | Diagnostic information — List below (diagnostic codes:)
xPrepared BOOL State of the FB outputs FALSE | FB outputs still invalid; FB is
still processed
TRUE FB outputs valid; FB has been
processed
iTemperatureC INT Measured temperature in [°C] e.g. 35
iTemperatureF INT Measured temperature in [°F] e.g. 95

Diagnostic codes (— Messages / diagnostic codes of the function blocks (— p. 180)):

STAT_PREPARING

STAT_DONE

ERR_INVALID_VALUE
ERR_INTERNAL

ERR_UNDEFINED

DIAG_INTERNAL
DIAG_INVALID_VALUE

State: FB/FUN is processed,; final results are not yet available. Some output values are
updated in each PLC cycle.

State: FB/Function has been successfully executed and completed. There are valid
results on the outputs.

Error: At least one input parameter is invalid or outside the value range.

Error: Internal system error
» Contact the ifm Service Center!

Error: Unknown error
» Contact the ifm Service Center!

Internal system error.

At least one input parameter is invalid or exceeds the permissible area.
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10.5.7

FILTER_INPUT (ENUM)

The input signal can be changed with a digital low-pass filter.

For the output signal of the function bloc, the delay time is changed to the input signal change by the
filter. This applies both to the switch-on and the switch-off pulse.

23166

Description Possible values Digital signal Analogue signal
Name delay delay
FILTER_INPUT Valid filters for inputs of the FBs UNCHANGED No change of settings
FILTER_O 0.6 ms 1.7ms
(no digital low- (no digital low-
pass filter is set) pass filter is set)
FILTER_1 0.9 ms 3.3ms
FILTER_2 2.1ms 7.0ms
FILTER_3 4.0 ms 14.1 ms
FILTER_4 7.6 ms 28.9ms
FILTER_5 15.2 ms 58.4 ms
FILTER_6 30.8 ms 117.2 ms
FILTER_ 7 61.6 ms 235.2ms
FILTER_8 123.2 ms 470.8 ms
FILTER_9 246.4 ms 942.4 ms
FILTER_10 493.2 ms 1885.6 ms
FILTER_11 986.4 ms 3772.0 ms
FILTER_12 1972.4 ms 7544.4 ms
10.5.8 FILTER_OUTPUT (ENUM)

Filter setting for the current measurement of an output.
The signal of the current measurement is damped via a first-order low-pass filter.

23167

Name

Description

FILTER_OUTPUT

Valid filter for the outputs of the FBs

Possible values

UNCHANGED No change of settings
FILTER_O 1.7ms
FILTER_1 1.8 ms
FILTER_2 2.4ms
FILTER_3 3.9ms
FILTER_4 7.4ms
FILTER_5 14.7 ms
FILTER_6 29.3ms
FILTER_7 58.8 ms
FILTER_8 117.7 ms
FILTER_9 235.6 ms
FILTER_10 471.4 ms
FILTER_11 943.0 ms
FILTER_12 1886.1 ms
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10.5.9 MODE_INPUT (ENUM)

23168

Description Possible values
Name
MODE_INPUT Operating mode of the inputs UNCHANGED Preset mode is maintained
IN_DIGITAL_CSI Input for analogue value

measurement and digital
evaluation without diagnostics;
Csl

IN_DIGITAL_CSI_NAMUR

Input for analogue value
measurement and digital
evaluation with NAMUR-capable
diagnostics; CSI

IN_VOLTAGE_10

Input for analogue current
measurement 0...10 V; CSI

IN_VOLTAGE_32

Input for analogue current
measurement 0...32 V; CSI

IN_VOLTAGE_RATIO

Input for ratiometric current
measurement in relation to
VBB30; CSI

IN_CURRENT_CSI

Input for current measurement
0...20 mA; CSI

IN_RESISTOR

Input for resistance measurement;
CSO

IN_DIGITAL_CSO

Input for analogue value
measurement and digital
evaluation without diagnostics;
CSO

IN_DIGITAL_CSO_DIAG

Input for analogue value
measurement and digital
evaluation with diagnostics similar
to NAMUR; CSO

MONITOR

No parameters or process data
are written. Only the FB output
data is updated.

For use in a PLC application to
which the resource does not
belong.
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10.5.10 MODE_OUTPUT (ENUM)

23169

Description Possible values
Name
MODE_OUTPUT Operating mode of the UNCHANGED Preset mode is maintained
outputs OUT_DIGITAL_CSI Digital output without diagnostics; CSI
OUT_DIGITAL_CSO Digital output without diagnostics;
CSO
OUT_ANALOGUE_10 Analogue output to generate a

selectable voltage 0...10 V without
diagnostics. Generated with the help
of a filtered PWM signal. CSO

OUT_SENSOR_05 Output with fixed output voltage 5 V
for the sensor supply without
diagnostics and without protection.
CsO

OUT_SENSOR_10 Output with fixed output voltage 10 V
for the sensor supply without
diagnostics and without protection.
CSsO

MONITOR No parameters or process data are
written. Only the FB output data is
updated.

For use in a PLC application to which
the resource does not belong.

10.511  SYS_VOLTAGE_CHANNEL (ENUM)

23170

Description Possible values
Name
SYS VOLTAGE CHANNEL | List of all available system voltages. | VBB30 Terminal 30 system voltage
VBB15 Terminal 15 system voltage of the
ignition switch
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10.6 Library ifmOutGroup

Contents

(O 111 0TV (0] o PP PP PR PPPPP 143
FILTER_OUTPUT_GROUP (ENUM) ......oiiiiiiiiiiiiiiee ettt et e e b e s e anbeeeeannnees 146
MODE_OUTPUT_GROUP (ENUM)......uitiiiiiiieeaiiite ettt ettt et e e s sibee e e asibeeesesnbeeesennnes 146

The library contains function blocks (POU) to control extended output functions.
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10.6.1

Function block type:

Library:

Symbol in CODESYS:

OutputGroup

Function block (FB)

23326

ifmlOutGroup.library

OutputGroup
—xResetError XErrorf—
—uiChannel eDiagInfof—
—eMode wPrepared—
—eFilter ¥GEroupstatef—
—pivalue viGroupCurrentf—

Description

uivBBx\Voltagef—
uiGroupVaoltagef—

23327

The FB controls the activation status of an output group and provides diagnostic information about the
group and the connected outputs. Using the FB, an output group including the corresponding outputs
can be switched on or off.

Input parameters

23328

Data type Description Possible values
Parameter
xResetError BOOL Reset request for an occurring error FALSE | When switching from FALSE
TRUE = TRUE: Reset request to the
lower level system
uiChannel UINT Output channel group — Data sheet
— Note on wiring (— p. 29)
eMode MODE_ Operating type of the output channel — MODE_OUTPUT_GROUP (ENUM)
OUTPUT_ group (— p. 146)
GROUP
eFilter FILTER_ Defines the limit frequency of the output | — FILTER_OUTPUT_GROUP (ENUM)
OUTPUT_ filter (— p. 146)
GROUP
xValue BOOL Activation requirement for the output FALSE [ Deactivate output group
group TRUE Activate output group

23337

The error of an output group will only be reset if all corresponding outputs are error-free.
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Output parameters

23329

uiGroupVoltage

Data type [Description Possible values
Parameter
XEFror BOOL Indication if an error occurred during the FB | FALSE | No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO [ Diagnostic information — List below (diagnostic codes:)
xPrepared BOOL State of the FB outputs FALSE | FB outputs still invalid; FB is
still processed
TRUE FB outputs valid; FB has been
processed
xGroupState BOOL Return value activation state of the selected | FALSE [ Output group is deactivated
output group
The state may deviate from the required
outpup state if e.g. a safety function has TRUE Output value is activated
deactivated an output group due to an error.
uiGroupCurrent UINT Measured output current of the entire group | available = 0...final value of the
in [mA] measuring range
uiVBBxVoltage UINT Measured voltage before the group switch in | available = 0...final value of the
[mV] measuring range
UINT Measured voltage after the group switch in | available = 0...final value of the

[mV]

measuring range
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Diagnostic codes (— Messages / diagnostic codes of the function blocks (— p. 180)):

ERR_INVALID_VALUE
ERR_INTERNAL

ERR_UNDEFINED

ERR_STUCK_AT_HIGH
ERR_STUCK_AT_LOW
ERR_UNDERVOLTAGE_VBBX

ERR_OVERVOLTAGE_VBBX

DIAG_INVALID_VALUE

DIAG_INTERNAL
DIAG_ACCESS

DIAG_UNDERVOLTAGE_VBBX "

DIAG_OVERVOLTAGE_VBBX

DIAG_STUCK_AT_HIGH
DIAG_STUCK_AT_LOW
DIAG_NO_CALIB

DIAG_OVERLOAD_CURRENT
ERR_OVERLOAD_CURRENT
DIAG_AT_GROUP_OUTPUT
ERR_AT_GROUP_OUTPUT

Error: At least one input parameter is invalid or outside the value range.
Error: Internal system error

» Contact the ifm Service Center!

Error: Unknown error

» Contact the ifm Service Center!

Error: Signal frozen, signal state high.

Error: Signal frozen, signal state low.

For inputs: Error: Reference voltage not reached.
For outputs. Error: The voltage of the corresponding output group supply or at
VBB30 / VBB15 is not reached.

= For inputs: Error: Reference voltage exceeded.
= For outputs. Error: Voltage of the corresponding output groups supply or at VBB30
/ VBB15 not reached.

At least one input parameter is invalid or exceeds the permissible area.
Internal system error.

FB/Function cannot access the required resource; Resource is blocked by another task.

For inputs: Error: Reference voltage not reached.
For outputs. Error: The voltage of the corresponding output group supply or at
VBB30 / VBB15 is not reached.

For inputs: Error: Reference voltage exceeded.
For outputs. Error: Voltage of the corresponding output groups supply or at  VBB30
/ VBB15 not reached.

Error: Signal frozen, signal state high.
Error: Signal frozen, signal state low.

The selected resource has no valid calibration.
The displayed values are maybe faulty.

Maximum current exceeded.
Error: Maximum current exceeded.
At least one output of the output group is in an error state.

Error: At least one output of the output group is in an error state.
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10.6.2 FILTER_OUTPUT_GROUP (ENUM)

Filter setting for voltage measurement in an output group.
The signal of the voltage measurement is damped via a first-order low-pass filter.

23338

Name

Description

FILTER_OUTPUT_GROUP

Possible values

UNCHANGED No change of settings
FILTER_O 1.7ms
FILTER_1 1.8ms
FILTER_2 2.4 ms
FILTER_3 3.9ms
FILTER_4 7.4 ms
FILTER_5 14.7 ms
FILTER_6 29.3ms
FILTER_7 58.8 ms
FILTER_8 117.7ms
FILTER_9 235.6 ms
FILTER_10 471.4 ms
FILTER_11 943.0 ms
FILTER_12 1886.1 ms

10.6.3 MODE_OUTPUT_GROUP (ENUM)

23270

Name

Description

Possible values

MODE_OUTPUT_GROUP

Operating type of the output
group

UNCHANGED

Setting remains unchanged

OUT _DIGITAL_CSO

Digital output without
diagnostics and without
protection; CSO

MONITOR

No parameters or process data
are written. Only the FB output
data is updated.

For use in a PLC application to
which the resource does not
belong.
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10.7 Library ifmOutHBridge

Contents
[ =T 1T [T PP PP PP P PP PP 148
MODE_BRAKE (ENUM) ... ceitiiiiiieee ittt ettt e e e ettt ee e e e e e s s sbs et e e e e e e e sansbabaeeeaaeeesannsnbaeeeaaeaeas 151

The library contains function blocks (POU) to control extended output functions via an HBridge.
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10.7.1

Function block type:

Library:
Symbol in CODESYS:

Description

HBridge

Function block (FB)

ifmlOutHBridge.library

23469

HBridge

—xResetError

—uiChannel

—uiFrequency

—xDirection

—{eBrakeMode
—{uiBrakeValue
—{tBrakeTime

—uivalue

XErrorf—
eDiagInfof—
xPrepared [—

uiDutCurrent —

23470

The FB configures and controls a pair of output channels in the "HBridge" operating type to control a

motor.

Input parameters

23471

Data type Description Possible values
Parameter
xResetError BOOL Reset request for an occurring error FALSE | When switching from FALSE
TRUE = TRUE: Reset request to the
lower level system
uiChannel UINT 1. Output channel_(channel A) of the Group + channel
output channel pair — Data sheet
— Note on wiring (— p. 29)
Examples:
703 Group 7 + channel 3
1203 Group 12 + channel 3
uiFrequency UINT E*V\/]M frequency of the output signal in — Data sheet
z
xDirection BOOL The direction in which the current flows | FALSE | PWM Current Sourcing (CSO)
via the bridge connections. Determines is on channel A
the direction of rotation of the connected TRUE | PWM Current Sourcing (CSO)
Jrong is on channel B
eBrakeMode MODE_BRAKE B_rake_ mode that_ ap_plies when the — MODE_BRAKE (ENUM) (— p. 151)
direction of rotation is changed or when
stopping
eBrakeValue UINT P_ulse/pause ration of thg PWM output permissible =0...1
signal at the corresponding current
sinking output of the bridge in [%o]
The input is only relevant in the
eBrakeModes that end with
" DYNAMIC" (= dynamic brake).
tBrakeTime TIME Ir_]di(_:ates_ the braking_time for the current | permissible =0...1 h
sinking side of the bridge
The input is only relevant in
eBrakeModes ending with " BTIME".
uivValue UNIT Pulse/pause ration of the PWM output permissible = 0...1

signal in [%o]

148



ifm Programming Manual ecomatController/60-1 (CR711S) Operating System V2.5.0.n

ifm function libraries

2017-12-19
Library ifmOutHBridge

Output parameters

23472

uiOutCurrent

normal operation in [mA]
When braking, uiOutCurrent is = 0 because
no regular current exists in the lowside path.

Data type [Description Possible values
Parameter
XEFror BOOL Indication if an error occurred during the FB | FALSE | No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO [ Diagnostic information — List below (diagnostic codes:)
xPrepared BOOL State of the FB outputs FALSE | FB outputs still invalid; FB is
still processed
TRUE FB outputs valid; FB has been
processed
UINT Measured current at the PWM output during | available = 0...final value of the

measuring range
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Diagnostic codes (— Messages / diagnostic codes of the function blocks (— p. 180)):

STAT_PREPARING

STAT_DONE

ERR_INVALID_VALUE
ERR_INTERNAL

ERR_UNDEFINED

ERR_SHORT_CIRCUIT
ERR_STUCK_AT
ERR_STUCK_AT_HIGH
ERR_STUCK_AT_LOW
ERR_UNDERVOLTAGE_VBBX

ERR_OVERVOLTAGE_VBBX

DIAG_INVALID_VALUE
DIAG_INTERNAL
DIAG_ACCESS
DIAG_CHANGEOVER_TIME

DIAG_UNDERVOLTAGE_VBBX "

DIAG_OVERVOLTAGE_VBBX

DIAG_STUCK_AT
DIAG_STUCK_AT_HIGH
DIAG_STUCK_AT_LOW
DIAG_SHORT_CIRCUIT
DIAG_NO_CALIB

DIAG_CONTROL_DITHER

State: FB/FUN is processed,; final results are not yet available. Some output values are
updated in each PLC cycle.

State: FB/Function has been successfully executed and completed. There are valid
results on the outputs.

Error: At least one input parameter is invalid or outside the value range.
Error: Internal system error

» Contact the ifm Service Center!

Error: Unknown error

» Contact the ifm Service Center!

Error: Short circuit with GND or VBBXx.

Error: Signal is frozen.

Error: Signal frozen, signal state high.

Error: Signal frozen, signal state low.

For inputs: Error: Reference voltage not reached.
For outputs. Error: The voltage of the corresponding output group supply or at
VBB30 / VBB15 is not reached.

= Forinputs: Error: Reference voltage exceeded.
= For outputs. Error: Voltage of the corresponding output groups supply or at VBB30
/ VBB15 not reached.

At least one input parameter is invalid or exceeds the permissible area.
Internal system error.
FB/Function cannot access the required resource; Resource is blocked by another task.

Minimum changeover time for the highside-lowside selection of the drivers has not yet
expired.

For inputs: Error: Reference voltage not reached.
For outputs. Error: The voltage of the corresponding output group supply or at
VBB30 / VBB15 is not reached.

For inputs: Error: Reference voltage exceeded.
For outputs. Error: Voltage of the corresponding output groups supply or at  VBB30
/ VBB15 not reached.

Error: Signal is frozen.

Error: Signal frozen, signal state high.
Error: Signal frozen, signal state low.
Error: Short circuit with GND or VBBXx.

The selected resource has no valid calibration.
The displayed values are maybe faulty.

The requested dither value cannot be set because the calculation from dither and PWM
value is higher than 1000 per mill.
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1072  MODE_BRAKE (ENUM)

23480

Description Possible values
Name

MODE_BRAKE Braking mode that is applied when | UNCHANGED Setting remains unchanged

changing the c_Iirecti(_)n (xDirection) BRAKE_OFF No braking. The voltage direction
or when stopping (uivalue = 0). is changed immediately.

BRAKE_EMCY Emergency brakes:

= In case of change of direction:
Braking only during
tBrakeTime.

* When stopping: Braking
during and after the
tBrakeTime is elapsed.

BRAKE EMCY BTIME Em_ergency bra_kes, but only
- - during tBrakeTime.
BRAKE_DYNAMIC Like BRAKE_EMCY mode, but

dynamic braking with the
uiBrakeValue.

BRAKE_DYNAMIC_BTIME Like BRAKE_EMCY_BTIME
mode, but dynamic braking with
the

uiBrakeValue.
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10.8 Library ifmOutPWM

Contents

(OL U] =1 01 (0] a1 1o PR 153

PWVIMIOO0 ... .. ittt e et e ettt e e et e e e e ea e e e et e e e e atn e e e aaa e e e ta e e eaan e e e annnaeeatanaaeentnaeernnaaenen 156

MODE_CURRENT_CONTROL (ENUM) ....ceiiiiiiiiiiieee ettt a et ee e e e e e s snansaeeeaaeeeas 160

MODE_PWM (ENUM) ...ttt ettt ettt e e e e s ettt e e e e e e s e sbabe e e e e e e e e sannbnbaeeeaaeeesannsnbaeeeaeeeeas 160
23381

The library function blocks (POU) and enumeration types for pulse width modulation and current
control of output channels.
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10.8.1

Function block type:

Library:
Symbol in CODESYS:

Description

CurrentControl

Function block (FB)

ifmIOutPWM.library

23359

CurrentControl

—xResetErrar

—uiChannel
—eMode

—uiFrequency
—uiDitherFrequency
—uiDitherValue

—usikKP
—usikI

—uiDesired Current

XErrorfp—
eDiagInfof—
wPreparedf—

uiCurrent f—
uiPWMratiop—

23356

The FB is used to configure and operate a current controlled output. The current control is supported
by pulse width modulation (PWM). The configuration of PWM frequency and dither is also done with

this FB.

Input parameters

23357

uiDitherFrequency

Data type Description Possible values
Parameters
xResetError BOOL Reset request for an occurring error FALSE | When switching from FALSE
TRUE = TRUE: Reset request to the
lower level system
uiChannel UINT Output channel Group + channel
— Data sheet
— Note on wiring (— p. 29)
Examples:
703 Group 7 + channel 3
1203 Group 12 + channel 3
eMode MODE_ Operating type of the output channel — MODE_CURRENT_CONTROL (ENUM)
CURRENT _ (— p. 160)
CONTROL
uiFrequency UINT E_Y\I]M frequency of the output signal in — Data sheet
z
UNIT Frequency for the dither signal at the permissible = 0...uiFrequency / 2

PWM output in [Hz]

The value at uiDitherFrequency must be
an integer part of the value indicated to
uiFrequency.

Examples:

uiFrequency = 300 Hz

uiDitherFrequency = 50 Hz = 300 /50 = 6
= even factor, valid

uiDitherFrequency = 100 Hz =

300/100 =3

= uneven factor, invalid

Invalid values are corrected to the value
that matches the next lower integer factor.
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uiDitherValue UNIT Peak-to-peak value of the dither signal permissible =0...1
which overlays with the PWM signal, in | If the resulting PWM ratio value is outside
[%o0] the 0...1000 %o range, the dither value will
be temporarily internally reduced to the
minimum/maximum value that is possible,
so that the mean value of the PWM ratio
corresponds with the required value.
usikP USINT Proportional component of the output permissible = 0...255
signal
usiKI USINT Integral component of the output signal |0 ... 255
uiDesiredCurrent UINT Default value at the output channel. 0 ... 65535
When 0 is set, the output is immediately
deactivated.

Output parameters

23358

Parameters Data type [Description Possible values
XError BOOL Indication if an error occurred during the FB | FALSE | No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO | Diagnostic information — List below (diagnostic codes:)
xPrepared BOOL State of the FB outputs FALSE | FB outputs still invalid; FB is
still processed
TRUE FB outputs valid; FB has been
processed
uiCurrent UINT Output current signal in [mA] available = 0...final value of the
measuring range
uiPWMRatio UINT PWM pulse ration calculated by the PI
controller in [%o]
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Diagnostic codes (— Messages / diagnostic codes of the function blocks (— p. 180)):

ERR_INVALID_VALUE
ERR_INTERNAL

ERR_UNDEFINED

ERR_SHORT_CIRCUIT
ERR_STUCK_AT
ERR_STUCK_AT_HIGH
ERR_STUCK_AT_LOW
ERR_UNDERVOLTAGE_VBBX

ERR_OVERVOLTAGE_VBBX

DIAG_INVALID_VALUE
DIAG_INTERNAL
DIAG_ACCESS
DIAG_CHANGEOVER_TIME

DIAG_UNDERVOLTAGE_VBBX "

DIAG_OVERVOLTAGE_VBBX

DIAG_STUCK_AT
DIAG_STUCK_AT_HIGH
DIAG_STUCK_AT_LOW
DIAG_SHORT_CIRCUIT
DIAG_NO_CALIB

DIAG_CONTROL_DITHER

Error: At least one input parameter is invalid or outside the value range.

Error: Internal system error
»  Contact the ifm Service Center!

Error: Unknown error
» Contact the ifm Service Center!

Error: Short circuit with GND or VBBXx.
Error: Signal is frozen.
Error: Signal frozen, signal state high.

Error: Signal frozen, signal state low.

For inputs: Error: Reference voltage not reached.
For outputs. Error: The voltage of the corresponding output group supply or at
VBB30 / VBB15 is not reached.

= Forinputs: Error: Reference voltage exceeded.
= For outputs. Error: Voltage of the corresponding output groups supply or at VBB30
/ VBB15 not reached.

At least one input parameter is invalid or exceeds the permissible area.
Internal system error.
FB/Function cannot access the required resource; Resource is blocked by another task.

Minimum changeover time for the highside-lowside selection of the drivers has not yet
expired.

For inputs: Error: Reference voltage not reached.
For outputs. Error: The voltage of the corresponding output group supply or at
VBB30 / VBB15 is not reached.

For inputs: Error: Reference voltage exceeded.
For outputs. Error: Voltage of the corresponding output groups supply or at VBB30
/ VBB15 not reached.

Error: Signal is frozen.

Error: Signal frozen, signal state high.
Error: Signal frozen, signal state low.
Error: Short circuit with GND or VBBXx.

The selected resource has no valid calibration.
The displayed values are maybe faulty.

The requested dither value cannot be set because the calculation from dither and PWM
value is higher than 1000 per mill.
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10.8.2 PWM1000

23343

Function block type: Function block (FB)

Library: ifmIOutPWM.library

Symbol in CODESYS: PWM1000
—xResetError xErrorf—
—uiChannel eDiagInfof—
—eMode wPrepared—
—uiFrequency uiQutCurrent p—
—uivalue x0utStatef—
—uiDitherFrequency
—uiDithervalue

Description
23344
The FB is used to configure and to operate an output with pulse width modulation.
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Input parameters

23345

Parameters

Data type

Description

Possible values

XResetError

BOOL

Reset request for an occurring error

FALSE | When switching from FALSE

TRUE = TRUE: Reset request to the

lower level system

uiChannel

UINT

Input channel

Group + channel
— Data sheet
— Note on wiring (— p. 29)

Examples:

403 Group 4 + channel 3

502 Group 5 + channel 2

eMode

MODE_PWM

Operating type of the output channel

— MODE_OUTPUT_GROUP (ENUM)
(— p. 146)

uiFrequency

UINT

PWM frequency of the output signal in
[Hz]

— Data sheet

uiValue

UNIT

Pulse/pause ration of the PWM output
signal in [%o]

permissible =0...1

uiDitherFrequency

UNIT

Frequency for the dither signal at the
PWM output in [Hz]

permissible = 0...uiFrequency / 2

The value at uiDitherFrequency must be
an integer part of the value indicated to
uiFrequency.

Examples:

uiFrequency = 300 Hz

uiDitherFrequency = 50 Hz = 300 /50 = 6
= even factor, valid

uiDitherFrequency = 100 Hz =
300/100=3

= uneven factor, invalid

Invalid values are corrected to the value
that matches the next lower integer factor.

uiDitherValue

UNIT

Peak-to-peak value of the dither signal
which overlays with the PWM signal, in
[%o]

permissible = 0...1

If the resulting PWM ratio value is outside
the 0...1000 %o range, the dither value will
be temporarily internally reduced to the
minimum/maximum value that is possible,
so that the mean value of the PWM ratio
corresponds with the required value.
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Output parameters

23346

Data type [Description Possible values
Parameters
XEFror BOOL Indication if an error occurred during the FB | FALSE | No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO [ Diagnostic information — List below (diagnostic codes:)
xPrepared BOOL State of the FB outputs FALSE | FB outputs still invalid; FB is
still processed
TRUE FB outputs valid; FB has been
processed
uiGroupCurrent UINT Measured output current of the entire group | available = 0...final value of the
in [mA] measuring range
xGroupState BOOL Return value activation state of the selected | FALSE Output group is deactivated
output group
The state may deviate from the required
output state if e.g. a safety function has TRUE Output value is activated

deactivated an output group due to an error.
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Diagnostic codes (— Messages / diagnostic codes of the function blocks (— p. 180)):

ERR_INVALID_VALUE
ERR_INTERNAL

ERR_UNDEFINED

ERR_SHORT_CIRCUIT
ERR_STUCK_AT
ERR_STUCK_AT_HIGH
ERR_STUCK_AT_LOW
ERR_UNDERVOLTAGE_VBBX

ERR_OVERVOLTAGE_VBBX

DIAG_INVALID_VALUE
DIAG_INTERNAL
DIAG_ACCESS
DIAG_CHANGEOVER_TIME

DIAG_UNDERVOLTAGE_VBBX "

DIAG_OVERVOLTAGE_VBBX

DIAG_STUCK_AT
DIAG_STUCK_AT_HIGH
DIAG_STUCK_AT_LOW
DIAG_SHORT_CIRCUIT
DIAG_NO_CALIB

DIAG_CONTROL_DITHER

Error: At least one input parameter is invalid or outside the value range.

Error: Internal system error
» Contact the ifm Service Center!

Error: Unknown error
» Contact the ifm Service Center!

Error: Short circuit with GND or VBBXx.
Error: Signal is frozen.
Error: Signal frozen, signal state high.

Error: Signal frozen, signal state low.

For inputs: Error: Reference voltage not reached.
For outputs. Error: The voltage of the corresponding output group supply or at
VBB30 / VBB15 is not reached.

= Forinputs: Error: Reference voltage exceeded.
For outputs. Error: Voltage of the corresponding output groups supply or at  VBB30
/ VBB15 not reached.

At least one input parameter is invalid or exceeds the permissible area.
Internal system error.
FB/Function cannot access the required resource; Resource is blocked by another task.

Minimum changeover time for the highside-lowside selection of the drivers has not yet
expired.

For inputs: Error: Reference voltage not reached.
For outputs. Error: The voltage of the corresponding output group supply or at
VBB30 / VBB15 is not reached.

For inputs: Error: Reference voltage exceeded.
For outputs. Error: Voltage of the corresponding output groups supply or at VBB30
/ VBB15 not reached.

Error: Signal is frozen.

Error: Signal frozen, signal state high.
Error: Signal frozen, signal state low.
Error: Short circuit with GND or VBBX.

The selected resource has no valid calibration.
The displayed values are maybe faulty.

The requested dither value cannot be set because the calculation from dither and PWM
value is higher than 1000 per mill.
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10.8.3 MODE_CURRENT_CONTROL (ENUM)

23361

Description Possible values
Name
MODE_CURRENT_CONTROL Optere;ting mode of the UNCHANGED Setting is maintained
outpu
OUT_CURRENT_CSO Output for current control

without diagnostics and
without protection; CSO

OUT_CURRENT_CSO_DIAG Output for current control
with diagnostics and
without protection; CSO

OUT_CURRENT_CSO_DIAG_PROT | Output for current control
with diagnostics and
protection; CSO

MONITOR No parameters or
process data are written.
Only the FB output data
is updated.

For use ina PLC
application to which the
resource does not

belong.
23348
Description Possible values
Name
MODE PWM Operating mode of the output UNCHANGED Setting is maintained
OUT_PWM_CSI PWM output without diagnostics;
Csl
OUT_PWM_CSO PWM output without diagnostics;
CSsO
OUT_PWM_CSO_DIAG PWM output with diagnostics and

without protection; CSO

OUT_PWM_CSO_DIAG_PROT | PWM output with diagnostics and
with protection; CSO

MONITOR No parameters or process data
are written. Only the FB output
data is updated.

For use in a PLC application to
which the resource does not
belong.
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10.9 Library ifmRawCAN.library

Contents

(07 2 NN T =1 = ] [ SRR 162
CAN _RECOVET ... s 164
CAN_REMOIEREMUEST ...ttt e e et et et e e e s e s e et e e e e e s snnrnenees 166
CAN_REMOIERESPONSE ...ttt ettt e e et e st e e e e e s e s e et e e e e e s snnrrnnees 168
L 0 PP PP PPPR 170
CAN_RXMAESK ...ttt ettt sa e e Rt e e n e e rn e nnreena 172
(00 NN 0T d S E= 100 L= PP PP 174
L I3 PP PP PP PPPR 176
(O I 101 {0 T (LY PP PPR PRSP 178
CAN_BUS_STATE (STRUCT) ..eeitiieiiiteitieesiiee ittt asmee et s s sneessnneesneeesnneesnneesanneesnneeennneenas 178

The library contains POUs and data structures for the programming of the CAN Layer 2 level of the
CAN interfaces of the device under CODESYS.
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10.9.1 CAN_Enable

Function block type:
Behaviour model:

Library:
Symbol in CODESYS:

Description

Function block (FB)

ENABLE

ifmRawCAN.library

—xEnable
—leChannel
—eBaudrate

CAN_Enable

XError
eDiagInfo

The FB activates the CAN Layer 2 functions of a CAN interface with a certain transmission rate.
Simultaneously the FB writes information about the current state of the CAN interface into the global

variable CAN State.
Changes of the transmission rate or of the CAN interface are applied at once. All existing reception

and send buffer storages are deleted.

interface.

Input parameter

The FB does not have any influence on a CANopen Manager / CANopen Device at the
selected CAN interface. In this case the FB cannot change the transmission rate of the CAN

8709

7073

11241

Data type |Description Possible values
Parameter
xEnable BOOL Control activity of the FB FALSE |FB is deactivated
TRUE FB is activated
eChannel CAN_ Identifier of the CAN Interface — CAN_CHANNEL (ENUM) (— p. 113)
CHANNEL
eBaudrate CAN_ Baud rate of the CAN channel — CAN_BAUDRATE (ENUM)
BAUD
RATE
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Output parameter

7135

Data type [Description Possible values
Parameter
XError BOOL Indication if an error occurred during the FB | FALSE No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO | Diagnostic information — List below (diagnostic codes:)

Diagnostic codes:
= STAT_INACTIVE
= STAT_DONE

= ERR_BUS_OFF
= ERR_INTERNAL

= ERR_INVALID_VALUE

= ERR_BAUDRATE_ALREADY_

SET
= ERR_UNDEFINED

State: FB/Function is inactive.

State: FB/Function has been successfully executed and completed. There are valid

results on the outputs.

Error: CAN interface is in the "BUS OFF" state

Error: Internal system error
» Contact the ifm Service Center!

Error: at least 1 invalid input parameter or invalid combination of input parameters;

Function call has been stopped.

Error: Requested baud rate cannot be set because another baud rate has already been

defined.

Error: Unknown error
» Contact the ifm Service Center!
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10.9.2 CAN_Recover

11765

Function block type: Function block (FB)

Behaviour model: EXECUTE

ifmRawCAN.library

Library:

Symbol in CODESYS: CAN_Recover
—xExecute ¥Done f—
—eChannel xError f—
—usiNumberRetry eDiaginfof—
—tInhibitTime usiRetryCountf—

Description

11771
The FB controls the processing of a failure of the CAN channel.
The call of the FB triggers the following actions:
e If the CAN channel fails the CAN interface is reset and rebooted.
e All buffer storages are emptied.

If the CAN channel keeps failing after the maximum number of recovery attempts has been
exceeded, the CAN bus remains in the error state.

» Call FB again to repeat the execution of the recovery function.

Input parameter

11768

Data type |Description Possible values
Parameter
xExecute BOOL Control execution of the FB FALSE [ FB is executed once
= TRUE
Other No impact on FB processing
eChannel CAN_ Identifier of the CAN Interface — CAN_CHANNEL (ENUM) (— p. 113)
CHANNEL
usiNumberRetry USINT Max. number of retries E.g. 4
tinhibitTime TIME Time until the CAN interface is star_ted again | E.g. #2ms
after the detection of a CAN bus failure
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Output parameter

11769

Data type | Description Possible values
Parameter
xDone BOOL Indication of whether execution of the FB FALSE FB is executed
has been successfully completed
TRUE = FB successfully executed
= FB can be called again
XError BOOL Indication if an error occurred during the FB | FALSE No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO [ Diagnostic information — List below (diagnostic codes:)
usiRetryCount USINT Counter for retries carried out since the last
activation of the FB

Diagnostic codes:
= STAT_INACTIVE
= STAT_DONE

= ERR_INACTIVE_INTERFACE

= ERR_INTERNAL

= ERR_INVALID_VALUE

= ERR_UNDEFINED

State: FB/Function is inactive.

State: FB/Function has been successfully executed and completed. There are valid

results on the outputs.
Error: Selected CAN channel is deactivated.

Error: Internal system error
»  Contact the ifm Service Center!

Error: at least 1 invalid input parameter or invalid combination of input parameters;

Function call has been stopped.

Error: Unknown error
» Contact the ifm Service Center!
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10.9.3 CAN_RemoteRequest

Function block type:
Behaviour model:

Library:
Symbol in CODESYS:

Description

Function block (FB)
EXECUTE

ifmRawCAN.library

10884

CAN_RemoteRequest
—xExecute ¥Donef—
—leChannel xErrar f—
—udiID eDiaginfof—
—wExtended aDatap—
—usiSetDLC usiDLC—

10886

The FB sends the request for a CAN Remote message into a CAN network. The FB provides the data
of the response message in an array. The FB supports standard and extended frames.

Input parameter

10888

Data type |Description Possible values
Parameter
xExecute BOOL Control execution of the FB FALSE |FB is executed once
= TRUE
Other No impact on FB processing
eChannel CAN_ Identifier of the CAN Interface — CAN_CHANNEL (ENUM) (— p. 113)
CHANNEL
udilD UDINT Identifier of the CAN message «  for Standard Frame (11 bits
identifier):
0...2047
= for Extended-Frame (29 bits
identifier):
0...536.870.911
xExtended BOOL Requested frame type: FALSE | Standard Frame*
- Standard Frame (11 bits identifier) TRUE E =
- Extended-Frame (29 bits identifier) v xtended Frame
usiDLC UINT Number of the data bytes in the CAN 0 0 bytes*
message (DLC = Data Length Count)
7 7 bytes

* ... preset value
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Output parameter

10890

Data type [Description Possible values
Parameter
xDone BOOL Indication of whether execution of the FB FALSE FB is executed
has been successfully completed
TRUE = FB successfully executed
= FB can be called again
XEFror BOOL Indication if an error occurred during the FB | FALSE | No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO [ Diagnostic information — List below (diagnostic codes:)
aData ARRAY Array for storage of the data received
[0..7] OF
USINT

Diagnostic data:
= STAT_INACTIVE
= STAT_DONE

= STAT_BUSY

= ERR_BUFFER_OVERFLOW

= ERR_INVALID_VALUE

= ERR_INTERNAL

= ERR_UNDEFINED

= ERR_INACTIVE_INTERFACE

State: FB/Function is inactive.

State: FB/Function has been successfully executed and completed. There are valid
results on the outputs.

State: FB/Function is currently executed.

Error: Transmission buffer full; CAN message cannot write to buffer storage and is not
transmitted

Error: at least 1 invalid input parameter or invalid combination of input parameters;
Function call has been stopped.

Error: Internal system error
» Contact the ifm Service Center!

Error: Unknown error
» Contact the ifm Service Center!

Error: Selected CAN channel is deactivated.
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10.9.4 CAN_RemoteResponse

Function block type:
Behaviour model:

Library:
Symbol in CODESYS:

Description

Function block (FB)

ENABLE

ifmRawCAN.library

CAN_RemoteResponse

—xEnable
—leChannel

—udilD

—wExtended

—alata

—usiDLC

XErrorf—
eDiagInfof—
UiRTR_Cntf—

19902

15962

The FB replies as reaction to the request of a CAN Remote message and sends the data required into

a CAN network.

As long as the FB is activated it responds to each remote request message (automatic reply).
Several FB calls are possible during one PLC cycle.

Input parameter

9237

Data type |Description Possible values
Parameter
XxEnable BOOL Control activity of the FB FALSE |FB is deactivated
TRUE FB is activated
eChannel CAN_ Identifier of the CAN Interface — CAN_CHANNEL (ENUM) (— p. 113)
CHANNEL
udilD UDINT Identifier of the CAN message «  for Standard Frame (11 bits
identifier):
0...2047
= for Extended-Frame (29 bits
identifier):
0...536.870.911
xExtended BOOL Requested frame type: FALSE [ Standard Frame*
- Standard Frame (11 bits identifier) TRUE
- Extended-Frame (29 bits identifier) v Extended Frame
usiDLC UINT Number of the data bytes in the CAN 0 0 bytes*
message (DLC = Data Length Count)
7 7 bytes

* ... preset value
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Output parameter

11740

Data type [Description Possible values
Parameter
XEFror BOOL Indication if an error occurred during the FB | FALSE | No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO [ Diagnostic information — List below (diagnostic codes:)
UIRTR Cnt UINT Number of received remote requests after
- the last FB call

Diagnostic code:
= STAT_INACTIVE
= STAT_DONE

= ERR_INACTIVE_INTERFACE

= ERR_BUFFER_OVERFLOW

= ERR_INVALID_VALUE

= ERR_INTERNAL

= ERR_UNDEFINED

State: FB/Function is inactive.

State: FB/Function has been successfully executed and completed. There are valid

results on the outputs.

Error: Selected CAN channel is deactivated.

Error: Transmission buffer full; CAN message cannot write to buffer storage and is not

transmitted

Error: at least 1 invalid input parameter or invalid combination of input parameters;

Function call has been stopped.

Error: Internal system error
»  Contact the ifm Service Center!

Error: Unknown error
» Contact the ifm Service Center!
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10.9.5 CAN_Rx

6939

Function block type: Function block (FB)

Behaviour model: ENABLE

Library: ifmRawCAN .library

Symbol in CODESYS: CAN_Rx
—xEnable XError —
—leChannel eDiagInfof—
—wExtended aDatap—
—udiID usiDLCH—

uiAvailablef—
Description

11777
The FB receives CAN messages with a defined identifier.

The FB receives all CAN messages with the indicated identifier between 2 FB calls and stores them in
a FIFO buffer storage. The number of the received CAN messages is displayed. The CAN message
received first is always provided on the output.

Input parameter
11784

Data type | Description Possible values
Parameter
xEnable BOOL Control activity of the FB FALSE |FB is deactivated
TRUE FB is activated
eChannel CAN_ Identifier of the CAN Interface — CAN_CHANNEL (ENUM) (— p. 113)
CHANNEL
xExtended BOOL Requested frame type: FALSE | Standard Frame*
- Standard Frame (11 bits identifier) TRUE E =
- Extended-Frame (29 bits identifier) v xtended Frame
udilD UDINT Identifier of the CAN message «  for Standard Frame (11 bits
identifier):
0...2047
= for Extended-Frame (29 bits
identifier):
0...536.870.911
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Output parameter

14640

Data type | Description Possible values
Parameter
XEFror BOOL Indication if an error occurred during the FB | FALSE | No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO [ Diagnostic information — List below (diagnostic codes:)
aData ARRAY Array for storage of the data received
[0...7] OF
USINT
usiDLC UINT Number of the data bytes in the CAN 0 0 bytes*
message (DLC = Data Length Count)
7 7 bytes
uiAvailable UINT *  Number of received CAN messages 0 No CAN messages received
since the last FB call between 2 FB calls
= Current CAN message is taken into n n CAN messages received
account

Error codes:
= STAT_INACTIVE
* STAT_DONE

= ERR_INACTIVE_INTERFACE
= ERR_BUFFER_OVERFLOW

= ERR_INVALID_VALUE

= ERR_INTERNAL

= ERR_UNDEFINED

State: FB/Function is inactive.

State: FB/Function has been successfully executed and completed. There are valid

results on the outputs.

Error: Selected CAN channel is deactivated.

Error: Transmission buffer full; CAN message cannot write to buffer storage and is not

transmitted

Error: at least 1 invalid input parameter or invalid combination of input parameters;

Function call has been stopped.

Error: Internal system error
» Contact the ifm Service Center!

Error: Unknown error
» Contact the ifm Service Center!
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10.9.6 CAN_RxMask

14643

Function block type: Function block (FB)

Behaviour model: ENABLE

Library: ifmRawCAN.library

Symbol in CODESYS: CAN_RxMask
—xEnable XError —
—eChannel eDiagInfof—
—{xExtended aDataj—
—udilDset usiDLCF—
—udilDmask uiAvailablef—

udilDp—
Description

14641

The FB receives CAN messages of a non-coherent area. The area is defined by a bit pattern and a bit
mask.

The following rules apply to the bit mask:
= 0: The equivalent bit of the CAN identifier can be 0 or 1

= 1: The equivalent bit of the CAN identifier must have the same value as the bit in the bit
pattern

Example:

Pattern: 000 0010 0000
Mask: ee0 1111 1111

Result: xxx 0010 0000

All CAN messages with an identifier whose 8 least significant bits have the value "0010 0000" are
received.

E.g. 110 0010 0000 000 0010 0000, 001 0010 0000

General behaviour of the FB: — CAN_Rx (— p. 170)

Input parameter

14638

Data type |Description Possible values
Parameter
xEnable BOOL Control activity of the FB FALSE FB is deactivated
TRUE FB is activated
eChannel CAN_ Identifier of the CAN Interface — CAN_CHANNEL (ENUM) (— p. 113)
CHANNEL
xExtended BOOL Requested frame type: FALSE Standard Frame*
- Standard Frame (11 bits identifier) TRUE E =
- Extended-Frame (29 bits identifier) xtended Frame
udilDSet UDINT Preset bit pattern for the masking of the E.g. 000 0010 0000
identifier of the CAN message
udilDMask UDINT Bit pattern of the required area E.g. 000 1111 1111
1 ... bit relevant for selection
0 ... bit not relevant for selection

* ... preset value
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Output parameter

11736

Data type | Description Possible values
Parameter
XError BOOL Indication if an error occurred during the FB | FALSE No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO | Diagnostic information — List below (diagnostic codes:)
aData ARRAY Array for storage of the data received
[0...7] OF
USINT
usiDLC UINT Number of the data bytes in the CAN 0 0 bytes*
message (DLC = Data Length Count)
7 7 bytes
uiAvailable UINT = Number of received CAN messages 0 No CAN messages received
since the last FB call between 2 FB calls
= Current CAN message is taken into n n CAN messages received
account
udilD UDINT Identifier of the CAN message * for Standard Frame (11 bits
identifier):
0...2047
= for Extended-Frame (29 bits
identifier):
0...536.870.911

Diagnostic codes:
= STAT_INACTIVE
= STAT_DONE

= ERR_INACTIVE_INTERFACE
= ERR_BUFFER_OVERFLOW

= ERR_INVALID_VALUE

= ERR_INTERNAL

= ERR_UNDEFINED

State: FB/Function is inactive.

State: FB/Function has been successfully executed and completed. There are valid

results on the outputs.

Error: Selected CAN channel is deactivated.

Error: Transmission buffer full; CAN message cannot write to buffer storage and is not

transmitted

Error: at least 1 invalid input parameter or invalid combination of input parameters;

Function call has been stopped.

Error: Internal system error
» Contact the ifm Service Center!

Error: Unknown error
» Contact the ifm Service Center!
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10.9.7 CAN_RxRange

11731

Function block type: Function block (FB)

Behaviour model: ENABLE

Library: ifmRawCAN.library

Symbol in CODESYS: CAN_RxRange
—xEnable XError —
—eChannel eDiagInfof—
—{xExtended aDataj—
—udilDstart usiDLCF—
—udilDstop uiAvailablef—

udilDp—
Description

11732
The FB receives CAN messages of a coherent area. The area is defined by an upper and lower limit.
The following rules apply to the definition of this area:

= Lower and upper limit:
Standard Frames: 0 ... 2047 (11-bit identifier)
Extended Frames: O ... 536 870 911 (29-bit identifier)

= The value for the lower limit must be <= the value of the upper limit.
Example:
Lower limit: 000 0000 0010
Upper limit: 000 0000 1000

Result: All CAN messages with an identifier whose 4 least significant bits have a value between
"0010" and "1000" are received.

General behaviour of the FB: — CAN_Rx (— p. 170)

Input parameter

14639

Data type | Description Possible values
Parameter
xEnable BOOL Control activity of the FB FALSE FB is deactivated
TRUE FB is activated
eChannel CAN_ Identifier of the CAN Interface — CAN_CHANNEL (ENUM) (— p. 113)
CHANNEL
xExtended BOOL Requested frame type: FALSE Standard Frame*
- Standard Frame (11 bits identifier)
- Extended-Frame (29 bits identifier) TRUE Extended Frame
udilDStart UDINT Start of the required area E.g. 000 0000 0010
udilDStop UDINT End of the required area E.g. 000 0000 1000

* ... preset value
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Output parameter

14642

Data type | Description Possible values
Parameter
XError BOOL Indication if an error occurred during the FB | FALSE No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO | Diagnostic information — List below (diagnostic codes:)
aData ARRAY Array for storage of the data received
[0...7] OF
USINT
usiDLC UINT Number of the data bytes in the CAN 0 0 bytes*
message (DLC = Data Length Count)
7 7 bytes
uiAvailable UINT = Number of received CAN messages 0 No CAN messages received
since the last FB call between 2 FB calls
= Current CAN message is taken into n n CAN messages received
account
udilD UDINT Identifier of the CAN message * for Standard Frame (11 bits
identifier):
0...2047
= for Extended-Frame (29 bits
identifier):
0...536.870.911

Diagnostic codes:
= STAT_INACTIVE
= STAT_DONE

= ERR_INACTIVE_INTERFACE
= ERR_BUFFER_OVERFLOW

= ERR_INVALID_VALUE

= ERR_INTERNAL

= ERR_UNDEFINED

State: FB/Function is inactive.

State: FB/Function has been successfully executed and completed. There are valid

results on the outputs.

Error: Selected CAN channel is deactivated.

Error: Transmission buffer full; CAN message cannot write to buffer storage and is not

transmitted

Error: at least 1 invalid input parameter or invalid combination of input parameters;

Function call has been stopped.

Error: Internal system error
» Contact the ifm Service Center!

Error: Unknown error
» Contact the ifm Service Center!
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10.9.8 CAN_Tx

Function block type:
Behaviour model:

Library:
Symbol in CODESYS:

Description

Function block (FB)

ENABLE

ifmRawCAN.library

2269

CAN_Tx

—xEnable
—leChannel

—udilD

—wExtended
—usiDLC

—alata

XErrorp—
eDiagInfof—

7401

By means of this FB CAN messages can be sent asynchronously. The FB writes the configured CAN
message into the buffer storage of the selected CAN channel. When the CAN message is transmitted
depends on the state of the CAN channel and the buffer storage. The FB and the PLC cycle do not

have any influence on this.

The FB can be called several times during a PLC cycle.
The repeated call of the FB during a PLC cycle triggers a repeated transmission of the CAN

message within the PLC cycle.

Input parameters

14057

Data type |Description Possible values
Parameters
xEnable BOOL Control activity of the FB FALSE |FB is deactivated
TRUE FB is activated
eChannel CAN_ Identifier of the CAN Interface — CAN_CHANNEL (ENUM) (— p. 113)
CHANNEL
udilD UDINT Identifier of the CAN message «  for Standard Frame (11 bits
identifier):
0...2047
= for Extended-Frame (29 bits
identifier):
0...536.870.911
xExtended BOOL Requested frame type: FALSE | Standard Frame*
- Standard Frame (11 bits identifier) TRUE E =
- Extended-Frame (29 bits identifier) v xtended Frame
usiDLC UINT Number of the data bytes in the CAN 0 0 bytes*
message (DLC = Data Length Count)
7 7 bytes
aData ARRAY Array with the data to be sent
[0...7] OF
USINT

* ... preset value
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Output parameter

13821

Data type [Description Possible values
Parameter
XEFror BOOL Indication if an error occurred during the FB | FALSE | No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO [ Diagnostic information — List below (diagnostic codes:)

Diagnostic codes:
= STAT_INACTIVE
= STAT_DONE

= ERR_INACTIVE_INTERFACE

= ERR_BUFFER_OVERFLOW

= ERR_INVALID_VALUE

= ERR_INTERNAL

= ERR_UNDEFINED

State: FB/Function is inactive.

State: FB/Function has been successfully executed and completed. There are valid

results on the outputs.

Error: Selected CAN channel is deactivated.

Error: Transmission buffer full; CAN message cannot write to buffer storage and is not

transmitted

Error: at least 1 invalid input parameter or invalid combination of input parameters;

Function call has been stopped.

Error: Internal system error
» Contact the ifm Service Center!

Error: Unknown error
» Contact the ifm Service Center!
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1099  CAN Info (GVL)

12281

Description Data type Possible values
Name
eBusState Status of the CAN interface to CiA 11898 — CAN_BUS_STATE Undefined
(STRUCT) (— p. 178)
uiBaudRate Current baud rate UINT 0*...65535
udiRxCount Counter for all messages detected at the UINT 0*...65535
CAN interface
UIErrorCntRx Error counter Rx (receive) UINT 0*...65535
UIErrorCntTx Error counter Tx (send) UINT 0*...65535
xWarningRx Warning signal for error counter Rx BOOL FALSE* | uiErrorCntRx < 96
TRUE | uiErrorcntRx > 96
xWarningTx Warning signal for error counter Tx BOOL FALSE* | uiErrorCntRx < 96
TRUE | uiErrorcntRx > 96

* = preset value

10910  CAN_BUS_STATE (STRUCT)

18497
Description Possible values Data type | Value
Name
CAN BUS STATE State of the CAN UNDEFINED Interface not available or not | INT 0
- - interface configured
ERROR_ACTIVE Error counter Tx/Rx <= 127 INT
ERROR_PASSIVE Error counter Tx/Rx > 127 INT
and
Error counter Tx > 255
BUS_OFF Error counter Tx > 255 INT 65535
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11 Troubleshooting

Contents

L o) Q0] =TT =
Error messages
Messages / diagnostic codes of the function blocks

11.1 Error classes

23276

An error is classified according to its possible impact. The error class determines how the system
reacts when a specific error occurs.

Error class Description Reaction

. The controller deactivates components
The overall integrity of the controller is no longer allocated to the PLC.
guaranteed. Errors in the central components of the

A Fatal Error controller that affect the behaviour of other The controller deactivates the concerned PLC.
components. e The controller saves the information in the error
log.
. The controller deactivates components
allocated to the PLC.
B Serious error One or several PLCs can no longer be executed. e The controller deactivates the concerned PLC.
e The controller saves the information in the error
log.
e  The controller puts the affected function into a
defined state.
Error in a controller component; The function of one or The controller reports the error to the
C Component errors several components of the controller is no longer anolication P
guaranteed. PP )
e The controller saves the information in the error
log.
e The controller puts the affected function into a
defined state.
e The controller reports the error to the
i i : i application.
D Periphery errors Errors on or in the periphery; a function can no longer pp . o
be executed. e The controller saves the information in the error

log.

e The error can be reset in the application (as
often as required).
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11.2 Error messages

23459
(Most) FBs provide, among others, the following signals at their outputs.
» Evaluate these signals in the application!

Data type [Description Possible values
Parameters
XEFror BOOL Indication if an error occurred during the FB | FALSE | No error occurred or the FB is
execution still being executed
TRUE = Error occurred
= Action could not be
executed
= Note diagnostic
information
eDiaginfo DIAG_INFO [ Diagnostic information — List below (diagnostic codes:)

l i Lists of diagnostic codes are part of the function block descriptions — {ifm function libraries
(— p. 102)

11.3 Messages / diagnostic codes of the function blocks

23460
Status/diagnostic/error messages of the function blocs are defined in the global Enum DIAG_INFO.
They have one of the following prefixes depending on the type of message:

Prefix Type of message Description

STAT Status message Status messages contain information about the condition of the function
block during the normal procedure.

DIAG Diagnostic message Diagnostic messages contain information about a failure event. They reset

themselves after the failure event has disappeared and can optionally be
evaluated by the application.

ERR Error message Error messages contain information about a failure event. They must be
reset in the application after the failure event has disappeared.

Examples for messages / diagnostic codes:
= STAT_INACTIVE

= DIAG_OPEN_CIRCUIT

= ERR_OVERVOLTAGE

l i Lists of diagnostic codes are part of the function block descriptions — {ifm function libraries
(— p. 102)
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Directory structure and file overview

12 Appendix

Contents

Directory structure and file overview
ifm behaviour models for function blocks

12.1 Directory structure and file overview

The following directories and files are stored in the device:

Data name / path
apps

= standard.app
= safe.app

0s

= ifmOS.ifm

boot

= boot.ifm
sis
= sissys.ifm

cfg
= comconf.cfg

= memconf.ifm

retain

= standard.ret
= standard.mb
= safe.ret

= safe.mb
data

T

compat

= compat.ifm

cmd

= cmd.ifm
info

= devinfo.txt

= swinfo.txt

Description
Folder

Application non-safe

Application safe
Folder

ifmOS
Folder

Bootloader
Folder

SIS-SYS
Folder

Communication configuration

Memory configuration
Folder

Application retain non-safe

Application memory bytes non-safe

Application retain safe

Application memory bytes non-safe

folder

Memory space for user-defined data

Folder

Compatibility File
Folder

Command File
Folder

Device information

Software information

23443
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12.2 ifm behaviour models for function blocks

Contents

(1T 01T = 182
Behaviour MOAEI ENABLE .......... ettt et e et e et e e e eat e e e eaae e e s et esesatnseessaneesees 182
Behaviour MOAEl EXECUTE .......oiiieiiiiiieeeee ettt e e et e e e e e e s et e s e eat s e e saae e e s et e seeatnsesnanssesees 183

This chapter describes the ifm behaviour models for function blocks.

12.21 General

23801
ifm function blocks feature the following outputs to return status and error information:

Description

Output

XError TRUE An error has occurred.
FALSE No error has occurred.

eDiaginfo (Diagn(:)l-sstg:)/error information — Messages / diagnostic codes of the function blocks
— p. 180

All inputs and outputs in the function block that belong to the ifm behaviour model are featured at the
top.

12.2.2 Behaviour model ENABLE

23705
Function blocks that use the behaviour model ENABLE are cyclically processed as long as the status
at the input is xEnable = TRUE.
If xEnable = FALSE, the function block will not be executed. All function block outputs are reset to their
preset default values and will not be updated. In this case the following applies: xError = FALSE and
eDiaglinfo = STAT_INACTIVE.
Function blocks that have no xEnable input are processed cyclically when the application is started.
The processing is only terminated when the application is stopped. The behaviour corresponds with
the behaviour of a function block with a permanent TRUE at the xEnable input.

Response to errors

23815

In case of an error, XError is set to TRUE and eDiaglnfo indicates the diagnostic code as long as
xEnable is = TRUE.

Irrespective of the data type, all other outputs of the function block will be reset to the following values:

Data type value
numerical 0/0.0
String Empty string
BOOL/Bit FALSE
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12.2.3 Behaviour model EXECUTE

23800

Function blocks that have the EXECUTE behaviour model are processed once after a rising edge at
the xExecute input.

If the function block has executed its function successfully, the output is set xDone = TRUE.

Response to errors
23827

In case of an error, XError is set to TRUE and eDiaglnfo indicates the error status as long as XxExecute
is = TRUE.

The output xDone is set to FALSE since the execution could not be finished successfully.
Irrespective of the data type, all other outputs of the function block will be reset to the following values:

Data type value
numerical 0/0.0
String Empty string
BOOL/Bit FALSE
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13 Glossary of Terms
A

Address

This is the "name" of the bus participant. All participants need a unique address so that the signals can
be exchanged without problem.

Application

Software that is programmed by the manufacturer into the machine specifically for the application. The
software usually contains logic sequences, limit values and expressions to control the corresponding
inputs and outputs, calculations and decisions.

Architecture
Specific configuration of hardware and/or software elements in a system.

B

Baud

Baud, abbrev.: Bd = unit for the data transmission speed. Do not confuse baud with "bits per second"
(bps, bits/s). Baud indicates the number of changes of state (steps, cycles) per second over a
transmission length. But it is not defined how many bits per step are transmitted. The name baud can
be traced back to the French inventor J. M. Baudot whose code was used for telex machines.

1 MBd = 1024 x 1024 Bd = 1 048 576 Bd

Bootloader

The bootloader is a start program with which the operating system and the application can be reloaded
on the device.

Bus
Serial data transmission of several participants on the same cable.

C

CAN

CAN = Controller Area Network
CAN is a priority-controlled fieldbus system for large data volumes. There are several higher-level
protocols that are based on CAN, e.g. 'CANopen' or 'J1939'.

CAN stack
CAN stack = software component that deals with processing CAN messages.

CiA

CiA = CAN in Automation e.V.

User and manufacturer organisation in Germany / Erlangen. Definition and control body for CAN and
CAN-based network protocols.

Homepage — www.can-cia.org
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CiA DS 304

DS = Draft Standard
CANopen device profile for safety communication

CiA DS 401

DS = Draft Standard
CANopen device profile for binary and analogue I/O modules

CiA DS 402

DS = Draft Standard
CANopen device profile for drives

CiA DS 403

DS = Draft Standard
CANopen device profile for HMI

CiA DS 404

DS = Draft Standard
CANopen device profile for measurement and control technology

CiA DS 405

DS = Draft Standard
CANopen specification of the interface to programmable controllers (IEC 61131-3)

CiA DS 406

DS = Draft Standard
CANopen device profile for encoders

CiA DS 407

DS = Draft Standard
CANopen application profile for local public transport

Clamp 15
In vehicles clamp 15 is the plus cable switched by the ignition lock.

COBID

COB = Communication Object

ID = Identifier

ID of a CANopen communication object

Corresponds to the identifier of the CAN message with which the communication project is sent via the
CAN bus.
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CODESYS

CODESYSP is a registered trademark of 3S — Smart Software Solutions GmbH, Germany.

'CODESYS for Automation Alliance' associates companies of the automation industry whose hardware
devices are all programmed with the widely used IEC 61131-3 development tool CODESYS®.
Homepage — www.codesys.com

CSl
CSI = Current Sinking
1) *)
S
In Current Sinking Input ©) | current Sinking Output
In = connection of binary input n on Qn = connection of output n
(S) = sensor |—-|- (L) = load
Q]
Q]
Binary input bIo_c_k diagram, p_lus-swnchlng Output block diagram, minus-switching (B.)
for positive sensor signal for negative output signal
Input = open = Signal = Low (GND) Low-Side Output (B)
— Low-Side Input (B,) -
CSO
CSO = Current Sourcing
®) *)
Current Sourcing Input |J Current Sourcing Output
In In = connection of binary input n an Qn = connection of output n

©) (S) = Sensor (L) | (L)=load
)_ %) 0

Binary input block diagram, minus-switching
for negative sensor signal:
Input = open = Signal = High (Supply)
— High-Side Input (By)

Output block diagram, plus-switching
for positive output signal
High-Side Output (By)

CSV file

CSV = Comma Separated Values (also: Character Separated Values)
A CSV file is a text file for storing or exchanging simply structured data.
The file extension is .csv.

Example: Source table with numerical values:

value 1.0 value 1.1 value 1.2 value 1.3
value 2.0 value 2.1 value 2.2 value 2.3
value 3.0 value 3.1 value 3.2 value 3.3

This results in the following CSV file:

value 1.0;value 1.1;value 1.2;value 1.3
value 2.0;value 2.1;value 2.2;value 2.3
value 3.0;value 3.1;value 3.2;value 3.3

Cycle time
This is the time for a cycle. The PLC program performs one complete run.
Depending on event-controlled branchings in the program this can take longer or shorter.
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D

Depending on the data type, values of different sizes can be stored.

Data type
Data type min. value
BOOL FALSE
BYTE 0
WORD 0
DWORD 0
SINT -128
USINT 0
INT -32 768
UINT 0
DINT -2 147 483 648
UDINT 0
REAL -3.402823466 « 103
ULINT 0
STRING
DC

Direct Current

Diagnosis

max. value
TRUE
255
65535
4 294 967 295
127
255
32767
65535
2 147 483 647
4294 967 295
3.402823466 - 103
18 446 744 073 709 551 615

size in the memory
8 bits = 1 byte
8 bits = 1 byte
16 bits = 2 bytes
32 bits = 4 bytes
8 bits = 1 byte
8 bits = 1 byte
16 bits = 2 bytes
16 bits = 2 bytes
32 bits = 4 bytes
32 bits = 4 bytes
32 bits = 4 bytes
64 Bit = 8 Bytes

number of char. + 1

During the diagnosis, the "state of health" of the device is checked. It is to be found out if and what

—faults are given in the device.

Depending on the device, the inputs and outputs can also be monitored for their correct function.

- wire break,
- short circuit,
- value outside range.

For diagnosis, configuration and log data can be used, created during the "normal” operation of the

device.

The correct start of the system components is monitored during the initialisation and start phase.

Errors are recorded in the log file.

For further diagnosis, self-tests can also be carried out.

Dither

Dither is a component of the —PWM signals to control hydraulic valves. It has shown for
electromagnetic drives of hydraulic valves that it is much easier for controlling the valves if the control
signal (PWM pulse) is superimposed by a certain frequency of the PWM frequency. This dither
frequency must be an integer part of the PWM frequency.

DLC

Data Length Code = in CANopen the number of the data bytes in a message.

For -SDO: DLC =8
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DRAM

DRAM = Dynamic Random Access Memory.

Technology for an electronic memory module with random access (Random Access Memory, RAM).
The memory element is a capacitor which is either charged or discharged. It becomes accessible via a
switching transistor and is either read or overwritten with new contents. The memory contents are
volatile: the stored information is lost in case of lacking operating voltage or too late restart.

DTC

DTC = Diagnostic Trouble Code = error code
In the protocol J1939 faults and errors well be managed and reported via assigned numbers — the
DTCs.

E

ECU

(1) Electronic Control Unit = control unit or microcontroller
(2) Engine Control Unit = control device of a engine

EDS-file

EDS = Electronic Data Sheet, e.g. for:

* File for the object directory in the CANopen master,

* CANopen device descriptions.
Via EDS devices and programs can exchange their specifications and consider them in a simplified
way.

Embedded software

System software, basic program in the device, virtually the —runtime system.

The firmware establishes the connection between the hardware of the device and the application
program. The firmware is provided by the manufacturer of the controller as a part of the system and
cannot be changed by the user.

EMC

EMC = Electro Magnetic Compatibility.

According to the EC directive (2004/108/EEC) concerning electromagnetic compatibility (in short EMC
directive) requirements are made for electrical and electronic apparatus, equipment, systems or
components to operate satisfactorily in the existing electromagnetic environment. The devices must
not interfere with their environment and must not be adversely influenced by external electromagnetic
interference.

EMCY

Abbreviation for emergency
Message in the CANopen protocol with which errors are signalled.

Ethernet

Ethernet is a widely used, manufacturer-independent technology which enables data transmission in
the network at a speed of 10...10 000 million bits per second (Mbps). Ethernet belongs to the family of
so-called "optimum data transmission" on a non exclusive transmission medium. The concept was
developed in 1972 and specified as IEEE 802.3 in 1985.
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EUC

EUC = Equipment Under Control.

EUC is equipment, machinery, apparatus or plant used for manufacturing, process, transportation,
medical or other activities (— IEC 61508-4, section 3.2.3). Therefore, the EUC is the set of all
equipment, machinery, apparatus or plant that gives rise to hazards for which the safety-related
system is required.

If any reasonably foreseeable action or inaction leads to —hazards with an intolerable risk arising from
the EUC, then safety functions are necessary to achieve or maintain a safe state for the EUC. These
safety functions are performed by one or more safety-related systems.

F

FiFo
FIFO (First In, First Out) = Operating principle of the stack memory: The data packet that was written
into the stack memory first, will also be read first. Each identifier has such a buffer (queue).

Flash memory

Flash ROM (or flash EPROM or flash memory) combines the advantages of semiconductor memory
and hard disks. Similar to a hard disk, the data are however written and deleted blockwise in data
blocks up to 64, 128, 256, 1024, ... bytes at the same time.

Advantages of flash memories
e The stored data are maintained even if there is no supply voltage.

¢ Due to the absence of moving parts, flash is noiseless and insensitive to shocks and magnetic
fields.

Disadvantages of flash memories

e A storage cell can tolerate a limited number of write and delete processes:

* Multi-level cells: typ. 10 000 cycles
« Single level cells: typ. 100 000 cycles

e Given that a write process writes memory blocks of between 16 and 128 Kbytes at the same time,
memory cells which require no change are used as well.

FRAM

FRAM, or also FeERAM, means Ferroelectric Random Access Memory. The storage operation and
erasing operation is carried out by a polarisation change in a ferroelectric layer.
Advantages of FRAM as compared to conventional read-only memories:

* non-volatile,

» compatible with common EEPROMSs, but:

* access time approx. 100 ns,

* nearly unlimited access cycles possible.

H

Heartbeat

The participants regularly send short signals. In this way the other participants can verify if a
participant has failed.

HMI

HMI = Human Machine Interface
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ID
ID = Identifier

Name to differentiate the devices / participants connected to a system or the message packets
transmitted between the participants.

IEC 61131

Standard: Basics of programmable logic controllers
* Part 1: General information
* Part 2: Production equipment requirements and tests
* Part 3: Programming languages
* Part 5: Communication
* Part 7: Fuzzy Control Programming

IEC user cycle
IEC user cycle = PLC cycle in the CODESYS application program.

Instructions

Superordinate word for one of the following terms:
installation instructions, data sheet, user information, operating instructions, device manual, installation
information, online help, system manual, programming manual, etc.

Intended use
Use of a product in accordance with the information provided in the instructions for use.

IP address

IP = Internet Protocol.
The IP address is a number which is necessary to clearly identify an internet participant. For the sake
of clarity the number is written in 4 decimal values, e.g. 127.215.205.156.

ISO 11898

Standard: Road vehicles — Controller area network
« Part 1: Data link layer and physical signalling
* Part 2: High-speed medium access unit
* Part 3: Low-speed, fault-tolerant, medium dependent interface
* Part 4: Time-triggered communication
* Part 5: High-speed medium access unit with low-power mode

ISO 11992

Standard: Interchange of digital information on electrical connections between towing and towed
vehicles

* Part 1: Physical and data-link layers

« Part 2: Application layer for brakes and running gear

« Part 3: Application layer for equipment other than brakes and running gear

* Part 4: Diagnostics
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ISO 16845

Standard: Road vehicles — Controller area network (CAN) — Conformance test plan

J

J1939
— SAE J1939

L

LED

LED = Light Emitting Diode.
Light emitting diode, also called luminescent diode, an electronic element of high coloured luminosity
at small volume with negligible power loss.

Link
A link is a cross-reference to another part in the document or to an external document.

LSB
Least Significant Bit/Byte

MAC-ID

MAC = Manufacturer's Address Code

= manufacturer's serial number.

—ID = Identifier

Every network card has a MAC address, a clearly defined worldwide unique numerical code, more or
less a kind of serial number. Such a MAC address is a sequence of 6 hexadecimal numbers, e.g. "00-
0C-6E-D0-02-3F".

Master

Handles the complete organisation on the bus. The master decides on the bus access time and polls
the —slaves cyclically.

Misuse

The use of a product in a way not intended by the designer.
The manufacturer of the product has to warn against readily predictable misuse in his user
information.

MMI
— HMI (— p. 189)
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MRAM

MRAM = Magnetoresistive Random Access Memory
The information is stored by means of magnetic storage elements. The property of certain materials is
used to change their electrical resistance when exposed to magnetic fields.
Advantages of MRAM as compared to conventional RAM memories:
* non volatile (like FRAM), but:
* access time only approx. 35 ns,
* unlimited number of access cycles possible.

MSB
Most Significant Bit/Byte

N

NMT

NMT = Network Management = (here: in the CANopen protocol).
The NMT master controls the operating states of the NMT slaves.

Node
This means a participant in the network.

Node Guarding

Node = here: network participant

Configurable cyclic monitoring of each —slave configured accordingly. The —master verfies if the
slaves reply in time. The slaves verify if the master regularly sends requests. In this way failed network
participants can be quickly identified and reported.

0]

Obj / object
Term for data / messages which can be exchanged in the CANopen network.

Object directory

Contains all CANopen communication parameters of a device as well as device-specific parameters
and data.

oBv

Contains all CANopen communication parameters of a device as well as device-specific parameters
and data.

OPC

OPC = OLE for Process Control

Standardised software interface for manufacturer-independent communication in automation
technology

OPC client (e.g. device for parameter setting or programming) automatically logs on to OPC server
(e.g. automation device) when connected and communicates with it.
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Operating system
Basic program in the device that establishes the connection between the hardware of the device and

the application program.
— Chapter Software module for the device

Operational

Operating state of a CANopen participant. In this mode —-SDOs, —NMT commands and —PDOs can
be transferred.

P

PC card
—PCMCIA card

PCMCIA card

PCMCIA = Personal Computer Memory Card International Association, a standard for expansion
cards of mobile computers.
Since the introduction of the cardbus standard in 1995 PCMCIA cards have also been called PC card.

PDM

PDM = Process and Dialogue Module.
Device for communication of the operator with the machine / plant.

PDO

PDO = Process Data Obiject.

The time-critical process data is transferred by means of the "process data objects" (PDOs). The
PDOs can be freely exchanged between the individual nodes (PDO linking). In addition it is defined
whether data exchange is to be event-controlled (asynchronous) or synchronised. Depending on the
type of data to be transferred the correct selection of the type of transmission can lead to considerable
relief for the —CAN bus.

According to the protocol, these services are unconfirmed data transmission: it is not checked whether
the receiver receives the message. Exchange of network variables corresponds to a "1 to

n connection” (1 transmitter to n receivers).

PDU

PDU = Protocol Data Unit = protocol data unit.

The PDU is a term from the —CAN protocol —-SAE J1939. It refers to a component of the target
address (PDU format 1, connection-oriented) or the group extension (PDU format 2, message-
oriented).

PES

Programmable Electronic System ...
« for control, protection or monitoring,
* dependent for its operation on one or more programmable electronic devices,
* including all elements of the system such as input and output devices.
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PGN

PGN = Parameter Group Number
PGN = 6 zero bits + 1 bit reserved + 1 bit data page + 8 bit PDU Format (PF) + 8 PDU Specific (PS)
The parameter group number is a term from the —CAN protocol —SAE J1939.

Pictogram

Pictograms are figurative symbols which convey information by a simplified graphic representation.
(— chapter What do the symbols and formats mean?)

PID controller

The PID controller (proportional-integral—derivative controller) consists of the following parts:
* P = proportional part

* | = integral part

+ D = differential part (but not for the controller CR04nn, CR253n).

PLC configuration

Part of the CODESYS user interface.

» The programmer tells the programming system which hardware is to be programmed.
> CODESYS loads the corresponding libraries.

> Reading and writing the periphery states (inputs/outputs) is possible.

Pre-Op

Pre-Op = PRE-OPERATIONAL mode.

Operating status of a CANopen participant. After application of the supply voltage each participant
automatically passes into this state. In the CANopen network only -SDOs and -NMT commands
can be transferred in this mode but no process data.

Process image
Process image is the status of the inputs and outputs the PLC operates with within one —cycle.

e At the beginning of the cycle the PLC reads the conditions of all inputs into the process image.
During the cycle the PLC cannot detect changes to the inputs.

e During the cycle the outputs are only changed virtually (in the process image).
e Atthe end of the cycle the PLC writes the virtual output states to the real outputs.

PWM

PWM = pulse width modulation

The PWM output signal is a pulsed signal between GND and supply voltage.

Within a defined period (PWM frequency) the mark-to-space ratio is varied. Depending on the mark-to-
space ratio, the connected load determines the corresponding RMS current.

R

ratiometric

Measurements can also be performed ratiometrically. If the output signal of a sensor is proportional to
its suppy voltage then via ratiometric measurement (= measurement proportional to the supply) the
influence of the supply's fluctuation can be reduced, in ideal case it can be eliminated.

— analogue input
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RAW-CAN

RAW-CAN means the pure CAN protocol which works without an additional communication protocol
on the CAN bus (on ISO/OSI layer 2). The CAN protocol is international defined according to
ISO 11898-1 and garantees in ISO 16845 the interchangeability of CAN chips in addition.

remanent

Remanent data is protected against data loss in case of power failure.

The —runtime system for example automatically copies the remanent data to a —flash memory as
soon as the voltage supply falls below a critical value. If the voltage supply is available again, the
runtime system loads the remanent data back to the RAM memory.

The data in the RAM memory of a controller, however, is volatile and normally lost in case of power
failure.

ro

RO = read only for reading only
Unidirectional data transmission: Data can only be read and not changed.

RTC

RTC = Real Time Clock
Provides (batter-backed) the current date and time. Frequent use for the storage of error message
protocols.

rw

RW = read/ write
Bidirectional data transmission: Data can be read and also changed.

S

SAE J1939

The network protocol SAE J1939 describes the communication on a —CAN bus in commercial
vehicles for transmission of diagnosis data (e.g.engine speed, temperature) and control information.
Standard: Recommended Practice for a Serial Control and Communications Vehicle Network

* Part 2: Agricultural and Forestry Off-Road Machinery Control and Communication Network

* Part 3: On Board Diagnostics Implementation Guide

* Part 5: Marine Stern Drive and Inboard Spark-Ignition Engine On-Board Diagnostics Implementation
Guide

* Part 11: Physical Layer — 250 kBits/s, Shielded Twisted Pair

* Part 13: Off-Board Diagnostic Connector

+ Part 15: Reduced Physical Layer, 250 kBits/s, Un-Shielded Twisted Pair (UTP)

+ Part 21: Data Link Layer

» Part 31: Network Layer

« Part 71: Vehicle Application Layer

« Part 73: Application Layer — Diagnostics

« Part 81: Network Management Protocol

SD card

An SD memory card (short for Secure Digital Memory Card) is a digital storage medium that operates
to the principle of —flash storage.
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SDO

SDO = Service Data Obiject.
The SDO is used for access to objects in the CANopen object directory. 'Clients' ask for the requested
data from 'servers'. The SDOs always consist of 8 bytes.

Examples:

» Automatic configuration of all slaves via —SDOs at the system start,

« reading error messages from the —object directory.
Every SDO is monitored for a response and repeated if the slave does not respond within the
monitoring time.

Self-test

Test program that actively tests components or devices. The program is started by the user and takes
a certain time. The result is a test protocol (log file) which shows what was tested and if the result is
positive or negative.

Slave

Passive participant on the bus, only replies on request of the —master. Slaves have a clearly defined
and unique —address in the bus.

stopped
Operating status of a CANopen participant. In this mode only —NMT commands are transferred.

Symbols

Pictograms are figurative symbols which convey information by a simplified graphic representation.
(— chapter What do the symbols and formats mean?)

System variable
Variable to which access can be made via IEC address or symbol name from the PLC.

T

Target

The target contains the hardware description of the target device for CODESYS, e.g.: inputs and
outputs, memory, file locations.
Corresponds to an electronic data sheet.

TCP

The Transmission Control Protocol is part of the TCP/IP protocol family. Each TCP/IP data connection
has a transmitter and a receiver. This principle is a connection-oriented data transmission. In the
TCP/IP protocol family the TCP as the connection-oriented protocol assumes the task of data
protection, data flow control and takes measures in the event of data loss. (compare: —UDP)

Template

A template can be filled with content.
Here: A structure of pre-configured software elements as basis for an application program.

196



ifm Programming Manual ecomatController/60-1 (CR711S) Operating System V2.5.0.n 2017-12-19

Glossary of Terms

U

UDP

UDP (User Datagram Protocol) is a minimal connectionless network protocol which belongs to the
transport layer of the internet protocol family. The task of UDP is to ensure that data which is
transmitted via the internet is passed to the right application.

At present network variables based on —CAN and UDP are implemented. The values of the variables
are automatically exchanged on the basis of broadcast messages. In UDP they are implemented as
broadcast messages, in CAN as —PDOs.

According to the protocol, these services are unconfirmed data transmission: it is not checked whether
the receiver receives the message. Exchange of network variables corresponds to a "1 to

n connection" (1 transmitter to n receivers).

Use, intended
Use of a product in accordance with the information provided in the instructions for use.

W

Watchdog

In general the term watchdog is used for a component of a system which watches the function of other
components. If a possible malfunction is detected, this is either signalled or suitable program
branchings are activated. The signal or branchings serve as a trigger for other co-operating system
components to solve the problem.
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